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Read Me First

Notes on Online Manual Usage
How to Print

Notes on Online Manual Usage

• Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

• In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

• Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

• In principle, the descriptions in this guide are based on the product at the time of its initial sale.
• This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied

with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

Note
• In Windows 8, print in the desktop version.

• In Internet Explorer 9, 10, or 11

1. Select  (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

• In Internet Explorer 8

1. Press the Alt key to display the menus.
Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.

2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

• In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.
3. Select the Print Background (colors & images) checkbox in Format & Options.

• In Google Chrome

1. Select  (Chrome Menu) > Print....
2. Select the Background colors & images checkbox in Options.
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How to Use the Online Manual

Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

Note
Instructions including notes for operation and additional explanations.

Basic

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,

registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under

license.
• Google Cloud Print, Google Chrome, Android, Google Play and Picasa are either registered trademarks

or trademarks of Google Inc.
• Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either

registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

• Photo Rag is a trademark of Hahnemühle FineArt GmbH.
• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
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1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
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their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
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goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.
END OF TERMS AND CONDITIONS
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Enter keywords in the search window and click  (Search).

You can search for target pages in this guide.

Search Tips

You can search for target pages by entering keywords in the search window.

Note
• The displayed screen may vary.
• When searching from this page or the "Home" page without entering your product's model name or your

application's name, all products supported by this guide will be considered for the search.
If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

• Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about

Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search

• Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search
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Note
• The displayed screen varies depending on your product.

• Searching for Application Functions

Enter your application's name and a keyword for the function you want to learn about

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

• Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page
Refer to "Color Settings Tab" for your model from Home of the Online Manual for details. 
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Notes on Operation Explanations

In this guide, most of the operations are described based on the windows displayed when Windows 8.1
operating system (called Windows 8.1 below) or Windows 8 operating system (called Windows 8 below) is
used.
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Useful Functions Available on the Machine

Connect Wirelessly with Ease in "Access Point Mode"

Download a Variety of Content Materials

Print Items with Easy-PhotoPrint+ (Web Application)

Use the Printer More Conveniently with Quick Toolbox

Connection Methods Available on the Printer

Notice for Web Service Printing

Use MAXIFY Cloud Link

Printing with Google Cloud Print

Printing from AirPrint Compliant Device

Checking Printer Information

How to Use Print from E-mail

Print Easily from a Smartphone or Tablet with MAXIFY Printing Solutions

Printing with Windows RT
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Connect Wirelessly with Ease in "Access Point Mode"

The printer supports "access point mode" in which you can connect to the printer wirelessly from a computer
or smartphone even in an environment without an access point or wireless LAN router.
Switch to "access point mode" with simple steps to enjoy printing wirelessly.

When you use the printer with the access point mode, be sure to specify the access point name of the
printer and the security setting in advance.

Using the Printer with the Access Point Mode
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Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.
Various types of content such as seasonal cards and paper crafts that can be made by assembling paper
parts are provided.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.
PREMIUM Contents can be downloaded easily via Easy-PhotoPrint+. Downloaded PREMIUM Contents
can be printed directly with Easy-PhotoPrint+.
To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed for
all colors on a supported printer.

Note
• The designs of PREMIUM Contents provided in this page are subject to change without prior notice.
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Print Items with Easy-PhotoPrint+ (Web Application)

You can easily create and print personalized items such as calendars and collages, anytime and anywhere,
by simply accessing Easy-PhotoPrint+ on the web from a computer or tablet.

By using Easy-PhotoPrint+, you can create items in the latest environment without going through the trouble
of installation.

Moreover, you can use various photos for your item through integration with social networks such as
Facebook, or with online storage, web albums, etc.

Refer to "Easy-PhotoPrint+ Guide" for details.
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Use the Printer More Conveniently with Quick Toolbox

Quick Toolbox is a shortcut menu that lets you access the functions you want to use with one click. After
installing utilities compatible with Quick Toolbox, they will be added to this menu. The Quick Toolbox
provides a convenient way to quickly launch added utilities for making printer settings and doing other
management tasks.

Refer to "Quick Toolbox Guide" for details.
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Connection Methods Available on the Printer

The following connection methods are available on the printer.

Wireless Connection 

With an access point

Without an access point

Wired Connection 

USB Connection 

Wireless Connection

There are two methods for connecting the printer to your device (such as a smartphone). One method is
to connect using an access point, and the other method is to connect without using an access point.
The two connection methods cannot be used at the same time.

If you have an access point (or wireless network router), it is recommended that you use the method
described in Connection Using an Access Point.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.
If you connect using a different connection method, the connection to the device in use will be disabled.

Connection Using an Access Point

• Connect the printer and a device using an access point.
• Connection methods vary depending on the access point type.
• You can change network settings such as the SSID and security protocol on the printer.
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• When the connection between a device and an access point is completed and  (Wi-Fi icon) is
displayed in the device's screen, you can connect the device to the printer using the access point.

Connection without Using an Access Point

• Connect the printer and a device without using an access point. Connect a device and the printer
directly using the printer's access point mode function.

• When establishing a connection in access point mode, Internet connection may become unavailable.
In that case, web services for the printer cannot be used.

• If you connect a device connected to the Internet via an access point to the printer that is in access
point mode, the connection between the device and access point will be disabled. In that case, the
connection of the device may switch to a mobile data connection automatically depending on your
device. Transmission fees for connecting to the Internet using a mobile data connection apply.

• In access point mode, you can connect up to five devices at the same time. If you try to connect a
sixth device while five devices are already connected, an error will appear.
If an error appears, disconnect a device that does not use the printer, then configure settings again.

• Network settings such as the SSID and security protocol can be changed on the printer.

When Using Windows XP:

Connection without Using an Access Point (Windows XP)

Restrictions

(Appears in a new window)

Wired Connection

Connect the printer and a hub or router with an Ethernet cable. Prepare an Ethernet cable.

USB Connection

Connect the printer and a computer with a USB cable. Prepare a USB cable.
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Connection without Using an Access Point (Windows XP)

Restrictions

(Appears in a new window)

1. Make sure that the screen below is displayed.

If another screen is displayed, press the Setup button (A) on the printer.

2. Press the Setup button.

3. Use the  or  button (B) to select Device settings, then press the OK button.

4. Select LAN settings, then press the OK button.

5. Select Change LAN, then press the OK button.

6. Select AP mode active, then press the OK button.
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7. Select SSID, then press the OK button.

8. Check SSID information in the printer screen, then press the Back (C).

You will use the SSID information in the subsequent steps.

9. Select Security protocol, then press the OK button.

10. Check the Password (network key), then press the Back button.

You will use the Password (network key) in the subsequent steps.

11. Select Start setup, then press the OK button.

12. Right-click the Wireless Network Connection icon in the notification area of the taskbar
on the computer, then select View Available Wireless Networks.
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13. Select the network name (SSID) you want to use, then click Connect.

14. Enter the Password (Network key), then click Connect.

15. When connection is complete, click Back until the screen below appears.
Proceed with the setup.
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Restrictions

When connecting another device while a device (such as a smartphone) is already connected to the
printer, connect it using the same connection method as the connected device.
If you connect using a different connection method, the connection to the device in use will be disabled.

Connection Using a Wired Network cannot be performed on printers that do not support a wired
connection.

Connection Using an Access Point

• Make sure that a device and an access point (or wireless network router) are connected. For details
on how to check the settings, refer to the manual supplied with the access point or contact its
manufacturer.
As for a device already connected to the printer without using an access point, reconnect it via an
access point.

• The configuration, router functions, setup procedures and security settings of the network device vary
depending on your system environment. For details, refer to the manual of your network device or
contact its manufacturer.

• Check if your device supports IEEE802.11n (2.4 GHz), IEEE802.11g or IEEE802.11b.
• If your device is set to the "IEEE802.11n only" mode, WEP or TKIP cannot be used as a security

protocol. Change the security protocol for your device to something other than WEP and TKIP or
change the setting to something other than "IEEE802.11n only."
The connection between your device and the access point will be temporarily disabled while changing
the setting. Do not operate the screen of this guide until the setup is complete.

• For office use, consult your network administrator.
• Take added care when connecting to a network that is not protected with security measures, as there

is a risk of disclosing data such as your personal information to a third party.

Connection without Using an Access Point

Important
• If you connect a device connected to the Internet via an access point to the printer that is in access

point mode, the connection between the device and access point will be disabled. In that case, the
connection of the device may switch to a mobile data connection automatically depending on your
device. When you connect to the Internet using a mobile data connection, charges may apply
depending on your contract.

• When you connect a device and the printer in access point mode, the connection information will
be saved to Wi-Fi settings. The device may be connected to the printer automatically even after
disconnecting it or connecting it to another access point.

• You cannot connect to an access point and the printer that is in access point mode at the same
time. If you have an access point, it is recommended that you use the access point to connect to
the printer.

• To prevent automatic connection to the printer that is in access point mode, change the
connection mode after using the printer, or set not to connect automatically in the Wi-Fi settings
of the device.
For details on how to change the settings of a device, refer to the manual supplied with the
device or contact its manufacturer.
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• When connecting a device and the printer in access point mode, Internet connection may become
unavailable. In that case, web services for the printer cannot be used.

• In access point mode, you can connect up to five devices at the same time. If you try to connect a
sixth device while five devices are already connected, an error will appear.
If an error appears, disconnect a device that does not use the printer, then configure settings again.

• Devices connected to the printer in access point mode cannot communicate with each other.
• Firmware updates for the printer are not available while using the access point mode.
• When a device has been connected to the printer without using an access point and you want to set it

up again using the same connection method, disconnect it first. Disable the connection between the
device and printer in the Wi-Fi setting screen.

Connection Using a Wired Network

• This printer cannot be used over wireless and wired connections at the same time.
• When using a router, connect the printer and a device to the LAN side (same network segment).

33



Notice for Web Service Printing

When Using Web Service

• Canon does not guarantee the continuity and reliability of the web services provided, the availability of
site access, or permission to download the materials.

• Canon may at any time update, change, or delete the information provided through the web service,
or may suspend or discontinue the service without prior notice. Canon shall not be held responsible
for any damages resulting from such actions.

• In no event shall Canon be liable for any damages whatsoever resulting from the use of the web
services.

• User registration is necessary before using the photo sharing site.
When you use the photo sharing site, observe the conditions of use of the site and use the service
within your own responsibility.

• All or part of the web service may not be available depending on the country or region you live in.
• Depending on your network environment, some functions on web service are not available. Even if

they are available, it may take a while to print or display the contents, or communication may be
interrupted while operation is in progress.

• When you use web service, your machine's name, information of your region or country, your selected
language, and what kind of service you use (e.g. photo sharing site) are sent to and saved in our
server. Canon is unable to identify specific customers using this information.

• Your login name and password for the photo sharing site are saved in the machine's memory (not
encrypted).
If you hand over the machine to anyone or dispose of it, delete your login name and password from
the machine's memory in advance.

• The account information will be sent to Canon Inc. server (located in Japan), then forwarded to the
service provider's server.

• Canon handles your account information as follows:

◦ Your account information will be used in personal identification process of the selected service.
◦ Canon will not provide your account information to any third party without your consent, except for

sending to the service provider or providing based on laws and regulations.
◦ After the conclusion of non-disclosure agreement, Canon may deposit your account information to

the contractor to achieve the purpose of use.
◦ Canon endeavors to secure the safety of your account information.
◦ It is at your option to enter and send your account information. However, the service that requires

to enter your account information is not available unless you enter and send it.
◦ Your account information does not remain in Canon Inc. server. At the latest, it will be deleted

when you have disconnected your printer from LAN.
◦ For details, contact a Canon-authorized sales representative in the country or region you live in.

To Those Living in Mainland China

• PIXMA/MAXIFY Cloud Link, Easy-PhotoPrint+, and some functions of PIXMA/MAXIFY Printing
Solutions, which are included with this machine, are provided by Canon Inc.
However, as the server is installed outside of mainland China, some of these services may not be
available yet.
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Copyrights and Rights of Publicity

When printing from the photo sharing site:

• Observe the conditions of use of the photo sharing site when you use photos on the site.
• It is unlawful to reproduce or edit the copyrighted work of another person without permission from the

copyright holder, except for personal use, use within the home, or other use within the limited scope
as defined by the copyright. Additionally, reproducing or editing photographs of people may infringe
on Rights of Publicity.

When printing downloaded template forms:

1. The copyright of each material (photos, illustrations, logos, or documents: hereinafter referred to as
"the materials") provided on the web template printing service belongs to their respective owners.
Issues pertaining to Rights of Publicity may arise regarding the use of any of people or characters
displayed on the web template printing service.

Except as otherwise permitted (please see "2" below), copying, modifying or distributing all or a
portion of any of the materials contained on the web template printing service without prior consent of
the respective rights (Rights of Publicity and Copyright) holder is strictly prohibited.

2. All of the materials provided on the web template printing service can be freely used for personal and
non-commercial purposes.
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Use MAXIFY Cloud Link

By using MAXIFY Cloud Link, you can connect your printer to a cloud service, such as CANON iMAGE
GATEWAY, Evernote, or Twitter, and use the following functions without using a computer:

• Print images from a photo-sharing service
• Print documents from a data management service
• Use Twitter to report the printer status, such as no paper or low ink levels.

In addition, you can use various functions by adding and registering apps that are linked with various cloud
services.

Using MAXIFY Cloud Link from Your Smartphone, Tablet, or Computer

Important
• In certain countries, MAXIFY Cloud Link may not be available or the available apps may be different.
• Some apps require that you have an account before you use those apps. For such apps, please set up

an account beforehand.
• To find out which models support MAXIFY Cloud Link check the Canon homepage.
• The screen display may change without prior notice.
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Using MAXIFY Cloud Link from Your Smartphone, Tablet, or
Computer

Before Using Canon Inkjet Cloud Printing Center

Preparations Before Using Canon Inkjet Cloud Printing Center

Using Canon Inkjet Cloud Printing Center

Adding a Printer

Adding a MAXIFY Cloud Link User

Troubleshooting Canon Inkjet Cloud Printing Center

37



Before Using Canon Inkjet Cloud Printing Center

Canon Inkjet Cloud Printing Center is a service that links with the cloud function of the printer and allows you
to perform operations such as registering and managing apps from your smartphone or tablet device, and
checking the print status, print error, and ink status of the printer. You can also print app photos and
documents from your smartphone or tablet.

First, check the following content:

• Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

• Printer specification

Check that Canon Inkjet Cloud Printing Center supports the printer.

• Network environment

The printer must be connected to a LAN and to the Internet.

Important
• The user will bear the cost of Internet access.

• Operating requirements

For computers, smartphones, and tablet devices, see "Requirements for Canon Inkjet Cloud Printing
Center operation".

Important
• This service may not be available in certain countries or regions. Also even if the service is available,

there are apps that cannot be used in certain regions.

Preparations Before Using Canon Inkjet Cloud Printing Center

38



Requirements for Canon Inkjet Cloud Printing Center operation

Computer

CPU x86 or x64 1.6 GHz or higher

RAM 2 GB or higher

Monitor display
Resolution 1024 x 768 pixels or higher
Number of display colors 24 bits (true-color) or higher

OS Browser

Windows XP SP3 or later
Internet Explorer 8*
Mozilla Firefox
Google Chrome

Windows Vista SP1 or later
Internet Explorer 8*, 9
Mozilla Firefox
Google Chrome

Windows 7
Internet Explorer 8*, 9, 10, 11
Mozilla Firefox
Google Chrome

Windows 8
Internet Explorer 10
Mozilla Firefox
Google Chrome

Windows 8.1
Internet Explorer 11
Mozilla Firefox
Google Chrome

Mac OS X v10.6-OS X Mavericks v10.9 Safari 5.1, 6, 7

* When you use Internet Explorer 8, the web pages may not display correctly. Canon recommends that
you upgrade to Internet Explorer 9 or later, or use another browser.

Smartphone or tablet

OS Browser Resolution

iOS 5.1 or later
OS standard browser

320 x 480 (HVGA) or higher

Android 2.3.3 or later 480 x 800 (HVGA) or higher

*Android3.x is not supported.

Important
• On the browser you are using, enable JavaScript and cookies.
• If you use the zoom function or change the font size on your browser, the web pages may not display

correctly.

• If you use the translation function of Google Chrome, the web pages may not display correctly.

• If you use a proxy server outside of your country, the service may not be able to determine the correct
region.
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• In an in-house network environment, the 5222 port must be released. For confirmation instructions,
contact the network administrator.

40



Preparations Before Using Canon Inkjet Cloud Printing Center

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
the user information.

Print registration information from the printer

1. On the printer operation panel, select the  Setup button, and then select Web
service setup -> Connection setup -> IJCloudPrintingCtr -> Register w/ service

2. In the registration confirmation window, Select Yes

3. In the print settings, select the display language

4. Follow the instructions displayed in the window, and print the URL of the authentication
site and the Printer registration ID

Set A4 size or Letter size plain paper and select OK.
The authentication URL and Printer registration ID are printed.

Note
• You will use this printed page in the next step.
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Important
• The operation to complete the registration should be done within 60 minutes.

Access the URL on the printed page, and then enter the e-mail address and
other necessary information

Important
• Do not use the Back button of the web browser while an operation is processing. The screen may not

transition properly.

1. Use the web browser on your PC, smartphone, tablet, or other devices to access the
authentication URL
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2. On the Login screen, select Create new account

3. Enter the E-mail address and Printer registration ID of the printer's owner, and then
select OK

The registration page URL is sent to the e-mail address entered.

Important
• There are character restrictions for the e-mail address, as shown below.

• You can use up to 255 alphanumeric characters consisting of single-byte characters and
symbols (!$'*/^_{}|~.-@).

• Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

• If you registered a different e-mail address by mistake, you can cancel the registration by
selecting the Setup button on the printer operation panel, and then selecting Web service
setup -> Connection setup -> IJCloudPrintingCtr -> Delete from service.
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• You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com".
There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

Access the URL in the e-mail, register the information, and complete the
user registration

1. When an e-mail with the subject "Information on Canon Inkjet Cloud Printing Center" is
sent to the e-mail address that you entered, select the URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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3. In the user information entry screen, enter your Password, and select Next

Enter your password for logging in to the Canon Inkjet Cloud Printing Center.

Important
• There are character restrictions for the Password, as shown below.

• The password needs to be between 8 and 32 characters long, using single-byte
alphanumeric characters and symbols (!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~). (Alphabets are
case-sensitive)

4. Enter the User name

Enter the name that identifies the user.
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Important
• The User name entry field has the following character restrictions:

• The user name needs to be between 1 and 20 characters long, using single-byte
alphanumeric characters and symbols (!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~). (Alphabets are
case-sensitive)

5. Specify the Time zone setting, and select Next

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.

Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

6. Enter the Security code and select Done
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A Security code identifies the user when multiple other users are sharing the same printer.

Important
• The Security code entry field has the following character restrictions:

• Single-byte numbers

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Enter the registered e-mail address and password, and log in to the Canon Inkjet Cloud Printing Center.

Using Canon Inkjet Cloud Printing Center
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Printing Your Printer registration ID

To add a printer by using Canon Inkjet Cloud Printing Center, you will need a Printer registration ID.

From the operation panel of this printer, print the URL of the authentication site and your Printer
registration ID. The procedure is as follows:

1. Check that the printer is connected to the Internet

Important
• To use this function, you must connect this printer to the Internet.

2. On the printer operation panel, select the  Setup button, and then select Web
service setup -> Connection setup -> IJCloudPrintingCtr -> Register w/ service

3. In the registration confirmation window, Select Yes

4. In the print settings, select the display language

5. Follow the instructions displayed in the window, and print the URL of the authentication site
and your Printer registration ID

When you set A4 size or Letter size plain paper and select OK, the authentication site URL and your
Printer registration ID are printed.

Important
• The operation to complete the registration should be done within 60 minutes.
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Canon Inkjet Cloud Printing Center window

This section describes the Canon Inkjet Cloud Printing Center screens that are displayed on your
smartphone, tablet device, or computer.

Description of the Login screen
Description of the Main screen

Description of the Login screen

This section provides the description of the Login screen of Canon Inkjet Cloud Printing Center.

Important
• You have 5 tries to enter your password. If you fail, you will not be able to log in for about the next

hour.
• You remain logged in for an hour after the last access.

Language
Select the language you will be using.

E-mail address
Enter the e-mail address that you entered in the user registration.

Important
• The e-mail address is case-sensitive. Make sure the case is correct.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.

Reset password from here
Select this if you forgot the password.
Reset your password by following the instructions on the screen.
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Create new account
A new registration will be added to the Canon Inkjet Cloud Printing Center.
For a new registration, you need the Printer registration ID.

System requirements
This displays the system requirements for the Canon Inkjet Cloud Printing Center.

Help/legal notices (smartphone and tablet devices only)
The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

Software license info
The licensing information of Canon Inkjet Cloud Printing Center is displayed.

About this service
This displays the descriptions of this service.

Description of the Main screen

When you log in to the Canon Inkjet Cloud Printing Center, the Main screen appears.

Important
• With this service, the functions available to Standard user of the printer are different from those

available to the printer Administrator.
Standard user can only use the functions marked by an asterisk (*).

You can use areas shown below to start*, add, and manage apps.
If you are using a smartphone or a tablet, you can also print photos and documents.

If you are using a smartphone or tablet
If you are using a PC
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If you are using a smartphone or tablet

(1) Left context menu
(2) Printer name area
(3) Right context menu
(4) Display area
(5) Menu area

(1) Left context menu

When you select , the Mng. printer screen of the Manage users screen appears.
For general users, the Select printer screen appears.

Mng. printer screen (Select printer screen)
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From the Mng. printer screen (Select printer screen), you can check*and update* printer information
registered to the Canon Inkjet Cloud Printing Center, change printer names, delete printers, add
printers, and copy apps.

• Check the printer information*

The registered printer name is displayed.

 indicates the currently selected printer.

 indicates that an error occurred on the printer.

• Display update date/time of the printer information*

This displays the date and time the printer information was last updated.

 refreshes the information.

• Multiuser mode

If multiple users are using the printer, select the Multiuser mode check box.

• Copy apps

Select this to copy apps added in the selected printer to another printer.

When you select , the screen shown below appears.

Set the Destination printer and the Source printer. Then select OK.
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• Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

Note
• The printer name entry has the following character limitation:

• Up to 128 characters

• Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

• Add printers

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.
You need a Printer registration ID to add a printer.

Note
• Up to 16 printers are guaranteed to operate for each e-mail address.

Manage users screen

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.
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• User deletion

Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the user
information screen.

• Adding a user

Select Add user. The user registration screen appears.

• Changing Administrator and Standard user settings

You can change the privileges of the Administrator and Standard users.

(2) Printer name area

The registered name of the printer selected is displayed.

The Administrator can change the printer name.

(3) Right context menu

When you select , the context menu appears.
The information displayed depends on the menu currently selected in the menu area.

The  symbol indicates that there is a new unread notice.

•  Sort

This displays the screen to sort registered apps.

You can use the   buttons to change the display order of apps. When you finish sorting,
press the Done button to confirm the order.
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•  Latest notices*

This displays the latest notices. The  symbol indicates that there is a new unread notice.

•  User information*

This displays the User information screen.
You can change the registered e-mail address, password, language, time zone, and other settings.

•  Help/legal notices*

The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

•  Log out*

This opens the Log out screen of the Canon Inkjet Cloud Printing Center.

(4) Display area

The display changes based on the menu you select.
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(5) Menu area

The following 4 menu buttons are displayed:

•  Apps*

This displays the list of registered apps in the Display area.

•  Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.
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On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud
Printing Center are displayed by category.

◦ When you select , the details of the app are displayed.

When you select  / , you can choose to register or unregister the app.

Note
• Description of displayed icons

 : Cannot be used because it is not yet released, not available in your region, or does
not support your model.

 : Can be used with genuine Canon ink.
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•  Properties*

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

Important
• The Properties displayed may differ from the actual status at the display time, depending on

the printer status.

•  Manage jobs*

This screen displays the print status and the print history.
You can check the print status by looking at Status list, and the print history by looking at History.
You can also cancel print jobs and delete history information.
To cancel or delete a job, select that job and then select Cancel or Delete.

If you are using a PC

(1) Mng. printer (Select printer) button
(2) Manage users button
(3) Printer name area
(4) Menu area
(5) Notices area
(6) Information area
(7) Global navigation area
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(8) Display area

(1) Mng. printer (Select printer) button

When you select the Mng. printer (Select printer) button, the Mng. printer (Select printer) screen
appears.

From the Mng. printer screen (Select printer screen), you can check*and update* printer information
registered to the Canon Inkjet Cloud Printing Center, change printer names, delete printers, add
printers, and copy apps.

• Check the printer information*

The registered printer name is displayed.

 indicates the currently selected printer.

 indicates that an error occurred on the printer.

• Display update date/time of the printer information*

This displays the date and time the printer information was last updated.

 refreshes the information.
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• Multiuser mode

If multiple users are using the printer, select the Multiuser mode check box.

• Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

Note
• The printer name entry has the following character limitation:

• Up to 128 characters

• Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

• Add printers

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.
You need a Printer registration ID to add a printer.

Note
• Up to 16 printers are guaranteed to operate for each e-mail address.

• Copy apps

Select this to copy apps added in the selected printer to another printer.

When you select , the screen shown below appears.

Set the Destination printer and the Source printer. Then select OK.
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(2) Manage users button

When you select the Manage users button, the Manage users screen appears.

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.

• User deletion

Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the user
information screen.

• Adding a user

Select Add user. The user registration screen appears.

• Changing Administrator and Standard user settings

You can change the privileges of the Administrator and Standard users.

(3) Printer name area

The registered name of the printer selected is displayed.

The Administrator can use the Mng. printer functions to change the printer name.

(4) Menu area

The following 4 menu buttons are displayed:

•  Sort (Apps)

This displays the list of registered apps in the Display area.
Drag the app to change the order.

61



When you finish sorting, press the Set sort order button and confirm the order.

•  Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.

On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud
Printing Center are displayed by category.
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◦ When you select , the details of the app are displayed.

When you select  / , you can choose to register or unregister the app.

Note
• Description of displayed icons

 : Cannot be used because it is not yet released, not available in your region, or does
not support your model.

 : Can be used with genuine Canon ink.

•  Properties*

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

Important
• The Properties displayed may differ from the actual status at the display time, depending on

the printer status.

•  Manage jobs*

This screen displays the print status and the print history.
You can check the print status by looking at Status list, and the print history by looking at History.
You can also cancel print jobs and delete history information.
To cancel or delete a job, select that job and then select Cancel or Delete.
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(5) Notices area

This displays the latest notice. Nothing is displayed in this area if there is no notice.
When you select Notice list, you can display up to 40 items.

(6) Information area

This display other information, including the privacy statement and other companies' licensing
information.

(7) Global navigation area

The User information*, Instructions*, and Log out* buttons are displayed.
Press the User information to change the settings.

(8) Display area

The display changes based on the menu you select.
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Using Canon Inkjet Cloud Printing Center

When the user registration is completed, you can log in to the Canon Inkjet Cloud Printing Center and use
the service.

1. From your PC, smartphone, or tablet, access the service login URL (http://cs.c-ij.com/)

2. On the Login screen, enter the E-mail address and Password, and then select Log in

Important
• The e-mail address and password are case-sensitive. Make sure the case is correct.

E-mail address
Enter the e-mail address that you entered in the user registration.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.

Important
• If you fail to log in five straight times, you will not be able to login again for an hour.
• You remain logged in for an hour after the last access.
• The service may not function properly if you log in from multiple devices at the same time.

After logging in, you can use useful services such as adding/managing apps that work in conjunction with
this product's cloud functionality and checking the ink status.

For screen descriptions and operation instructions, see "Canon Inkjet Cloud Printing Center window".

Printing procedure

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.
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Important
• The available functions differ depending on the app.
• The printing procedure differs depending on the app.
• You need to get the account and register photo and other data beforehand.
• The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlsx, xls, pptx, ppt, and rtf.

The file formats that can be printed differ depending on the app.
• Before you print, check that printer is on and is connected to the network. Then start.
• This is available if you are using a smartphone or tablet.

Note
• You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

3. In the displayed album list, select the album of your choice
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4. In the displayed image list, select the image that you want to print, and then select Next

5. Make the necessary print settings, and then select Print
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6. A print job completion message appears, and printing starts

To end the printing, select Apps and return to the Apps list screen.
To continue printing, select Continue and repeat the procedure from step 3.

Important
• If a print job is not printed within 24 hours after the print job is issued, the print job will expire and

cannot be printed.
• With premium apps that limit the number of print jobs, print jobs that expire and cannot be printed are

also included in the print count.

Adding a Printer
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Adding a Printer

With one account, you can use the Canon Inkjet Cloud Printing Center services on multiple printers.

The procedure for adding a printer is as follows:

1. Print the registration information from the printer to be added

2. From the browser on your smartphone, tablet, or computer, access the authentication site
URL

3. Select Add printer

4. When the confirmation message is displayed, select OK

5. Enter your Printer registration ID, and select OK
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Note
• When you access the service from Remote UI, the Printer registration ID is entered

automatically.

Printer addition is completed.

Adding a MAXIFY Cloud Link User
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Adding a MAXIFY Cloud Link User

Several people can use one printer.
This section describes the user addition procedure and the user privileges.

Adding a user

1. On the service screen, select Manage users

2. Select Add user

Note
• When you select Add user, the service first checks whether the maximum number of users has

been reached. If new users can be added, the user registration screen appears.
• The maximum number of users that can be added for 1 printer is 20.
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3. Enter the e-mail address of the user to be added, and then select OK

The URL for completing the registration is then sent to the entered e-mail address.

4. Access the URL reported in the e-mail

5. Read the terms displayed in the License agreement and Privacy statement screens. If
you agree to the terms, select Agree.

6. In the user information entry screen, enter your Password, and select Next
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Enter your password for logging in to the Canon Inkjet Cloud Printing Center.

Important
• There are character restrictions for the password, as shown below.

• The password needs to be between 8 and 32 characters long, using single-byte
alphanumeric characters and symbols (!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~). (Alphabets are
case-sensitive)

7. Enter the User Name

Enter the name that identifies the user.

Important
• The User Name entry field has the following character restrictions:
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• The user name needs to be between 1 and 20 characters long, using single-byte
alphanumeric characters and symbols (!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~). (Alphabets are
case-sensitive)

8. Set Time zone and select Next

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.

Apply daylight saving time
This appears only when there is a daylight saving time in the time zone that you selected.
Select whether or not to apply the daylight saving time.

9. Enter the Security code and select Done

Enter the code for authenticating the user.
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Important
• The Security code entry field has the following character restrictions:

• Single-byte numbers

The main registration is complete, and a registration completion e-mail is sent.

Note
• A cookie for the selected user is added to the printer, and the login status of each user is recovered.

Cookies for up to 8 users can be registered to 1 printer.

Printer user privileges

If several users are using the cloud service for 1 printer, each user is categorized as the Administrator or
a Standard user.

Note
• The user who is registered first becomes the Administrator. The administrator can change the

privileges of users from the Manage users screen.

An Administrator can change printer information, add and delete apps, manage users, and perform
various other operations.
A Standard user can check printer information and start apps.
For information about the functions that each user can use, refer to the "Canon Inkjet Cloud Printing
Center window".

If you are using MAXIFY Cloud Link from the printer, select Multiuser mode in the Mng. printer screen to
set the printer to Multiuser mode. Each user can then start an app and print documents.

Troubleshooting Canon Inkjet Cloud Printing Center
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Troubleshooting Canon Inkjet Cloud Printing Center

If an app cannot be installed
If the registered app is not in the Apps list
If the information is not updated when you press the Update button
If you do not receive the registration e-mail
If you cannot print
Printing starts on its own even if you do not do anything
If you are unable to log in correctly even after entering the correct password in iOS or Mac

If an app cannot be installed

Check the country or region where the printer was purchased.
If the printer is taken outside the country or region where it was purchased, apps cannot be installed.

If the registered app is not in the Apps list

Check the display language of Canon Inkjet Cloud Printing Center.
If the display language is switched to a language that does not support an app, the app will not be
displayed in the apps list but will continue to be registered.
If you switch back to the target language of the app, it will be displayed in the apps list and you will be
able to start, register, or unregister the app.

If the information is not updated when you press the Update button

Because the Properties screen requires network connection with this product, the information may not be
reflected immediately. Please wait awhile, and then try updating the information again.
If the information is still not updated, then check that the product is connected to the Internet.

If you do not receive the registration e-mail

You may have entered a different e-mail address during the user registration of Canon Inkjet Cloud
Printing Center.

On the printer operation panel, select the  Setup button, and then select Web service setup ->
Connection setup -> IJCloudPrintingCtr -> Delete from service to delete the service registration.
After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.

If you cannot print

Check the following if you cannot print.

• Check that the printer is connected to the Internet.
• Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
• Check that no error message is displayed on the printer's LCD monitor.

• If printing does not start even after you wait awhile, go to the printer operation panel, select 
Setup, and run Web service inquiry. If printing does not start, run the inquiry several times.
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If the problem is not resolved, use the printer driver from your computer to perform the print job and check
whether the data can be printed normally on the printer.
If you still cannot print, see the troubleshooting page for your model on the Home of the Online Manual.

Note
• With a wireless LAN connection, after the printer is turned on, it may take several minutes before

communication is possible. Check that your printer is connected to the wireless network, and wait a
while before you start printing.

• If the printer is not turned on or is not connected to the Internet, and consequently a print job is not
processed within 24 hours after it was submitted, the print job is automatically canceled. If this
happens, check the printer power and the Internet connection, and then re-submit the print job.

Printing starts on its own even if you do not do anything

A third party may be able to illegally use the Canon Inkjet Cloud Printing Center services.

On the printer operation panel, select the  Setup button, and then select Web service setup ->
Connection setup -> IJCloudPrintingCtr -> Delete from service to delete the service registration.
After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.

If you are unable to log in correctly even after entering the correct
password in iOS or Mac

If you are using iOS or Mac, and the password contains the ¥ symbol, enter a backslash instead. For
instructions on entering a backslash, see the OS help.
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What is a Security code?

A Security code identifies the user when multiple other users are sharing the same printer.

Important
• If you do not set a Security code, another user may use your account.
• This code is valid only when you use MAXIFY Cloud Link from the printer operation panel. You cannot

use this code when you access the Canon Inkjet Cloud Printing Center from your smartphone, tablet, or
computer.
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Printing with Google Cloud Print

The printer is compatible with Google Cloud Print™ (Google Cloud Print is a service provided by Google
Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google
Cloud Print.

1. Preparations for Printing with Google Cloud Print

2. Printing from Computer or Smartphone with Google Cloud Print

Important
• LAN connection with the printer and Internet connection are required to register the printer and to print

with Google Cloud Print. Internet connection fees apply.
• This function may not be available depending on the country or region you live in.
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Preparations for Printing with Google Cloud Print

To print with Google Cloud Print, you need to get Google account and register the printer with Google Cloud
Print in advance.

Getting Google Account

If you already have Google account, register the printer.

Registering the Printer with Google Cloud Print

Getting Google Account

First, get your Google account in order to register the printer with Google Cloud Print.

Access to Google Cloud Print with the web browser on the computer or the mobile device, then register
the required information.

* The screen above may change without prior notice.

Registering the Printer with Google Cloud Print

Register the printer with Google Cloud Print.

If the firmware version is Ver. 2.010 or later, registration is possible from Google Chrome on your
computer, smartphone, or tablet device.

Registration Using Google Chrome

For earlier versions, register the information from the printer.

Registration from the Printer

Important
• For instructions on checking the firmware version and updating the firmware, refer to "Firmware

Update".
• After you update the firmware, you must re-register the printer even if it was already registered.
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• When you register a printer, the printer must be connected to the LAN and the LAN environment
must be connected to the Internet. Note that the customer is responsible for all Internet connection
fees.

• When the printer owner changes, delete the printer registration from Google Cloud Print.

Registration Using Google Chrome

1. Start the Google Chrome browser on your computer, smartphone, or tablet device.

Then from  (Chrome menu), select Sign in to Chrome..., and log in to your Google
account

2. From  (Chrome menu), select Settings

3. Click Show advanced settings... to display the information. Then for Google Cloud
Print, select Manage

4. Select Add printers for the printer to be added

5. When the confirmation message for registering the printer appears, select OK

Printer registration is complete.

Registration from the Printer

The authentication procedure using the web browser on the computer or the mobile device is required
in the process of registering. Because the authentication URL is printed from printer when the
authentication process is performed, prepare A4 or Letter-sized plain paper.

1. Make sure that the printer is turned on

2. From the operation panel, select the Setup button.

3. Select Web service setup -> Connection setup -> GoogleCloudPrint -> Register w/
service

Note
• If you have already registered the printer with Google Cloud Print, the confirmation message

to re-register the printer is displayed.

4. When the confirmation screen to register the printer is displayed, select Yes

5. Select a display language on the print setting screen of Google Cloud Print

The confirmation message to print the authentication URL is displayed.

6. Load A4 or Letter-sized plain paper, then select OK
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The authentication URL is printed.

7. Ensure that the authentication URL is printed, select Yes

8. Perform the authentication process using the web browser on the computer or the
mobile device

Access to the URL using the web browser on the computer or the mobile device and perform the
authentication process following the on-screen instructions.

Note
• Perform the authentication process with your Google account which you have gotten in

advance.

9. When the message that the registration is complete is displayed on the LCD of the
printer, select OK

When authentication process is complete properly, the registration items are displayed. When
authentication process is complete, you can print the data with Google Cloud Print.
When authentication process is not complete properly and the error message is displayed, select
OK. When the confirmation message to print the authentication URL is displayed, print the
authentication URL, then perform the authentication process on the computer again.

Deleting the Printer from Google Cloud Print

To change the printer owner or to re-register the printer, first delete the printer from Google Cloud Print by
using the respective procedure.

Deletion from Google Chrome
Deletion from the Printer

Deletion from Google Chrome

1. Start the Google Chrome browser on your computer, smartphone, or tablet device.

Then from  (Chrome menu), select Sign in to Chrome..., and log in to your Google
account

2. From  (Chrome menu), select Settings

3. Click Show advanced settings... to display the information. Then for Google Cloud
Print, select Manage

4. Select Delete for the printer to be deleted

5. When the confirmation message for deleting the printer appears, select OK
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Deletion from the Printer

1. Make sure that the printer is turned on

2. From the operation panel, select the Setup button.

3. Select Web service setup -> Connection setup -> GoogleCloudPrint -> Delete from
service

4. When the confirmation screen to delete the printer is displayed, select Yes
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Printing from Computer or Smartphone with Google Cloud Print

When you send print data with Google Cloud Print, the printer receives the print data and prints it
automatically if the printer is turned on.

When printing from a smartphone, tablet, computer, or other external device by using Google Cloud Print,
load paper into the printer in advance.

Sending the Print Data with Google Cloud Print

1. Make sure that the printer is turned on

Note
• If you want to send the print data from an outside location, turn on the printer in advance.

2. Send print data from your smartphone, tablet, or computer

The figure below is an example of when printing from the web browser corresponding with Google
Cloud Print. The screen differs depending on the applications or services supporting Google Cloud
Print.

When the preparation for printing with Google Cloud Print is complete and when the printer is turned
on, the printer receives the print data and prints it automatically.

Note
• If the firmware version is Ver. 2.010 or later, you can select which printer to use.

For the printing method, you can also select using the local network or using the cloud.
• Depending on the communication status, it may take a while to print the print data or the printer may

not receive the print data.
• While printing with Google Cloud Print, the printing may be canceled depending on the printer's

status, such as when the printer is being operated or an error has occurred. To resume printing,
check the printer's status, then print with Google Cloud Print again.

• For print settings:
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• If you select the media type other than plain paper or if you select the paper size other than A4/
Letter/B5/A5-size, the print data is printed in single-sided even when you select the duplex print
setting. (* The paper size differs depending on the model of your printer. For information about
the supported paper sizes, go to the Online Manual home page, and refer to the "Cannot Print
Properly with Automatic Duplex Printing" for your model.)

• If you select plain paper as media type or if you select B5/A5-size as paper size, the print data is
printed with border even when you select the borderless print setting.

• The print results may differ from the print image depending on the print data.
• Depending on the device sending the print data, you may not select the print settings when

sending the print data with Google Cloud Print.

When you want to print from Google Cloud Print immediately

When the printer cannot receive the print data, or you want to start printing immediately, you can check
whether there is a print job on the Google Cloud Print and start printing manually.

Follow the steps below.

Important
• Depending on your printer model, this function may not be available.

1. Make sure that the printer is turned on

2. From the operation panel, select the Setup button.

3. Select Web service inquiry

Note
• If you have not registered the printer with Google Cloud Print, Web service inquiry is not

displayed.
Register the printer with Google Cloud Print.

4. Select GoogleCloudPrint

5. Press the OK button

Connect to the server. If print data is available, print that data.
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Printing from AirPrint Compliant Device

This document explains how to use AirPrint to print wirelessly from your iPad, iPhone and iPod touch to a
Canon printer.

AirPrint enables you to print photos, email, Web pages and documents from your Apple device directly to
your printer without installing a driver.

Checking Your Environment

First, check your environment.

• AirPrint Operation Environment

To use AirPrint, you will need one of the following Apple devices running the latest version of iOS:

◦ iPad (all models)
◦ iPhone (3GS or later)
◦ iPod touch (3rd generation or later)

• Network Environment

The Apple device (iPad, iPhone, or iPod touch) and this printer must be connected to the same Wi-Fi
network or connected in AP mode.

Printing with AirPrint

1. Check that this printer is turned on and the Apple device and this printer is connected to
the LAN or connected in AP mode.

2. From the app of your Apple device, tap the operation icon to display the menu options.
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3. From the menu options, tap Print.

4. From Printer Options, select the model that you are using.

Important
• Because some app does not support AirPrint, Printer Options may not be displayed. If an app

does not let you use printer options, you cannot print from that app.

Note
• The Printer Options differ depending on the app and model you are using.
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5. When printing a file type that has multiple pages, such as a PDF file, click Range and
then click All Pages or select the range of pages to be printed.

6. For 1 Copy, click + or - to set the number of required copies.

7. For Duplex Printing, click On to enable duplex printing or click Off to disable the
function.

8. Tap the Print.

When you execute printing, the printer prints according to the specified settings.

Paper Size

With AirPrint, the paper size is selected automatically according to the app being used on the Apple
device and the region in which AirPrint is used.

When Apple's photo app is used, the default paper size is L size in Japan, and 4"x6" or KG in other
countries and regions.

When documents are printed from Apple's Safari app, the default paper size is letter size in the U.S.
region, and A4 in Japan and Europe.

Important
• Your app may support different paper sizes.

Checking the Print Status

During printing, a Print Center icon is displayed in the list of recently used apps, and you can use it to
check the print progress.

Press the Home button on the Apple device twice to set the Multitasking mode. Then swipe to the right to
display the Print Center icon and a Print Summary.
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Deleting a Print Job

To delete a print job with AirPrint, use one of the following two methods:

• From the printer: If your printer has a LCD monitor, use the operation panel to cancel the print job.
If you printer does not have a LCD monitor, press the Stop button on the printer to cancel the print
job.

• From an Apple device: Press the Home button on the Apple device twice to set the Multitasking
mode, and then swipe to the right. Tap the Print Center icon to display a Print Summary. Tap the
print job to be canceled, and then tap Cancel Printing.

AirPrint Troubleshooting

If the document does not print, check the following:

1. Check that the printer power is on. If the printer power is on, turn it off and then back on
again, and check whether the issue is resolved.

2. Check that the printer is connected by LAN to the same network subnet as the device on
which iOS is installed.

3. Check that the printer has enough paper and ink.

4. If your printer has a LCD monitor, check that no error message is displayed on the LCD
monitor.

If the problem persists, use the printer driver on your computer to execute printing and check whether
the document can be printed normally on the printer.

If the document cannot be printed, refer to the Online Manual for your model.
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Note
• After you turn on the printer, it may take few minutes before the printer can communicate through a

wireless LAN connection. Confirm that the printer is connected to the wireless LAN, and then try
printing.

• If Bonjour on the printer is disabled, AirPrint cannot be used. Check the LAN settings on the printer,
and enable Bonjour.

Note
• The windows used in the explanations may differ from those displayed by your Apple product or app.
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Checking Printer Information

You can use your smartphone, tablet, or computer to check the Printer status and execute utility functions
from apps such as Canon Inkjet Print Utility and MAXIFY Printing Solutions.

You can also use the convenient web services presented by Canon.

1. Selecting Printer Information in an Apps Screen

Note
• You can also enter IPv4 address directly in the web browser to display printer information.

1. Load one sheet of A4 size or Letter size plain paper

2. On the printer operation panel, select the  Setup button, and then select Device
settings -> LAN settings -> Print LAN details

IP address printing starts.

3. From your computer, smartphone, or tablet device, open the Web browser, and enter the
following URL:

http:// <Printer IP address>

For <Printer IP address>, enter the IP address that you checked in the previous procedure.

2. Entering Username and Administrator's Password

From the authentication screen, enter the Username and Password.

Username: ADMIN
Password: See "About the Administrator Password."

Note
• The Username display may differ depending on your browser.

3. Displaying Printer Information

The top screen for printer information is displayed.
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Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.
You can also connect to the ink purchase site or support page, and use Web Services.

Utilities
This function allows you to set and execute the printer utility functions such as cleaning.

AirPrint settings
This function allows you to specify the Apple AirPrint settings, such as position information.

Google Cloud Print setup
This function allows you to register this printer to Google Cloud Print or delete the printer.

Print from E-mail setup
Allows you to register printers, check print addresses, and delete registered printers.

IJ Cloud Printing Center setup
Allows you to register to IJ Cloud Printing Center or to delete a registration.

Security
Allows you to set the Administrator's password and Operation restrictions for the machine.

Important
• For the initial Password, see "About the Administrator Password."

For Security reasons, we recommend that you change the Password to an individual
password.

• The following character restrictions apply to the password that you enter:

• Set the password by using 0 to 32 characters.
• The allowed characters are single-byte alphanumeric characters.

Records of use
Displays a record of your printer usage, such as the number of pages printed.

Firmware update
This function allows you to update the firmware and check version information.

93



Manual (Online)
This function displays the Online Manual.
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How to Use Print from E-mail

By using Print from E-mail, you can easily print a photo or document saved on your smartphone, tablet, or
computer just by attaching it to an e-mail.

You can print simply from outside like a travel destination. Also, your family or friends can print by
registering beforehand.

You can use Print from E-mail on any Canon printer that supports the service.

Checking Your Environment

First, check your environment.

• Network environment

This product needs to be connected to a LAN with an Internet connection.

Important
• The user will bear the cost of Internet access.
• This function may not be available in some countries/regions.
• Depending on your printer model, this function may not be available.

Preparing to use Print from E-mail

To use Print from E-mail, you need to register the printer by entering information about the printer's
owner.

1. Print the printer registration page's URL and the PIN code

2. Access the URL and enter the owner's e-mail address and other required information

3. Check if an e-mail has been sent to the e-mail address you entered
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4. Access the URL provided in the e-mail and complete the printer registration process

Note
• The e-mail address that appears on the screen when you have finished registering is the e-mail

address that will be used just for the Print from E-mail function.

For details about the registration procedure, see here

Printing from Your Smartphone, Tablet, or Computer

1. Prepare a file that you want to print

The file format, number of files, and file size that this printing function supports are provided below.

Supported File Formats

• Adobe PDF files
• JPEG files
• .doc/.docx/.xls/.xlsx/.ppt/.pptx files

Important
• Only files that are attached to e-mail can be printed. E-mail messages cannot be printed.
• Adobe PDF files and .doc/.docx/.xls/.xlsx/.ppt/.pptx files that are encrypted, password-

protected, or set to print disabled cannot be printed.
• Files that are attached as compressed files cannot be printed.
• Files other than Adobe PDF files, JPEG files and .doc/.docx/.xls/.xlsx/.ppt/.pptx files cannot be

printed.

Supported Number of Files and File Sizes

• Up to 10 attachment files can be printed.
• The maximum size of an e-mail with attachment files is 10 MB.

Note
• The size of an e-mail is determined based on the size of the entire transmission file, including

the e-mail message and the header. Therefore sometimes an attachment file cannot be printed
even if the size of the attachment file is less than 10 MB.

• If the size of an attached JPEG file is less than 10 KB, the file cannot be printed.

2. Attach the file that you want to print from your smartphone, tablet, or computer to the e-
mail and send it to the e-mail address for printing

To check the print address, on the printer operation panel, select the  Setup button, and then
select Web service setup -> Connection setup -> Print from E-mail setup -> Register w/ service.

Important
• You will not be able to use the service during periods when the service is undergoing

maintenance.
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Use the Service With More Than One Person

To allow multiple users to use this function, register users (other than the printer's owner) as members.

1. The printer's owner uses his/her smartphone, tablet, or computer to access the service's
login URL (https://pr.mp.c-ij.com/po) and logs in

2. Select the printer name that you want to add the member. Click Member Settings ->
Add to enter the member's e-mail address, and click Add

A URL of the member registration page is sent to the e-mail address of the newly registered member.

3. Registered member accesses to the URL that is included in the e-mail, and complete the
registration

You can use this service from registered e-mail address.

Note
• You can register up to 500 members.

Print from E-mail Troubleshooting

The Document Does Not Print
If You Cannot Register to the Service or Delete the Service
If You Cannot Print after the Printer Is Repaired

The Document Does Not Print

If the document does not print, check the following:

• Check that the printer power is on.
If the printer power is on, turn it off and then back on again, and check whether the issue is resolved.

• Check that the printer is connected to the network.
• Check that the printer is connected to a LAN and the LAN has an Internet connection.
• Look at the printer LCD monitor and check that no error message is displayed.

If the problem persists, use the printer driver on your computer to execute printing and check whether
the document can be printed normally on the printer.
If the document cannot be printed, refer to the Online Manual for your printer.

• Check that the file attached to the e-mail is an Adobe PDF file, a JPEG file, or
a .doc/.docx/.xls/.xlsx/.ppt/.pptx file.

• Check whether the e-mail address of the send destination is correct.

To check the print address, on the printer operation panel, select the  Setup button, and then
select Web service setup -> Connection setup -> Print from E-mail setup -> Register w/ service.

• Check that the user's e-mail address for using this service is registered.
If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).

• In the Print Status screen, click Go to Print History Screen and check the history of jobs that were
sent. You can check the error details.
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If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).

Note
• For a wireless LAN connection, after the printer is turned on, it may take a few minutes before

communication becomes possible. Confirm that your printer is connected to the wireless LAN, and
then try printing.

If You Cannot Register to the Service or Delete the Service

If You Cannot Register to the Service

• If the printer operation panel display the message "Failed to register with "Print from E-mail".",
the registration to Print from E-mail may not have been completed in time. Select OK to release
the error, and start over again from the beginning.

• Check that the firmware version of the printer has been updated.

If You Do Not Receive the URL to Complete the Registration by E-mail

• An incorrect e-mail address may have been entered. Wait about 30 minutes, and operate the printer
operation panel to print the printer registration URL and PIN code. Then re-register from the
beginning.

If You Cannot Delete the Service

• If the printer operation panel display the message "Failed to connect to "Print from E-mail". Only
the information on the printer was deleted." is displayed, it could be that the registration
information on the service could not be deleted even though the Print from E-mail information
stored on this printer was deleted.
Select OK to release the error, and then access the service's login URL (https://pr.mp.c-ij.com/po)
to delete the registration information.

• If the Print from E-mail information stored on this printer could not be deleted even though the

registration information on the service was deleted, on the printer operation panel, select the 
Setup button, and then select Web service setup -> Connection setup -> Print from E-mail
setup -> Delete from service, and delete the registration information.

If You Cannot Print after the Printer Is Repaired

Re-registering the printer and the printer owner

• When the printer is repaired, all of the registered information is deleted and Print from E-mail can no
longer be used.
If you want to use this service again, you must re-register the printer and the printer owner.
For information about the re-registration procedure, see "Preparing to Use Print from E-mail".
Even if users other than the owner were registered as members, repeat the registration starting from
here.

98



Preparing to Use Print from E-mail

To use this service to print a photo or document, you need to follow the procedure provided below and
register the printer.

Print the Printer Registration Page's URL and the PIN Code

First, print the printer registration page's URL and the PIN code.
Check that there is sufficient amount of ink in the printer, and then print using the printer's operation panel.

1. Check that the printer is connected to the network

Important
• This product needs to be connected to a LAN with an Internet connection.

2. On the printer operation panel, select the  Setup button, and then select Web
service setup -> Connection setup -> Print from E-mail setup -> Register w/ service.

3. Follow the instructions on the screen and print the printer registration URL and PIN code

Important
• Do not turn off the power on the printer until the registration process is completed.

Access the printed URL and log in within 25 minutes.

• If you canceled the registration before it is completed, repeat the procedure from printing the
registration information.

Access the Printed URL and Enter the Owner's E-mail Address and Other
Required Information

Next, enter the owner's e-mail address and other required information.

1. Access the printed URL by using the browser on your smartphone, tablet, or computer,
and select Log In

2. In the use agreement window, select Agree

Important
• If you do not select Agree in the use agreement window, you will not able to register as the

printer owner.

3. Enter the printer owner's e-mail address, and select Next

Important
• An e-mail is sent with the required information for completing the registration to the e-mail

address entered for the printer's owner.
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• If domain-specific reception is set, change the setting so that mail can be received from
"info@mp.c-ij.com"

Note
• The e-mail address of the printer owner cannot be changed once the printer owner is

registered.
To change the e-mail address, delete the registration of the registered printer, and re-register
the printer owner by using the new e-mail address. In this case, all previously registered
information will be deleted.

• The notification is sent automatically to the registered e-mail address when the printing or
service maintenance starts.

4. In the Printer Owner Registration window, enter the information shown below, and click
Next

User Name

Enter any name.
The name that you enter is displayed at login.

Important
• The maximum number of characters that can be entered is 30.

Language

Select the language that you are using.
The language that you select is used in notification e-mails such as print start notices.

Time Zone

Refer to this section, and select the standard time of the city that is nearest to the region where you
live.

Date/Time Display Format

Select the format of your choice.
The format that you select is applied to the date/time information in the screens and notification e-
mails of this service.

Daylight Saving Time

This setting is combined with the Time Zone setting, and applied to the date/time information in the
screens and notification e-mails of this service.
When you select ON, 1 hour is added to the Time Zone setting when the date/time information is
displayed.

5. In the Printer Registration window, enter the Printer Name, and select Confirm

Enter any name that will allow you to identify the printer.

Important
• The maximum number of characters that can be entered is 30.
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6. In the Confirm Owner Registration window, check the registration information, and
select Register

A temporary password will be displayed.

Important
• The temporary password that appears is not included in the notification e-mail. Be sure to write

down the temporary password before closing the screen.

Check if an E-mail Has Been Sent to the E-mail Address You Entered

A URL is notified to complete the registration to the e-mail address that for the registered printer's owner.

Access the URL in the E-mail and Complete the Printer Registration

1. Access the URL provided in the e-mail

Important
• You have to complete the registration within 30 minutes.

2. Enter the registered e-mail address of the printer's owner, the temporary password, and
select Log In

3. Set a password of your choice, and select Register

When the password setting process is completed, the printer's e-mail address and the service's URL
are displayed, and the printer's registration process is completed.

Important
• When you enter the password, the following character restrictions apply.

• Set a password that has 8 or more characters.
• The characters that you can use are single-byte uppercase letters, single-byte lowercase

letters, and single-byte numbers.
• In the password, combine all of the different types of characters that can be used.

• The displayed printer's e-mail address and the URL of the login page are not sent. Be sure to
write down the printer's e-mail address and the URL of the login page before closing the screen.
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Timezone List

(UTC-12:00) International Date Line West

(UTC-11:00) Midway Island

(UTC-10:00) Hawaii

(UTC-09:00) Alaska

(UTC-08:00) Tijuana, Baja California, Pacific Time (US & Canada)

(UTC-07:00) Arizona, Chihuahua, La Paz, Mazatlan, Mountain Time (US & Canada)

(UTC-06:00) Guadalajara, Mexico City, Monterrey, Saskatchewan, Central America, Central Time (US & Canada)

(UTC-05:00) Indiana (East), Bogota, Lima, Quito, Eastern Time (US & Canada), Caracas

(UTC-04:00) Asuncion, Santiago, Georgetown, La Paz, San Juan, Manaus, Atlantic Time (Canada), Newfoundland

(UTC-03:00) Cayenne, Greenland, Buenos Aires, Brasilia, Montevideo

(UTC-02:00) Mid-Atlantic

(UTC-01:00) Azores, Cape Verde Is.

(UTC+00:00) Casablanca, Dublin, Edinburgh, Lisbon, London, Monrovia, Reykjavik, Coordinated Universal Time

(UTC+01:00)
Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna, Sarajevo, Skopje, Warsaw, Zagreb, Brussels,
Copenhagen, Madrid, Paris, Belgrade, Bratislava, Budapest, Ljubljana, Prague, West Central Africa

(UTC+02:00)
Athens, Bucharest, Istanbul, Amman, Windhoek, Jerusalem, Cairo, Harare, Pretoria, Beirut, Helsinki,
Kyiv, Riga, Sofia, Tallinn, Vilnius, Minsk

(UTC+03:00) Kuwait, Riyadh, Tbilisi, Nairobi, Baghdad, Moscow, St. Petersburg, Volgograd, Tehran

(UTC+04:00) Abu Dhabi, Muscat, Yerevan, Baku, Port Louis, Kabul

(UTC+05:00)
Islamabad, Karachi, Ekaterinburg, Tashkent, Sri Jayawardenepura, Chennai, Kolkata, Mumbai, New
Delhi, Kathmandu

(UTC+06:00) Astana, Dhaka, Almaty, Novosibirsk, Yangon (Rangoon)

(UTC+07:00) Krasnoyarsk, Bangkok, Hanoi, Jakarta

(UTC+08:00) Irkutsk, Ulaan Bataar, Kuala Lumpur, Singapore, Perth, Taipei, Beijing, Chongqing, Hong Kong, Urumqi

(UTC+09:00) Seoul, Yakutsk, Osaka, Sapporo, Tokyo, Adelaide, Darwin

(UTC+10:00) Vladivostok, Canberra, Melbourne, Sydney, Guam, Port Moresby, Brisbane, Hobart

(UTC+11:00) Magadan, Solomon Is., New Caledonia

(UTC+12:00) Auckland, Wellington, Fiji, Marshall Is., Petropavlovsk-Kamchatsky

(UTC+13:00) Samoa, Nuku'alofa
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Print Easily from a Smartphone or Tablet with MAXIFY Printing
Solutions

Use MAXIFY Printing Solutions to easily print photos saved on a smartphone or tablet wirelessly.

MAXIFY Printing Solutions can be downloaded from App Store and Google Play.

103



Printing with Windows RT

When you use Windows RT, printing is easy because you simply connect this printer to the network.

For information about connecting to the network, see the setup URL (http://www.canon.com/ijsetup) for
using this product from your computer, smartphone, or tablet device.

When the connection is complete, the Canon Inkjet Print Utility software, which allows you to specify
detailed print settings, is downloaded automatically.
By using Canon Inkjet Print Utility, you can check the Printer status and specify detailed print settings. (The
available functions will differ depending on your usage environment and connection method.)
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Overview of the Printer

Safety Guide
Safety Precautions
Regulatory and Safety Information

Main Components and Basic Operations
Main Components
About the Power Supply of the Printer
LCD and Operation Panel

Loading Paper / Originals
Loading Paper

Replacing an Ink Tank
Replacing an Ink Tank
Checking the Ink Status from Your Computer
Checking the Ink Status

Maintenance
When Printing Becomes Faint or Colors Are Incorrect
Performing Maintenance from a Computer
Cleaning the Printer

Changing the Printer Settings
Changing Printer Settings from Your Computer
Changing the Machine Settings on the LCD

Information about Network Connection
Useful Information about Network Connection

About Network Communication
Changing and Confirming Network Settings
Screens for Network Connection of IJ Network Tool
Other Screens of IJ Network Tool
Appendix for Network Communication

Tips for Ensuring Optimal Printing Quality
Useful Information about Ink
Key Points to Successful Printing
Be Sure to Check Paper Settings before Printing
Be Sure to Set Cassette Paper Information after Loading Paper
Canceling a Print Job
Key to Enjoying Consistent Printing Quality
Precautions for Safe Transport of the Printer

Legal Limitations on Use of Your Product and Use of Images

Specifications
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Safety Guide

Safety Precautions

Regulatory and Safety Information
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Safety Precautions

Choosing a location

• Do not install the machine in a location that is unstable or subject to excessive vibration.
• Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or

close to a heating source.
To avoid the risk of fire or electric shocks, use the machine under the operating environment specified
in the On-screen Manual.

• Do not place the machine on a thick rug or carpet.
• Place the machine with its back in a location that is more than 2 inches (5 cm) away from the wall.

Power supply

• Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

• Never remove the plug by pulling on the cord.
Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

• Do not use an extension lead/cord.

Working around the machine

• Never put your hands or fingers in the machine while it is printing.
• When moving the machine, carry the machine at both ends. In case the machine weighs more than

14 kg, it is recommended to have two people lifting the machine. Accidental dropping of the machine
causes injury. For the machine's weight, refer to the On-screen Manual.

• Do not place any object on the machine. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the machine.

• Do not transport or use the machine on a slant, vertically or upside-down, as the ink may leak and
damage the machine.

Working around the machine (For the multifunction printer)

• When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The
Platen Glass may break and cause injury.

Print Heads/ink tanks and FINE Cartridges

• Keep ink tanks out of the reach of children. In case ink* is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.
* Clear Ink contains nitrate salts (For models containing Clear Ink).

• In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

• Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.
The metal parts may be very hot and could cause burns.

• Do not throw ink tanks and FINE Cartridges into fire.
• Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
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Regulatory and Safety Information

For models containing lithium battery

• Dispose of used batteries according to the local regulations.
• Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10409 (Contains FCC ID: AZDK30357)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID:AZDK30357

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A., Inc.
One Canon Park
Melville, New York 11747
1-800-652-2666
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Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and
meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and
operated keeping the radiator at least 20cm or more away from person's body (excluding extremities:
hands, wrists, feet and ankles).

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage
radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrôlé et respecte les règles d'exposition aux fréquences radioélectriques (RF)
CNR-102 de l'IC. Cet équipement doit être installé et utilisé en gardant une distance de 20 cm ou plus
entre le dispositif rayonnant et le corps (à l'exception des extrémités : mains, poignets, pieds et chevilles).

Users in Jordan

This printer contains WLAN Module approved by TRC/LPD/2013/130

Name of WLAN Module : K30357

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human
health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.
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Korisnici u Srbiji

Ovaj simbol označava da ovaj proizvod ne sme da se odlaže sa ostalim kućnim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati određenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sličan novi proizvod, ili ovlašćenom centru
za prikupljanje za reciklažu istrošene električne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada može da ima moguće negativne posledice po životnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavnom vezuju za EEE. U isto vreme, vaša saradnja na
ispravnom odlaganju ovog proizvoda će doprineti efikasnom korišćenju prirodnih resursa. Za više
informacija o tome gde možete da predate vašu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne službe, odobreni plan reciklaže ili Gradsku čistoću. Za više
informacija o vraćanju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.

India only.

This product is not to be disposed of with your household waste, according to the e-waste (Management
and Handling) Rules, 2011.

This product should be handed over to a designated collection point, e.g., to an authorized collection site
for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste
could have a possible negative impact on the environment and human health due to potentially hazardous
substances that are generally associated with EEE. At the same time, your cooperation in the correct
disposal of this product will contribute to the effective usage of natural resources. For more information
regarding return and recycling of WEEE products, please visit http://www.canon.co.in/environment/.

Also, this product complies with the "India E-waste Rule 2011" and prohibits use of lead, mercury,
hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations
exceeding 0.1 % by weight and 0.01 % by weight for Cadmium, except for the exemptions set in Schedule
II of the Rule.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce your electricity costs. After the last print it switches to
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a time,
the device switches to its Power Save Mode. The devices consume less power (Watt) in these modes.
If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode,
please consider that this device may then only switch to a lower energy level after a longer period of
time or not at all.
Canon does not recommend extending the Activation Times from the optimum ones set as default.
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Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.
Products which meet the stringent requirements of the Energy Star® programme for both environmental
benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can
support printing on media down to a weight of 64g/m2, lighter paper means less resources used and a
lower environmental footprint for your printing needs.

Regulatory Model Code (RMC) is for identification and proof that the product complies with the
regulations. Please note that RMC is different from the marketing model number of the product.
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Main Components and Basic Operations

Main Components

About the Power Supply of the Printer

LCD and Operation Panel
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Main Components

Front View

Rear View

Inside View

Operation Panel
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Front View

(1) operation panel
Use to change the settings of the printer or to operate it.

Operation Panel

(2) front cover
Open to replace an ink tank or remove jammed paper inside the printer.

(3) paper output tray
Pull out to support printed paper. It will then cover the cassette. Pull out for normal use.

(4) cassette 1
Accepts all sizes of paper compatible with this printer (plain paper, photo paper, envelopes, etc.).

Paper Sources to Load Paper

(5) cassette 2
Accepts A4, Letter, and Legal-sized plain paper.

Paper Sources to Load Paper

(6) output tray extension
Extend to support ejected paper.

(7) paper output support
Open to support ejected paper.
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Rear View

(1) rear cover
Open when removing jammed paper.

(2) power cord connector
Plug in the supplied power cord.

(3) wired LAN connector
Plug in the LAN cable to connect the printer to a LAN.

(4) USB port
Plug in the USB cable to connect the printer with a computer.

Important
• Do not touch the metal casing.
• Do not plug in or unplug the USB cable or LAN cable while printing.
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Inside View

(1) ink tank eject lever
Push up when removing an ink tank.

(2) print head holder
The print head is pre-installed.

Note
• For details on replacing an ink tank, see Replacing an Ink Tank.
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Operation Panel

* All lamps on the operation panel are shown lit in the figure below for explanatory purposes.

(1) LCD (Liquid Crystal Display)
Displays messages, menu items, and the operational status.

(2) ON button
Turns the power on or off.

Turning the Printer On and Off

(3) POWER lamp
Lights after flashing when the power is turned on.

(4) Stop button
Cancels a print job in progress.

(5) Alarm lamp
Lights or flashes when an error occurs.

(6) OK button
Finalizes the selection of a menu or setting item. This button is also used to resolve an error.

(7)  and  buttons
Used to select a menu or setting item.

LCD and Operation Panel

(8) Back button
Returns the screen to the previous screen.

(9) Setup button
Displays the Setup menu screen. With this menu, you can perform printer maintenance and change
printer settings.
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About the Power Supply of the Printer

Confirming that the Power Is On

Turning the Printer On and Off

Notice for the Power Plug/Power Cord

Notice for Unplugging the Power Cord
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Confirming that the Power Is On

The POWER lamp is lit when the printer is turned on.

Even if the LCD is off, if the POWER lamp is lit, the printer is on.

Note
• It takes about 10 seconds until you can operate the printer after you turn on its power. Wait until the

standby screen is displayed on the LCD.
• The LCD will turn off if the printer is not operated for about 5 minutes. To restore the display, press any

button except the ON button on the operation panel or perform the print operation.
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Turning the Printer On and Off

Turning on the printer

1. Press the ON button to turn on the printer.

The POWER lamp flashes and then remains lit.

Confirming that the Power Is On

Note
• It takes about 10 seconds until you can operate the printer after you turn on its power. Wait until

the standby screen is displayed on the LCD.
• If the Alarm lamp lights up or flashes and an error message is displayed on the LCD, see A

Message Is Displayed.
• You can set the printer to automatically turn on when a print operation is performed from a

computer connected by USB cable or wireless network. This feature is set to off by default. For
details on the auto power on feature, see below.

From the printer

Turning on/off the Printer Automatically

From the computer

Managing the Printer Power

Turning off the printer

1. Press the ON button to turn off the printer.

When the POWER lamp stops flashing, the printer is turned off.

Important
• When you unplug the power cord after turning off the printer, be sure to confirm that the

POWER lamp is off.
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Note
• You can set the printer to automatically turn off when no operations are performed or no print

jobs are sent to the printer for a certain interval. This is the default setting. For details on the
auto power off feature, see below.

From the printer

Turning on/off the Printer Automatically

From the computer

Managing the Printer Power
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Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not have anything
unusual described below.

• The power plug/power cord is hot.
• The power plug/power cord is rusty.
• The power plug/power cord is bent.
• The power plug/power cord is worn.
• The power plug/power cord is split.

Caution
• If you find anything unusual with the power plug/power cord described above, unplug the power cord

and call for service. Using the printer with one of the unusual conditions above may cause a fire or an
electric shock.
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Notice for Unplugging the Power Cord

To unplug the power cord, follow the procedure below.

Important
• When you unplug the power cord, press the ON button, then confirm that the POWER lamp is off.

Unplugging the power cord before the POWER lamp is turned off may cause drying or clogging of the
print head and print quality may be reduced.

1. Press the ON button to turn the printer off.

2. Confirm that the POWER lamp is off.

3. Unplug the power cord.

The specification of the power cord differs depending on the country or region of use.
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LCD and Operation Panel

Pressing the Setup button (A) on the operation panel shows the Setup menu screen to select various
functions or settings.

Selecting a Menu or Setting Item

On the menu screen or settings screen, use the  or  button (B) to select an item or option, then press
the OK button (C) to proceed with the procedure.

To return to the previous screen, press the Back button (D).

Example: Changing the automatic paper source switching setting for the cassettes.

Press the Setup button (A) in the standby screen.

Use the  or  button (B) to select Device settings.

Press the OK button (C).

Use the  or  button (B) to select Cassette settings.

Press the OK button (C).

Use the  or  button (B) to select Auto feed switch.

Press the OK button (C).
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Use the  or  button (B) to change the setting, then press the OK button (C).
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Loading Paper

Loading Paper
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Loading Paper

Paper Sources to Load Paper

Loading Plain Paper / Photo Paper

Loading Envelopes

Media Types You Can Use

Media Types You Cannot Use

Printing Area
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Paper Sources to Load Paper

Page Sizes and Media Types compatible with the printer

Paper can be loaded into two sources, the upper cassette 1 (A) and lower cassette 2 (B).

In the upper cassette 1 (A), all sizes of paper compatible with this printer (plain paper, photo paper,
envelopes, etc.) can be loaded.

In the lower cassette 2 (B), A4, Letter, and Legal-sized plain paper can be loaded.

Media Types You Can Use

You can load the same size of plain paper (A4, Letter, and Legal) in both cassettes, then set the printer to
automatically switch the paper source and feed paper from the other cassette if paper in one cassette
runs out.

Cassette settings

Note
• When printing, be sure to select the correct page size and media type. If the wrong page size and

media type are selected, the printer may feed paper from the wrong paper source or may not print
with the proper print quality.

For details on loading paper in a cassette, see below.

Loading Plain Paper / Photo Paper
Loading Envelopes

Adjusting the cassette according to the Paper

The cassette can be adjusted to three lengths. Press down the lock (C) on the cassette to extend the
cassette.
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D: Lock position for stowing the cassette

When not using this printer for long period of time or moving it, set it to the position D. The cassette will fit
into the width of the printer. Paper cannot be loaded while in this position.

E: Lock position for A4 or Letter-sized paper or smaller

For A4 or Letter-sized paper or smaller, set it to the position E. The cassette sticks out of the printer, but
you can cover it by pulling out the paper output tray. Set the cassette to this position for normal use.

F: Lock position for paper larger than A4 or Letter size

For paper larger than A4 size, such as Legal size, set the cassette to the position F. When the cassette is
set to this position and inserted into the printer, pulling out the paper output tray will not fully cover it. (The
cassette sticks out of the printer.)

Loading Paper with the Print Side Facing Down

If the paper has a print side (front or back), such as photo paper, load it with the whiter side (or glossy
side) facing down.
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Loading Plain Paper / Photo Paper

You can load paper in the cassette 1 or cassette 2.

* This section describes how to load paper in the cassette 1. The procedure to loading paper in cassette 2 is
also the same.

Important
• If you cut plain paper into small size such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm) to perform trial

print, it can cause paper jams.

Note
• In the cassette 1, you can load all sizes of paper compatible with this printer (plain paper, photo paper,

envelopes, etc.).
• In the cassette 2, you can load A4, Letter, and Legal-sized plain paper.
• We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use.

• You can use general copy paper.
• For the page size and paper weight you can use for this printer, see Media Types You Can Use.
• For loading envelopes, see Loading Envelopes.

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

Note
• Align the edges of paper neatly before loading. Loading paper without aligning the edges may

cause paper jams.
• If paper is curled, hold the curled corners and gently bend them in the opposite direction until the

paper becomes completely flat.

For details on how to flatten curled paper, see "Load the paper after correcting its curl." in Paper Is
Smudged/Printed Surface Is Scratched.

• When using Photo Paper Plus Semi-gloss SG-201, even if the sheet is curled, load one sheet at a
time as it is. If you roll up this paper to flatten, this may cause cracks on the surface of the paper
and reduce the print quality.

2. Pull out the cassette from the printer.
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3. Slide the paper guide (A) in front and (B) on the right to open the guides.

4. Load the paper stack WITH THE PRINT SIDE FACING DOWN, and place it in the center of
the cassette.

Important
• Always load paper in the portrait orientation (C). Loading paper in the landscape orientation (D)

can cause paper jams.

Note
• If paper has print side (front or back), such as photo paper, load it with the whiter side (or glossy

side) facing down.
• Align the paper stack with the edge of the cassette as shown in the figure below.

If the paper stack is in contact with the protrusion (E), the paper may not be fed properly.
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• To load 5" x 7" (13 x 18 cm) size paper or smaller, raise the tab (F) of the paper guide. (5" x 7" (13
x 18 cm) size paper or smaller can be loaded in the cassette 1 only.)

• To load paper larger than A4 size in the cassette, press down the lock (G) on the cassette, then
extend the cassette all the way out.

5. Align the paper guide (A) in front with the paper stack.

For standard sizes, set the paper guide (A) to where it clicks into place.

6. Slide the paper guide (B) on the right to align the right and left guides with both sides of the
paper stack.

Do not slide the paper guides too hard against the paper. The paper may not be fed properly.
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Note
• Do not load sheets of paper higher than the load limit mark (H).
• Keep the paper stack height below the tabs (I) of the paper guides.

7. Insert the cassette into the printer.

Push the cassette into the printer until it stops.

After inserting the cassette into the printer, the paper information registration screen for the cassette is
displayed on the LCD.

Note
• When A4 or Letter-sized paper or smaller is loaded, the cassette stops at the same position as the

extended paper output tray, which then covers the cassette.
• When paper larger then A4 or Letter size is loaded, the extended cassette protrudes beyond the

paper output tray. Do not force the cassette into the printer any further. This can damage the
printer or cassette.
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8. Press the OK button.

9. Use the  or  button to select the size of the loaded paper in the cassette, then press the
OK button.

Note
• The asterisk " " will appear with the current page size and media type settings.

Paper setting for Printing

10. Use the  or  button to select the type of the loaded paper in the cassette, then press the
OK button.

11. Extend the output tray extension (J), then open the paper output support (K).

Note
• When printing, select the size and type of the loaded paper on the print settings screen of the printer

driver.
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Loading Envelopes

You can load envelopes in the cassette 1.

The address is automatically rotated and printed according to the envelope's direction by specifying with the
printer driver properly.

Important
• Do not use the following envelopes. They could jam in the printer or cause the printer to malfunction.

• Envelopes with an embossed or treated surface
• Envelopes with a double flap
• Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

• Press down on all four corners and edges of the envelopes to flatten them.

• If the envelopes are curled, hold the opposite corners and gently twist them in the opposite
direction.

• If the corner of the envelope flap is folded, flatten it.
• Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

The figures above show a side view of the leading edge of the envelope.

Important
• The envelopes may jam in the printer if they are not flat or the edges are not aligned. Make sure

that no curl or puff exceeds 0.1 inch (3 mm).

2. Pull out the cassette 1 from the printer.
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3. Slide the paper guide (A) in front and (B) on the right to open the guides.

4. Load the envelopes WITH THE PRINT SIDE FACING DOWN, and place them in the center
of the cassette 1.

The folded flap of the envelope will be faced up as shown in the figure below (C).

C: Rear side

D: Address side

Up to 10 envelopes can be loaded at once.

Note
• Align the envelope stack with the edge of the cassette 1 as shown in the figure below.

If the envelopes are in contact with the protrusion (E), the envelopes may not be fed properly.
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5. Align the paper guide (A) in front with the envelopes.

6. Slide the paper guide (B) on the right to align the right and left guides with both sides of the
envelopes.

Do not slide the paper guides too hard against the envelopes. The envelopes may not be fed properly.

Note
• Do not load envelopes higher than the load limit mark (F).
• Keep the envelope stack height below the tabs (G) of the paper guides.

7. Insert the cassette 1 into the printer.

Push the cassette 1 into the printer until it stops.

After inserting the cassette into the printer, the paper information registration screen for the cassette is
displayed on the LCD.
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8. Press the OK button.

9. Use the  or  button to select the size of the loaded envelopes in the cassette, then
press the OK button.

Note
• The asterisk " " will appear with the current page size and media type settings.

Paper setting for Printing

10. Use the  or  button to select the type of the loaded envelopes in the cassette, then
press the OK button.

11. Extend the output tray extension (H), then open the paper output support (I).
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Note
• When printing, select the size and type of the loaded envelopes on the print settings screen of the

printer driver.
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Media Types You Can Use

To get the best printing result, choose paper suitable for printing. Canon provides various types of paper
suitable for documents as well as paper suitable for photos or illustrations. We recommend the use of
Canon genuine paper for printing your important photos.

Media Types

Commercially available papers

• Plain Paper (including recycled paper)
• Envelopes

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction manual
supplied with the paper for detailed information on the printable side and notes on handling paper. For
information on the page sizes available for each Canon genuine paper, access our website.

Note
• You may not be able to purchase some Canon genuine papers depending on the country or region

of purchase. Paper is not sold in the US by Model Number. Purchase paper by name.

Paper for printing photos:

• Glossy Photo Paper "Everyday Use" <GP-501/GP-601>
• Photo Paper Glossy <GP-601>
• Photo Paper Plus Glossy II <PP-201>
• Photo Paper Pro Luster <LU-101>
• Photo Paper Plus Semi-gloss <SG-201>
• Matte Photo Paper <MP-101>

Paper for printing business documents:

• High Resolution Paper <HR-101N>

Paper Load Limit
Paper Settings on the Printer Driver and the Printer (Media Type)

Page Sizes

You can use the following page sizes.

Note
• You can load the page sizes as follows.

• cassette 1: A4, B5, A5, Letter, Legal, 4" x 6" (10 x 15 cm), 5" x 7" (13 x 18 cm), 8" x 10" (20 x 25
cm), Envelope DL, and Envelope Com 10

• cassette 2: A4, Letter, and Legal

Standard sizes:

• Letter
• Legal
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• A5
• A4
• B5
• 4" x 6" (10 x 15 cm)
• 5" x 7" (13 x 18 cm)
• 8" x 10" (20 x 25 cm)
• Envelope DL
• Envelope Com 10

Non-standard sizes:

You can print on non-standard size paper within the following ranges.

• cassette 1

- Minimum size: 3.50 x 5.00 inches (89.0 x 127.0 mm)

- Maximum size: 8.50 x 14.00 inches (215.9 x 355.6 mm)

• cassette 2

- Minimum size: 8.27 x 11.00 inches (210.0 x 279.4 mm)

- Maximum size: 8.50 x 14.00 inches (215.9 x 355.6 mm)

Paper Weight

You can use paper in the following weight range.

• 17 to 28 lb (64 to 105 g /m2) (plain paper except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the printer.

Notes on Storing Paper

• Take out only the necessary number of paper from the package, just before printing.
• To avoid curling, when you do not print, put unused paper back into the package and keep it on a

level surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Paper Load Limit

Commercially Available Papers

Media Name Cassette 1 Cassette 2 Paper Output Tray

Plain Paper (including recycled
paper)*1

Approx. 250 sheets Approx. 250 sheets Approx. 75 sheets

Envelopes 10 envelopes N/A*2 *3

Canon Genuine Papers

Note
• Feeding the following papers from the cassette 2 can damage the printer. Always load in the cassette

1.
• We recommend that you remove the previously printed sheet from the paper output tray before

continuously printing to avoid blurs and discoloration (except for High Resolution Paper <HR-101N>).

Paper for printing photos:

Media Name <Model No.> Cassette 1

Glossy Photo Paper "Everyday Use" <GP-501/GP-601>*4 10 sheets: A4 and Letter

20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Glossy <GP-601>*4 10 sheets: A4 and Letter

20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Plus Glossy II <PP-201>*4 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), and 8" x 10"
(20 x 25 cm)

20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Pro Luster <LU-101>*4 10 sheets: A4 and Letter

Photo Paper Plus Semi-gloss <SG-201>*4 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), and 8" x 10"
(20 x 25 cm)

20 sheets: 4" x 6" (10 x 15 cm)

Matte Photo Paper <MP-101> 10 sheets: A4 and Letter

20 sheets: 4" x 6" (10 x 15 cm)

Paper for printing business documents:

Media Name <Model No.> Cassette 1 Paper Output Tray

High Resolution Paper <HR-101N> 65 sheets 65 sheets

*1 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paper
or environmental conditions (either very high or low temperature or humidity). In such cases, reduce the
number of paper you load at a time to less than half.
*2 Feeding envelopes from the cassette 2 can damage the printer. Always load in the cassette 1.
*3 We recommend that you remove the previously printed envelope from the paper output tray before
continuously printing to avoid blurs and discoloration.
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*4 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed
properly. In this case, load one sheet at a time.
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Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but also
the printer to jam or malfunction.

• Folded, curled, or wrinkled paper
• Damp paper
• Paper that is too thin (weighing less than 17 lb (64 g /m2))
• Paper that is too thick (plain paper weighing more than 28 lb (105 g /m2), except for Canon genuine

paper)
• Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when printing

on paper smaller than A5)
• Picture postcards
• Postcards affixed with photos or stickers
• Envelopes with a double flap
• Envelopes with an embossed or treated surface
• Envelopes whose gummed flaps are already moistened and adhesive
• Any type of paper with holes
• Paper that is not rectangular
• Paper bound with staples or glue
• Paper with adhesives
• Paper decorated with glitter, etc.
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Printing Area

Printing Area

Other Sizes than Letter, Legal, Envelopes

Letter, Legal

Envelopes
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Printing Area

To ensure the best print quality, the printer allows a margin along each edge of media. The actual printable
area will be the area inside these margins.

Recommended printing area  : Canon recommends that you print within this area.

Printable area  : The area where it is possible to print. However, printing in this area can affect the print
quality or the paper feed precision.

Note
• With performing Automatic Duplex Printing, the printable area will be 0.08 inch (2 mm) smaller at the

top margin.
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Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)

A5 5.56 x 7.95 inches (141.2 x 202.0 mm)

A4 8.00 x 11.38 inches (203.2 x 289.0 mm)

B5 6.90 x 9.80 inches (175.2 x 249.0 mm)

4" x 6" (10 x 15 cm) 3.73 x 5.69 inches (94.8 x 144.4 mm)

5" x 7" (13 x 18 cm) 4.73 x 6.69 inches (120.2 x 169.8 mm)

8" x 10" (20 x 25 cm) 7.73 x 9.69 inches (196.4 x 246.0 mm)

 Recommended printing area

A: 1.80 inches (45.8 mm)

B: 1.45 inches (36.8 mm)

 Printable area

C: 0.12 inch (3.0 mm)

D: 0.20 inch (5.0 mm)

E: 0.13 inch (3.4 mm)

F: 0.13 inch (3.4 mm)
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Letter, Legal

Size Printable Area (width x height)

Letter 8.00 x 10.69 inches (203.2 x 271.4 mm)

Legal 8.00 x 13.69 inches (203.2 x 347.6 mm)

 Recommended printing area

A: 1.80 inches (45.8 mm)

B: 1.45 inches (36.8 mm)

 Printable area

C: 0.12 inch (3.0 mm)

D: 0.20 inch (5.0 mm)

E: 0.25 inch (6.4 mm)

F: 0.25 inch (6.3 mm)
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Envelopes

Size Recommended Printing Area (width x height)

Envelope DL 3.88 x 6.69 inches (98.8 x 170.0 mm)

Envelope Com 10 3.68 x 8.24 inches (93.5 x 209.3 mm)

 Recommended printing area

Envelope DL

A: 0.83 inch (21.0 mm)

B: 1.14 inches (29.0 mm)

C: 0.22 inch (5.6 mm)

D: 0.22 inch (5.6 mm)

Envelope Com 10

A: 0.12 inch (3.0 mm)

B: 1.14 inches (29.0 mm)

C: 0.22 inch (5.6 mm)

D: 0.22 inch (5.6 mm)
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Replacing an Ink Tank

Replacing an Ink Tank

Checking the Ink Status
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Replacing an Ink Tank

When remaining ink cautions or errors occur, the message will appear on the LCD to inform you of the error.
Take appropriate action according to the message.

A Message Is Displayed

Note
• If print results become faint or white streaks appear despite sufficient ink levels, see Maintenance

Procedure.

Replacing Procedure

When you need to replace an ink tank, follow the procedure below.

Important
• If you remove an ink tank, replace it immediately. Do not leave the printer with the ink tank removed.
• Use a new ink tank for replacement. Installing a used ink tank may cause the nozzles to clog.

Furthermore, with such an ink tank, the printer will not be able to inform you when to replace the ink
tank properly.

• Once an ink tank has been installed, do not remove it from the printer and leave it out in the open.
This will cause the ink tank to dry out, and the printer may not operate properly when it is reinstalled.
To maintain optimal printing quality, use an ink tank within six months of first use.

Note
• Color ink may be consumed even when printing a black-and-white document or when black-and-

white printing is specified.

Every ink is also consumed in the standard cleaning and deep cleaning of the print head, which may
be necessary to maintain the performance of the printer. When an ink tank is out of ink, replace it
immediately with a new one.

Useful Information about Ink

1. Make sure that the power is turned on, then open the front cover.

The replaceable ink tank is displayed on the LCD and the print head holder (A) moves to the
replacement position of that ink tank.
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Caution
• Do not hold the print head holder to stop or move it forcibly. Do not touch the print head holder

until it stops completely.

Important
• Do not remove an ink tank until a new one is prepared to be installed.

• Once you remove an ink tank, the machine will not operate until a new one is installed.
• Once you remove an ink tank, the machine will not operate even if the removed ink tank is

just reinstalled.

• You cannot remove the ink tank which is not placed at the replacement position. Removing it
forcibly may cause the printer to malfunction or damage the printer.

• Do not touch the metallic parts or other parts inside the printer.
• If the front cover is left open for more than 60 minutes, the print head holder moves to the right.

In this case, close and reopen the front cover.

Note
• If the message for the ink tank replacement is displayed on the LCD, check it and then press

the OK button.

2. When an ink tank for replacement is displayed on the LCD, push up the ink tank eject
lever (B).

The ink tank will be ejected.

When you want to replace another ink tank, press the OK button to select [OK]Next and display the
screen for the ink tank to replace.

Important
• Place the removed ink tank into a plastic bag immediately after removing from the printer.

Otherwise, ink residue may stain your clothes or the surrounding area.
• Do not touch other parts besides the ink tanks.
• Discard the empty ink tank according to the local laws and regulations regarding disposal of

consumables.
• Handle the ink tanks carefully. Do not drop or apply excessive pressure to them.
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3. Remove the ink tank from the package.

Important
• Do not touch the contact (C) and joint (D) of the ink tank.

4. Insert a new ink tank aligning it with the installation guide (E) of the printer.
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Important
• You cannot insert the ink tank in the wrong position. Check the label under the installation

position, then install the ink tank in the correct position.

5. Push the ink tank until it snaps firmly into place.

6. Press the OK button to select [OK]Exit.

If [OK]Next is displayed on the screen, it means there is another ink tank that can be replaced.

If you want to replace this ink tank, press the OK button and then repeat procedures from step 2.

To exit the ink tank replacement, press the OK button until [OK]Exit is displayed on the screen.

The print head holder moves to the standby position. You cannot remove the ink tank while at this
position.

Important
• You cannot print unless all the ink tanks are installed. Be sure to install all the ink tanks.
• An installed ink tank cannot be removed until the message to replace it is displayed.

7. Close the front cover.
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After replacing the ink tanks, the printer starts mixing the ink automatically. Wait until the printer has
stopped making operating noise. (This takes about 1 to 2 minutes.)

Note
• If the error message appears on the LCD, take appropriate action.

A Message Is Displayed

• If the print head is out of alignment, as indicated by misaligned printed ruled lines or similar
symptoms, align the print head.

• The printer may make noise during operation.
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Checking the Ink Status

Checking the Ink Status with the LCD on the Printer

You can also check the ink status on the computer screen.

Checking the Ink Status from Your Computer
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Checking the Ink Status with the LCD on the Printer

You can check the ink status on the LCD.

A symbol appears in the area (A) if there is any information about the remaining ink level.

Example: 

Ink tank is running low. Prepare a new ink tank.

Note
• The above screen shows estimated ink levels.
• Select Print ink number in Ink information on the Setup menu screen to print the model number of

the ink tank.
• You can also check the ink status on the computer screen.

Checking the Ink Status from Your Computer
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Maintenance

When Printing Becomes Faint or Colors Are Incorrect

Performing Maintenance from a Computer

Cleaning the Printer
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When Printing Becomes Faint or Colors Are Incorrect

Maintenance Procedure

Printing the Nozzle Check Pattern

Examining the Nozzle Check Pattern

Cleaning the Print Head

Cleaning the Print Head Deeply

Aligning the Print Head
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Maintenance Procedure

If print results are blurred, colors are not printed correctly, or print results are unsatisfactory (e.g. misaligned
printed ruled lines), perform the maintenance procedure below.

Note
• Increasing the print quality in the printer driver settings may improve the print result.

Changing the Print Quality and Correcting Image Data

When the Print Results Are Blurred or Uneven:

Step1  Print the nozzle check pattern.

From the printer

Printing the Nozzle Check Pattern

From the computer

Use Your Computer to Print a Nozzle Check Pattern

Step2  Examine the nozzle check pattern.

If there are missing lines or horizontal white streaks in the pattern:

Step3  Clean the print head.

From the printer

Cleaning the Print Head

From the computer

Cleaning the Print Heads from Your Computer

After cleaning the print head, print and examine the nozzle check pattern:  Step1

If the problem is not resolved after performing from step 1 to step 3 twice:

Step4  Clean the print head deeply.

From the printer

Cleaning the Print Head Deeply

From the computer

Cleaning the Print Heads from Your Computer

Note
• When you have performed the procedure until step 4 and the problem has not been resolved, turn off

the power and clean the print head deeply again after 24 hours.

If the problem is still not resolved, the print head may be damaged. Contact the service center.
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When the Print Results Are Not Even such as the Ruled Lines Are
Misaligned:

Step  Align the print head.

From the printer

Aligning the Print Head

From the computer

Aligning the Print Head Position from Your Computer
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzle.

Note
• When the ink has run out during printing the nozzle check pattern, the error message will appear on the

LCD.

A Message Is Displayed

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the cassette 1.

After inserting the cassette into the printer, the paper information registration screen is displayed on the
LCD. Select A4 or Letter for Size: and Plain paper for Type:, then press the OK button.

Important
• The cassette 2 is not available for the nozzle check pattern print procedure. Be sure to load paper

in the cassette 1.

3. Extend the output tray extension, then open the paper output support.

4. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

5. Use the  or  button to select Nozzle check, then press the OK button.

The nozzle check pattern will be printed.

6. Examine the nozzle check pattern.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in the pattern A or horizontal white streaks in the pattern B.

C: Number of sheets printed so far

If there are missing lines in the pattern A:

Cleaning the print head is required.

D: Good

E: Bad (lines are missing)

If there are horizontal white streaks in the pattern B:

Cleaning the print head is required.

F: Good

G: Bad (horizontal white streaks are present)

Note
• The total number of sheets printed so far is shown in increments of 50 sheets on the printout of the

nozzle check pattern.
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

Note
• You can also clean the print head using the computer. When using the computer, select the ink group

to clean, then start cleaning.

Cleaning the Print Heads from Your Computer

• When cleaning the print head using the operation panel, the print head of all ink colors are cleaned.

1. Make sure that the power is turned on.

2. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

3. Use the  or  button to select Cleaning, then press the OK button.

The printer starts cleaning the print head.

Do not perform any other operations until the printer completes the cleaning of the print head. This takes
about 2 minutes.

4. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

Note
• If the problem is not resolved after cleaning the print head twice, clean the print head deeply.
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Cleaning the Print Head Deeply

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply.
Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean
the print head deeply only when necessary.

Note
• You can also clean the print head deeply using the computer. When using the computer, select the ink

group to clean, then start the deep cleaning.

Cleaning the Print Heads from Your Computer

• When cleaning the print head deeply using the operation panel, the print head of all ink colors are
cleaned.

1. Make sure that the power is turned on.

2. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

3. Use the  or  button to select Deep cleaning, then press the OK button.

The printer starts cleaning the print head deeply.

Do not perform any other operations until the printer completes the deep cleaning of the print head. This
takes about 2 to 3 minutes.

4. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.

If the problem is still not resolved, the print head may be damaged. Contact the service center.
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Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head
position.

Note
• When the ink has run out during printing the nozzle check pattern, the error message will appear on the

LCD.

A Message Is Displayed

You need to prepare: a sheet of A4 or Letter-sized plain paper (including recycled paper)*

* Be sure to use paper that is white and clean on both sides.

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the cassette 1.

After inserting the cassette into the printer, the paper information registration screen is displayed on the
LCD. Select A4 or Letter for Size: and Plain paper for Type:, then press the OK button.

Important
• The cassette 2 is not available for the print head alignment procedure. Be sure to load paper in

the cassette 1.

3. Extend the output tray extension, then open the paper output support.

4. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

5. Use the  or  button to select Head alignment, then press the OK button.

The print head alignment sheet will be printed and the print head position will be adjusted automatically.

This takes about 3 to 4 minutes.

Note
• If the automatic adjustment of the print head position has failed, the error message appears on the

LCD.

A Message Is Displayed

• If the print results are still not satisfactory after adjusting the print head position as described above,
adjust the print head position manually from the computer.

166



Aligning the Print Head Position Manually from Your Computer
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Performing Maintenance from a Computer

Cleaning the Print Heads from Your Computer

Aligning the Print Head

Aligning the Print Head Position from Your Computer

Use Your Computer to Print a Nozzle Check Pattern
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Cleaning the Print Heads from Your Computer

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print head is as follows:

 Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the ink group for which cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing cleaning.

3. Execute cleaning

Make sure that the printer is on and then click Execute.

Print head cleaning starts.

4. Complete cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

Important
• Cleaning consumes a small amount of ink.

Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

 Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem.

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab
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When the Deep Cleaning dialog box opens, select the ink group for which deep cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

Print head deep cleaning starts.

4. Complete deep cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

Important
• Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

Note
• If there is no sign of improvement after Deep Cleaning, turn off the printer, wait 24 hours, and then

perform Deep Cleaning again. If there is still no sign of improvement, the ink may have run out or the
print head may be worn. For details on the remedial action to be taken, see "Ink Is Not Ejected."

Related Topic

Use Your Computer to Print a Nozzle Check Pattern
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Aligning the Print Head

When you perform head position adjustment, errors in the print head adjustment position are corrected and
conditions such as color and line streaking are improved.
If the print results appear uneven because of line shifts or other conditions, adjust the position of the print
head.

On this printer, you can adjust the print head either automatically or manually.
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Aligning the Print Head Position from Your Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head alignment.

The procedure for performing automatic print head alignment is as follows:

 Print Head Alignment

1. Open the printer driver setup window

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the cassette 1.

Important
• The cassette 2 is not available for the print head alignment procedure. Be sure to load paper in

the cassette 1.

Note
• The number of sheets to be used differs when you select the manual head alignment.
• If the cassette paper information registered on the printer is not set to A4 size and plain paper,

an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the
following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)

4. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

Important
• Do not open the front cover while printing is in progress.

Note
• Wait until printing ends before performing other operations. Printing takes about 3 to 4 minutes

to complete.
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Note
• To print and check the current setting, open the Start Print Head Alignment dialog box, and click Print

Alignment Value.
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Aligning the Print Head Position Manually from Your Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head alignment.

The procedure for performing manual print head alignment is as follows:

 Print Head Alignment

1. Open the printer driver setup window

2. Click Custom Settings on the Maintenance tab

The Custom Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. Switch head alignment to manual

Check the Align heads manually check box.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

5. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

6. Load paper in the printer

Load two sheets of A4 size or Letter size plain paper into the cassette 1.

Important
• The cassette 2 is not available for the print head alignment procedure. Be sure to load paper in

the cassette 1.

Note
• If the cassette paper information registered on the printer is not set to A4 size and plain paper,

an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the
following:
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• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)

7. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

Important
• Do not open the front cover while printing is in progress.

8. Check the printed pattern

Enter the numbers of the patterns with the least noticeable streaks in the associated boxes.
Even if the patterns with the least noticeable streaks are clicked in the preview window, their numbers
are automatically entered in the associated boxes.

When you have entered all the necessary values, click OK.

Note
• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical

streaks.

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

9. Confirm the displayed message and click OK

The second pattern is printed.

Important
• Do not open the front cover while printing is in progress.
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10. Check the printed pattern

Enter the numbers of the patterns with the least noticeable stripes or streaks in the associated boxes.
Even if the patterns with the least noticeable stripes or streaks are clicked in the preview window, their
numbers are automatically entered in the associated boxes.

When you have entered all the necessary values, click OK.

Note
• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable

horizontal stripes.

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

Note
• To print and check the current setting, open the Start Print Head Alignment dialog box, and click

Print Alignment Value.
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Use Your Computer to Print a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

 Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing the nozzle check
pattern.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the cassette 1.

Important
• The cassette 2 is not available for the nozzle check pattern printing. Be sure to load paper in the

cassette 1.

Note
• If the cassette paper information registered on the printer is not set to A4 size and plain paper,

an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the
following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. When the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.
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Related Topic

Cleaning the Print Heads from Your Computer
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Cleaning the Printer

Cleaning the Exterior of the Printer

Cleaning the Paper Feed Roller

Cleaning the Inside of the Printer (Bottom Plate Cleaning)

Cleaning the Pad in the Cassette
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Cleaning the Exterior of the Printer

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.
Smooth out wrinkles on the cloth if necessary before cleaning.

Important
• Be sure to turn off the power and unplug the power cord before cleaning the printer.
• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not

to scratch the surface. Paper tissue powder or fine threads may remain inside the printer and cause
problems such as print head blockage and poor printing results.

• Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean
the printer, as this may cause a malfunction or damage the surface of the printer.
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Cleaning the Paper Feed Roller

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed properly.

In this case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so perform this only
when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

3. Use the  or  button to select Roller cleaning, then press the OK button.

4. Remove any paper from the cassette.

Note
• If a message is displayed on the screen after inserting the cassette into the printer, press the OK

button.

5. Use the  or  button to select the paper source to clean (Cassette 1 or Cassette 2),
then press the OK button.

The paper feed roller will rotate as it is cleaned.

6. Make sure that the paper feed roller has stopped rotating, then load three sheets of A4 or
Letter-sized plain paper in the paper source you selected in step 5.

After inserting the cassette into the printer, the paper information registration screen is displayed on the
LCD. Select A4 or Letter for Size: and Plain paper for Type:, then press the OK button.

7. Extend the output tray extension, then open the paper output support.

8. Press the OK button again.

The printer starts cleaning. The cleaning will be complete when the paper is ejected.

9. Press the Back button to exit.
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If the problem is not resolved after cleaning the paper feed roller, contact the service center.
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Cleaning the Inside of the Printer (Bottom Plate Cleaning)

Remove stains from the inside of the printer. If the inside of the printer becomes dirty, printed paper may get
dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on, then remove any paper from the cassette 1.

2. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the
paper.

3. Fold one side of the opened paper in another half, aligning the edge with the center crease,
then unfold the paper.

4. Load only this sheet of paper in the cassette 1 with the ridges of the creases facing up and
the edge of the half with no crease facing to the far side.

After inserting the cassette into the printer, the paper information registration screen is displayed on the
LCD. Select A4 or Letter for Size: and Plain paper for Type:, then press the OK button.

Important
• The cassette 2 is not available for the Bottom Plate Cleaning procedure. Be sure to load paper in

the cassette 1.
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5. Extend the output tray extension, then open the paper output support.

6. Press the Setup button, use the  or  button to select Maintenance, then press the OK
button.

LCD and Operation Panel

7. Use the  or  button to select Bottom cleaning, then press the OK button.

The paper cleans the inside of the printer as it feeds through the printer.

Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning
again.

Note
• When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.

If the problem is not resolved after performing cleaning again, the protrusions inside the printer may be
stained. Wipe off any ink from the protrusions using a cotton swab or the like.

Important
• Be sure to turn off the power and unplug the power cord before cleaning the printer.
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Cleaning the Pad in the Cassette

If the pad in a cassette is smeared with paper powder or dirt, two or more sheets of paper may be ejected.
Follow the procedure below to clean the pad in a cassette.

You need to prepare: cotton swab

1. Pull out the cassette 1 or cassette 2 from the printer, then remove all the paper.

2. Clean the pad (A) sideways with a moistened cotton swab.

Important
• After cleaning the smeared pad, dry it completely.

For an example of the cassette 1:

3. Reload the paper, then insert the cassette into the printer.

Note
• If a message is displayed on the screen after inserting the cassette into the printer, press the OK

button.

If the problem is not resolved, contact the service center.

185



Changing the Printer Settings

Changing Printer Settings from Your Computer

Changing the Machine Settings on the LCD
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Changing Printer Settings from Your Computer

Changing the Print Options

Registering a Frequently Used Printing Profile

Managing the Printer Power

Reducing the Printer Noise

Changing the Printer Operation Mode
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab

The Print Options dialog box opens.

Note
• When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.
Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:

Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if
necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...

The Save Commonly Used Settings dialog box opens.

4. Save the settings

Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.
In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the
Quick Setup tab.
The name and icon are displayed in Commonly Used Settings.
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Important
• To save the page size, orientation, and number of copies that was set in each sheet, click Options...,

and check each item.

Note
• When you re-install the printer driver or upgrade the printer driver version, the print settings that are

already registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register the print
settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.
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Managing the Printer Power

This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

 Power Off

The Power Off function turns off the printer. When you use this function, you will not be able to turn the
printer on from the printer driver.

1. Open the printer driver setup window

2. Execute power off

Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.

 Auto Power

Auto Power allows you to set Auto Power On and Auto Power Off.

The Auto Power On function automatically turns on the printer when data is received.
The Auto Power Off function automatically turns off the printer when there are no operations from the
printer driver or the printer for a specified period of time.

1. Open the printer driver setup window

2. Make sure that the printer is on and then click Auto Power on the Maintenance tab

The Auto Power Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Auto Power On
Specifying Enable from the list will turn the printer on upon receipt of print data.

Auto Power Off
Specify the time from the list. When this time lapses without any operations from the printer driver
or the printer, the printer is turned off automatically.

4. Apply the settings
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Click OK. When the confirmation message appears, click OK.
The Maintenance tab is displayed again.

The setting is enabled after this. When you want to disable this function, select Disable from the list
according to the same procedure.

Note
• When the printer is turned off, the Canon IJ Status Monitor message varies depending on the Auto

Power On setting.
When the setting is Enable, "Printer is standing by" is displayed. When the setting is Disable,
"Printer is offline" is displayed.

Important
• If you connect this printer to a network and use it, you can set Auto Power Off but the power will not be

turned off automatically.
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Reducing the Printer Noise

The silent function allows you to reduce the operating noise of this printer. Select when you wish to reduce
the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

 Quiet Settings

1. Open the printer driver setup window

2. Click Quiet Settings on the Maintenance tab

The Quiet Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified
period of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to
the same time, the quiet mode will not function.

Important
• You can set the quiet mode from the printer or the printer driver.

No matter how you use to set the quiet mode, the mode is applied when you perform
operations from the printer or printing from the computer.

4. Apply the settings

Make sure that the printer is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.

Note
• The effects of the quiet mode may be less depending on the paper source and the print quality settings.
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Changing the Printer Operation Mode

If necessary, switch between various modes of printer operation.

The procedure for configuring Custom Settings is as follows:

 Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density
printing to prevent paper abrasion.
Check this check box to prevent paper abrasion.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head
alignment.
Check this check box to perform the manual head alignment. Uncheck this check box to perform
the automatic head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the
Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print
data 90 degrees to the right during printing, clear this item.

Important
• Do not change this setting while the print job is displayed in the print wait list. Otherwise,

characters may be omitted or the layout may become corrupt.

Don't detect mismatch of paper settings when printing from computer
When you print documents from your computer and the paper settings on the printer driver and
the cassette paper information registered on the printer do not match, this setting disables the
message display and allows you to continue printing.
To disable detection of paper setting mismatches, select this check box.
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Ink Drying Wait Time
You can set the length of the printer rest time until printing of the next page begins. Moving the
slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page
dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

The printer operates with the modified settings hereafter.
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Changing the Machine Settings on the LCD

Changing the Printer Settings on the LCD

Output settings

LAN settings

Dev. user settings

Firmware update

Cassette settings

Reset setting

About Quiet setting

Turning on/off the Printer Automatically

Using the Printer with the Access Point Mode
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Changing the Printer Settings on the LCD

This section describes the procedure to change the settings in the Device settings screen, taking the steps
to specify Prevent abrasion as an example.

Note
• The * (asterisk) on the LCD indicates the current setting.

1. Make sure that the printer is turned on.

2. Press the Setup button.

The Setup menu screen is displayed.

3. Use the  button to select Device settings, then press the OK button.

The Device settings screen is displayed.

4. Use the  button to select the setting item, then press the OK button.

The setting screen for the selected item is displayed.

5. Use the  button to select the menu, then press the OK button.

6. Use the  button to select a setting item, then press the OK button.

You can select the setting menus below.

Output settings

LAN settings

Dev. user settings

Firmware update

Cassette settings

Reset setting

Note
• You can use the printer considering the environment, such as enabling the printer to turn on/off

automatically.

Turning on/off the Printer Automatically

• You can reduce the operating noise when printing at night.
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About Quiet setting
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Output settings

• Prevent abrasion

Use this setting only if the print surface becomes smudged.

Important
• Be sure to set this back to OFF after printing since it may result in lower printing speed or lower

print quality.
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LAN settings

• Change LAN

Enables either wireless LAN, wired LAN, or access point mode. You can also disable all.

• Wireless LAN setup

Selects the setup method for wireless LAN connection.

Note
• You can also enter this setting menu by selecting Wireless LAN setup from the Setup menu

screen.

When this menu is selected, the printer starts searching for a WPS-compatible access point. If the
printer detects the access point, follow the on-screen instructions to set up wireless LAN. If an access
point is not detected or if you select another setup method, select one of the setup methods below.

◦ WPS (Push button)

Select when you perform settings for wireless LAN using an access point supporting a Wi-Fi
Protected Setup (WPS) push button method. Follow the on-screen instructions during setup.

◦ Other setup

WPS (PIN code)
Select when you perform settings for wireless LAN using an access point supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

Cableless setup
Select if you specify the settings of the access point information to the printer directly from a
device (such as a smartphone) without operating the access point. Follow the on-screen
instructions of the connecting device for the setup procedure.

• Print LAN details

You can print out the network settings of the printer such as its IP address and SSID.

For more information on the printer's network setting is printed out, refer to Printing Out Network Setting
Information.

• Other settings

Important
• You cannot select the items below when LAN inactive is selected for Change LAN.

◦ TCP/IP settings

Performs IPv4 or IPv6 setting.

◦ WSD setting

Setting items when you use WSD (one of the network protocols supported in Windows 8.1,
Windows 8, Windows 7, and Windows Vista).

Enable/disable WSD
Selects whether WSD is enabled or disabled.
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Note
• When this setting is enabled, the printer icon is displayed on the Network Explorer in Windows

8.1, Windows 8, Windows 7, and Windows Vista.

Timeout setting
Specifies the timeout length.

◦ Bonjour settings

Setting items for LAN using Bonjour for Mac OS.

Enab./disab. Bonjour
Selecting Active allows you to use Bonjour to perform the network settings.

◦ LPR setting

Activates/deactivates the LPR setting.

◦ DRX setting

Enables discontinuous reception when using wireless or wired LAN. It allows you to save electricity.

Wireless LAN
Selecting Active allows you to enable discontinuous reception when using wireless LAN.

Wired LAN
Selecting Active allows you to enable discontinuous reception when using wired LAN.

Note
• Depending on the access point you are using, discontinuous reception of the wireless LAN may

not be activated even though Active is selected.

• Discontinuous reception is activated only while the printer is on standby. (The LCD is in the
screen saver mode.)
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Dev. user settings

• Language selection

Changes the language for LCD messages and menus.

Japanese / English / German / French / Italian / Spanish / Dutch / Portuguese / Norwegian / Swedish /
Danish / Finnish / Russian / Ukrainian / Polish / Czech / Slovak / Hungarian / Slovene / Croatian /
Romanian / Bulgarian / Turkish / Greek / Estonian / Latvian / Lithuanian / Simplified Chinese / Traditional
Chinese / Korean / Indonesian

• Key repeat

Enables/Disables continuous input by pressing and holding down the  button when selecting a
setting menu or setting item.

• Device info sending

Selects whether you will send the printer usage information to Canon server. The information sent to
Canon will be utilized to develop better products. Select ON to send the printer usage information to
Canon server.
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Firmware update

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen.

Note
• Only Current version is available when LAN inactive is selected for Change LAN in LAN settings.

• Install update

Performs the firmware update of the printer.

Important
• When you use this function, make sure that the printer is connected to the Internet.

Note
• If the firmware update is not complete, check the following and take an appropriate action.

• When using wired LAN, make sure that the printer is connected to the computer with a LAN
cable properly.

• Check the network settings such as an access point or a router.

• If Cannot connect to the server; try again is displayed on the LCD, press the OK button, then
try again after a while.

• Current version

You can check the current firmware version.

• Update notification

When ON is selected and the firmware update is available, the screen to inform you of the firmware
update is displayed on the LCD.
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Cassette settings

By registering the paper size and the media type loaded in the cassette, you can prevent the printer from
misprinting by displaying the message before printing starts when the paper size or the media type of the
loaded paper differs from the print settings. In addition, you can allow the printer to switch the paper source
automatically when a cassette runs out of paper.

• Register paper info

Registers the paper size and the media type you load in the cassette.

Note
• For details on the proper combination of paper settings you can specify by the printer driver or on

the LCD:

Setting the Media Type with the Printer Driver and on the Printer

Setting the Paper Size with the Printer Driver and on the Printer

• Det. paper mismatch

If you select ON, the printer detects whether the paper size and the media type are the same as those
registered in Register paper info. If printing starts with the settings that do not match, an error message
is displayed on the LCD.

Note
• When OFF is selected, Detect reinsertion is disabled.

• Detect reinsertion

If you select ON, the printer detects the cassette is reinserted. When the Register paper info screen is
displayed, register the paper size and the media type.

• Auto feed switch

If you select ON, the printer switches the paper source automatically when a cassette runs out of paper.
Load A4, Letter, or Legal sized plain paper in both of the cassettes to activate this function.
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Reset setting

Reverts all settings you made to the printer back to the default. However, some data may not be changed,
depending on the current usage state of your printer.

• Web service setup

Reverts the Web service settings back to the default.

• LAN settings

Reverts the LAN settings other than the administrator password specified by IJ Network Tool back to the
default.

• Setting data

Reverts the settings such as the paper size or media type back to the default.

• Device info sending

Reverts only the device information sending settings.

• All data

Reverts all settings you made to the printer back to the default. The administrator password specified by
IJ Network Tool reverts to the default setting.

Note
• You cannot change the following setting items back to the default:

• The language displayed on the LCD

• The current position of the print head
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About Quiet setting

Enables this function on the printer if you want to reduce the operating noise, such as when printing at night.

Follow the procedure below to perform setting.

1. Make sure that the printer is turned on.

2. Press the Setup button.

The Setup menu screen is displayed.

3. Use the  button to select Quiet setting, then press the OK button.

4. Use the  button to select ON, then press the OK button.

The LCD returns to the Setup menu screen.

You can reduce the operating noise while printing is in progress.

Important
• Operating speed may be reduced compared to when OFF is selected.

• This function may not be so effective depending on the printer's setting. Furthermore, certain
noise, such as when the printer is preparing for printing, is not reduced.

Note
• You can set the quiet mode from the operation panel of the printer or the printer driver. No matter

how you set the quiet mode, the mode is applied when you perform operations from the operation
panel of the printer or printing from the computer.
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Turning on/off the Printer Automatically

You can enable the printer to turn on/off automatically considering the environment

Turning on the Printer Automatically

Turning off the Printer Automatically

Turning on the Printer Automatically

You can enable the printer to turn on automatically when printing data is sent to the printer.

1. Make sure that the printer is turned on.

2. Press the Setup button.

The Setup menu screen is displayed.

3. Use the  button to select ECO (power on/off), then press the OK button.

4. Use the  button to select Auto power on, then press the OK button.

5. Use the  button to select ON, then press the OK button.

Note
• You can select whether you turn the printer on automatically from the operation panel of the

printer or the printer driver. No matter how you set the mode, the mode is applied when printing
data is sent to the printer.

Turning off the Printer Automatically

You can enable the printer to turn off automatically when no operation is made or no printing data is sent
to the printer for a specified period of time.

1. Make sure that the printer is turned on.

2. Press the Setup button.

The Setup menu screen is displayed.

3. Use the  button to select ECO (power on/off), then press the OK button.

4. Use the  button to select Auto power off, then press the OK button.

5. Use the  button to select the time, then press the OK button.

Note
• You can select whether you turn off the printer automatically from the operation panel of the

printer or the printer driver.
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Using the Printer with the Access Point Mode

By using the printer as an access point in an environment that does not have wireless LAN router or access
point, or by using the printer as an access point temporarily in an environment that has wireless LAN router
or access point, you can connect the printer to an external device such as a computer or a smartphone and
print from them.

This section describes how to enable the access point mode, the access point name of the printer, and the
security setting.

How to enable the Access Point Mode

Printing with the Access Point Mode

How to terminate the Access Point Mode

Setting of the Access Point Mode

Important
• Before using the printer with the access point mode, confirm the usage restrictions then switch the

printer to the access point mode.

Restrictions

• If you use the printer with the access point mode for the long time, it is recommended that you change
the default access point name and the default password to the combination of numbers and letters with
the point of view of security.

How to enable the Access Point Mode

Enable the access point mode following the procedure below.

1. Make sure that the printer is turned on.

2. Press the Setup button.

The Setup menu screen is displayed.

3. Use the  button to select Device settings, then press the OK button.

The Device settings screen is displayed.

4. Use the  button to select LAN settings, then press the OK button.

5. Use the  button to select Change LAN, then press the OK button.

6. Use the  button to select AP mode active, then press the OK button.

7. Use the  button to select Start setup, then press the OK button.

The access point mode is enabled and the printer can be used as an access point.
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Note
• If you select SSID or Security protocol using the  button and press the OK button, you

can confirm the current access point name (SSID) and the current security setting.

Printing with the Access Point Mode

Print with the access point mode following the procedure below.

1. Connect an external device such as a computer or a smartphone to the printer via
wireless LAN.

Perform wireless LAN settings with your external device, then assign the access point name specified
for the printer as a destination.

Note
• For details on how to perform wireless LAN settings with an external device, refer to the

device's instruction manual.

• When a WPA2-PSK (AES) password is valid on the printer, entering the password is required to
connect an external device to the printer via wireless LAN. Enter the password specified for the
printer.

2. Start printing from an external device such as a computer or a smartphone.

Note
• For details on how to print from an external device such as a computer or a smartphone via

wireless LAN, refer to the device's or application's instruction manual.

How to terminate the Access Point Mode

In environments that the printer is connected with the computer over the wireless LAN usually, set the
printer to the wireless LAN connection following the procedure below when you finish using the printer
with the access point mode temporarily.

1. Press the Setup button.

The Setup menu screen is displayed.

2. Use the  button to select Device settings, then press the OK button.

The Device settings screen is displayed.

3. Use the  button to select LAN settings, then press the OK button.

4. Use the  button to select Change LAN, then press the OK button.

5. Use the  button to select Wireless LAN active, then press the OK button.

If you do not use the printer over wireless LAN, select Wired LAN active or LAN inactive.
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Setting of the Access Point Mode

The initial value of the access point mode is set as follows.

SSID (access point name) XXXXXX-iB4000series

* "XXXXXX" is the last six digits of MAC address of the printer.

Security setting WPA2-PSK (AES)

Password Serial number of the printer

Note
• To confirm the MAC address of the printer, print out the network setting information.

Printing Out Network Setting Information

• You can change the security setting and the password using IJ Network Tool.

If you change the access point mode setting of the printer, also change the access point setting of the
external device such as a computer or a smartphone.

210



Information about Network Connection

Useful Information about Network Connection
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Useful Information about Network Connection

Default Values Set at Factory (Network)

Connecting the Printer to the Computer Using a USB Cable

When Detecting the Printers Have the Same Name during Setup

Connecting to Other Computer with LAN/Changing the Connection Method
from USB to LAN

Printing Out Network Setting Information
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Default Values Set at Factory (Network)

Default Values of the LAN Connection

Item The default

Change LAN LAN inactive

SSID BJNPSETUP

Communication mode Infrastructure

Wireless LAN security Disable

IP address (IPv4) Auto setup

IP address (IPv6) Auto setup

TCP/IP settings IPv4/IPv6

Enable/disable IPv6 Active

Enable/disable WSD Active

Timeout setting 1 minute

Enab./disab. Bonjour Active

Service name (Bonjour settings) Canon iB4000 series

LPR setting Active

DRX setting (Wireless LAN) Active

DRX setting (Wired LAN) Active

Default Values of the Access Point Mode

Item The default

SSID (access point name) XXXXXX-iB4000series

Security setting WPA2-PSK (AES)

Password Serial number of the printer

(XXXXXX is the last six digits of MAC address of the printer.)
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Connecting the Printer to the Computer Using a USB Cable

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located
on the rear of the printer.
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When Detecting the Printers Have the Same Name during Setup

When the printer is detected during setup, you may see multiple printers of the same name on the detection
result screen.

Select a printer with checking the MAC address or the serial number set to the printer against that on the
detection result screen.

Note
• A serial number may not be displayed on the detection result screen.

To check the MAC address of the printer, print out the network setting information.

Printing Out Network Setting Information
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Connecting to Other Computer with LAN/Changing the Connection
Method from USB to LAN

To add the computer connecting the printer with LAN or to change the connection method between the
printer and the computer from USB to LAN, perform setup with the Setup CD-ROM or perform it according
to the instructions on our website.

Connecting to Other Computer with LAN

To add the computer connecting the printer with LAN, perform setup with the Setup CD-ROM or perform it
according to the instructions on our website.

Changing the Connection Method from USB to LAN

To change the connection method to LAN while you are using the printer with USB connection, perform
setup again with the Setup CD-ROM or perform it again according to the instructions on our website and
select Change Connection Method.
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Printing Out Network Setting Information

You can print out the current network settings of the printer.

Important
• This print out contains valuable information about your computer. Handle it with care.

1. Make sure that the printer is turned on.

2. Load a sheet of A4 or Letter-sized plain paper.

3. Press the Setup button.

The Setup menu screen is displayed.

4. Use the  button to select Device settings, then press the OK button.

5. Use the  button to select LAN settings, then press the OK button.

6. Use the  button to select Print LAN details, then press the OK button.

The printer starts printing the network setting information.

The following information on the printer's network setting is printed out.

Item Explanations of the item Setting

Wireless LAN Wireless LAN Enable/Disable

Connection Connection status Active/Inactive

MAC Address MAC Address XX:XX:XX:XX:XX:XX

SSID SSID SSID of the wireless LAN/SSID of the access
point mode

Password Password Password of the access point mode (8 to 10
alphanumeric characters)

Communication Mode Communication Mode Infrastructure/Access Point Mode

Channel *1 Channel XX (1 to 13)

Encryption Method of the Encryption none/WEP/TKIP/AES

WEP Key Length WEP Key Length Inactive/128/64

Authentication Method of the Authentication none/auto/open/shared/WPA-PSK/WPA2-PSK

Signal Strength Signal Strength 0 to 100 [%]

TCP/IP Version TCP/IP Version IPv4 & IPv6/IPv4

IPv4 IP Address Selected IP Address (IPv4) XXX.XXX.XXX.XXX
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IPv4 Default Gateway Default Gateway (IPv4) XXX.XXX.XXX.XXX

Subnet Mask Subnet Mask XXX.XXX.XXX.XXX

IPv6 IP Address *2 Selected IP Address (IPv6) XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IPv6 Default Gateway *2 Default Gateway (IPv6) XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Subnet Prefix Length *2 Subnet Prefix Length XXX

IPsec *3 IPsec setting Active

Security Protocol *3 Method of the Security Protocol ESP/ESP & AH/AH

Wireless LAN DRX Discontinuous reception (wireless
LAN)

Enable/Disable

Wired LAN Wired LAN Enable/Disable

Connection Status of the Wired LAN Active/Inactive

MAC Address MAC Address XX:XX:XX:XX:XX:XX

TCP/IP Version TCP/IP Version IPv4 & IPv6/IPv4

IPv4 IP Address Selected IP Address (IPv4) XXX.XXX.XXX.XXX

IPv4 Default Gateway Default Gateway (IPv4) XXX.XXX.XXX.XXX

Subnet Mask Subnet Mask XXX.XXX.XXX.XXX

IPv6 IP Address *2 Selected IP Address (IPv6) XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IPv6 Default Gateway *2 Default Gateway (IPv6) XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Subnet Prefix Length *2 Subnet Prefix Length XXX

IPsec *3 IPsec setting Active

Security Protocol *3 Method of the Security Protocol ESP/ESP & AH/AH

Wired LAN DRX Discontinuous reception (wired
LAN)

Enable/Disable

Other Settings Other settings -

Printer Name Printer name Printer name (Up to 15 alphanumeric
characters)

WSD WSD setting Enable/Disable

WSD Timeout Timeout 1/5/10/15/20 [min]

LPR Protocol LPR protocol setting Enable/Disable

Bonjour Bonjour setting Enable/Disable
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Bonjour Service Name Bonjour service name Bonjour service name (Up to 52 alphanumeric
characters)

DNS Server Getting DNS Server automatically Auto/Manual

Primary Server Primary server address XXX.XXX.XXX.XXX

Secondary Server Secondary server address XXX.XXX.XXX.XXX

Proxy Server Proxy Server setting Enable/Disable

Proxy Port Specifying Proxy Port 1 to 65535

Proxy Address Proxy Address XXXXXXXXXXXXXXXXXXXX

("XX" represents alphanumeric characters.)

*1 Depending on the country or region of purchase, one of the channels from 1 to 11 is printed.

*2 Only when IPv6 is enabled, the status of the network is printed.

*3 Only IPv6 and the IPsec setting are enabled, the status of the network is printed.
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About Network Communication

Changing and Confirming Network Settings

Screens for Network Connection of IJ Network Tool

Other Screens of IJ Network Tool

Appendix for Network Communication
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Changing and Confirming Network Settings

IJ Network Tool

Changing the Settings in the Wireless LAN Sheet

Changing the WEP Detailed Settings

Changing the WPA/WPA2 Detailed Settings

Changing the Settings in the Wired LAN Sheet

Changing the Settings in the Admin Password Sheet

Monitoring Wireless Network Status

Initializing the Network Settings of the Machine

Viewing the Modified Settings
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IJ Network Tool

IJ Network Tool is a utility that enables you to display and modify the machine network settings. It is installed
when the machine is set up.

Important
• To use the machine over LAN, make sure you have the equipment necessary for the connection type,

such as an access point or a LAN cable.

• Do not start up IJ Network Tool while printing.

• Do not print when IJ Network Tool is running.

• If the firewall function of your security software is turned on, a message may appear warning that
Canon software is attempting to access the network. If the warning message appears, set the security
software to always allow access.

• IJ Network Tool has been verified to work on Windows XP, however, it does not support Fast User
Switching. It is recommended to exit IJ Network Tool when switching users.

Starting up IJ Network Tool

1. Start up IJ Network Tool as shown below.

• In Windows 8.1 or Windows 8, select IJ Network Tool on the Start screen to start IJ Network
Tool. If IJ Network Tool is not displayed on the Start screen, select the Search charm, then
search for "IJ Network Tool".

• In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, IJ Network Tool, and then IJ Network Tool.

Depending on the printer you are using, an administrator password is already specified for the printer at
the time of purchase. When you change the network settings, authentication by the administrator
password is required.

For details:

About the Administrator Password

For improving security, it is recommended to change the administrator password.

Changing the Settings in the Admin Password Sheet
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Changing the Settings in the Wireless LAN Sheet

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

Note
• This screen is not available depending on the printer you are using.

• Activate the wireless LAN setting of the printer to change the settings in the Wireless LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with
"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

The Wireless LAN sheet is displayed.

For details on the Wireless LAN sheet, see Wireless LAN Sheet.

5. Change the settings or confirm.

SSID:
Enter the same value that was set for the target access point.

When the printer is connected with USB, the Search screen appears by clicking Search.... Set the
SSID of the access point by selecting the one of the detected access points.

Search Screen
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Note
• Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

Encryption Method:
Select the encryption method used over the wireless LAN.

You can change WEP settings with selecting Use WEP and clicking Configuration....

Changing the WEP Detailed Settings

You can change WPA/WPA2 settings with selecting Use WPA/WPA2 and clicking Configuration....

Changing the WPA/WPA2 Detailed Settings

Important
• If all encryption types of the access point, printer, or computer do not match, the printer cannot

communicate with the computer. If the printer cannot communicate with the computer after the
encryption type of the printer was switched, make sure that encryption types for the computer and
the access point match that set to the printer.

• If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.

TCP/IP Setup:
Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your
network environment.

6. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings
screen is displayed.

Note
• Changing the network settings with the USB cable temporarily may switch the default printer. In

this case, reset Set as Default Printer.
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Changing the WEP Detailed Settings

Note
• This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with
"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WEP in Encryption Method: and click Configuration....

The WEP Details screen is displayed.

6. Change the settings or confirm.

When changing the password (WEP key), the same change must be made to the password (WEP key)
of the access point.

1. WEP Key:

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the
combination of the key length and key format.

 Key Length

64bit 128bit

Key Format ASCII 5 characters 13 characters

Hexadecimal (Hex) 10 digits 26 digits
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2. Key Length:

Select either 64bit or 128bit.

3. Key Format:

Select either ASCII or Hex.

4. Key ID:

Select the Key ID (index) set to the access point.

5. Authentication:

Select the authentication method to authenticate the printer's access to the access point.

Normally, select Auto. If you want to specify the method manually, select Open System or
Shared Key according to the setting of the access point.

7. Click OK.

Important
• If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure that encryption types for the computer and the access point match that set to
the printer.

Note
• Changing the network settings with the USB cable temporarily may switch the default printer. In

this case, reset Set as Default Printer.
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Changing the WPA/WPA2 Detailed Settings

Note
• This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

The example screenshots in this section refer to the WPA detailed settings.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with
"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WPA/WPA2 in Encryption Method: and click Configuration....

The WPA/WPA2 Details screen is displayed.

If encryption is not set to the printer, the Authentication Type Confirmation screen is displayed. Go to
step 7.

6. Click Change Settings....

7. Check the client authentication type and click Next>.
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8. Enter the passphrase, then click Next>.

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

The dynamic encryption method is selected from either TKIP (basic encryption) or AES (secure
encryption) automatically.

Important
• If Auto is not displayed on Dynamic Encryption Type:, select either TKIP(Basic Encryption) or

AES(Secure Encryption).

9. Click Finish.
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Important
• If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure that encryption types for the computer and the access point match that set to
the printer.

Note
• Changing the network settings with the USB cable temporarily may switch the default printer. In

this case, reset Set as Default Printer.
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Changing the Settings in the Wired LAN Sheet

Note
• This screen is not available depending on the printer you are using.

• Activate the wired LAN setting of the printer to change the settings in the Wired LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Configuration... from the Settings menu.

4. Click the Wired LAN tab.

The Wired LAN sheet is displayed.

For details on the Wired LAN sheet, see Wired LAN Sheet.

5. Change the settings or confirm.

Set the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

6. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings
screen is displayed.
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Changing the Settings in the Admin Password Sheet

Note
• You cannot change the settings when using the access point mode.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Configuration... from the Settings menu.

4. Click the Admin Password tab.

The Admin Password sheet is displayed.

For details on the Admin Password sheet, see Admin Password Sheet.

5. Change the settings or confirm.

To use an administrator password, select the Use admin password check box and enter a password.

Important
• The password should consist of alphanumeric characters and be no longer than 32 characters.

The password is case-sensitive. Do not forget the password you set.

If you forget the administrator password you specified, initialize the printer to revert the password
to the default setting.

6. Click OK.

A screen is displayed asking you for confirmation before the settings are sent to the printer. If you click
Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.
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Monitoring Wireless Network Status

Note
• This screen is not available depending on the printer you are using.

• When using the machine over the wired LAN, you cannot monitor network status.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Status from the View menu.

The Status screen is displayed and you can check the printer status and connection performance.

Important
• If the indicated value is low, move your printer closer to the wireless network device.

4. If you measure the connection performance in detail, click Advanced Measurement....

The Connection Performance Measurement screen is displayed.

5. Click Next>.

The measurement starts and the status displays. Measurement takes a few minutes.
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6. Check the status.

When the measurement is complete, the status is displayed.

When  is displayed in Connection Performance between the Printer and the Access Point:, the
printer can communicate with the access point. Otherwise, refer to displayed comments and the
following to improve the status of communication link, and click Remeasurement.

• Check that the printer and the access point are located within the wireless connectivity range with
no obstacles between them.

• Check if the distance between the printer and the access point is not too far.

If they are too far, move them closer together (within 164 ft./50 m).

• Check that there is no barrier or obstacle between the printer and the access point.

In general, connection performance decreases for communications through walls or between
different floors. Adjust the locations to avoid such situations.

• Check that there are no sources of radio interference near the printer and the access point.

The wireless connection may use the same frequency band as microwave ovens and other
sources of radio interference. Try to keep the printer and the access point away from such sources.

• Check if the radio channel of the access point is close to that of other access points nearby.

If the radio channel of the access point is close to that of other access points nearby, the
connection performance may become unstable. Be sure to use a radio channel that does not
interfere with other access points.

• Check that the printer and the access point face each other.

Connection performance may depend on the orientations of the wireless devices. Replace the
access point and the printer in another direction to achieve the best performance.

• Check whether other computers are not accessing the printer.

If  appears in the result of the measurement, check whether other computers are not accessing
the printer.
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If  still appears even if you have tried the above, finish the measurement, then restart the IJ Network
Tool to start over the measurement.

7. Click Finish.

Note
• If any messages appear on Overall Network Performance:, move the machine and access point

as instructed to improve the performance.
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Initializing the Network Settings of the Machine

Important
• Note that initialization erases all network settings on the machine, printing or scanning operation from a

computer over network may become impossible. To use the machine over network, perform setup with
the Setup CD-ROM or perform setup according to the instructions on our website.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Maintenance... from the Settings menu.

The Maintenance screen is displayed.

4. Click Initialize.

5. When the confirmation screen is displayed, click Yes.

The network settings of the printer is initialized.

Do not turn off the printer during initialization.

Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup
with the Setup CD-ROM or perform setup according to the instructions on our website.

Note
• You can change the network settings of the printer using IJ Network Tool with USB connection after

initializing the LAN settings. To change the network settings using Canon IJ Network Tool, activate
wireless LAN in advance.

235



Viewing the Modified Settings

The Confirmation screen is displayed when you modified the printer settings on the Configuration screen.
When you click Yes on the Confirmation screen, the following screen is displayed for confirming the
modified settings.
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Screens for Network Connection of IJ Network Tool

Canon IJ Network Tool Screen

Configuration Screen

Wireless LAN Sheet

Search Screen

WEP Details Screen

WPA/WPA2 Details Screen

Authentication Type Confirmation Screen

PSK:Passphrase and Dynamic Encryption Setup Screen

Setup Information Confirmation Screen

Wired LAN Sheet

Admin Password Sheet

Network Information Screen

Access Control Sheet

Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

Edit Accessible IP Address Screen/Add Accessible IP Address Screen
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

Items on the Canon IJ Network Tool Screen

Canon IJ Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

Important
• To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.

• If No Driver is displayed for the name, associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

• If Not Found is displayed for the status, check the followings:

• The access point is turned on.

• When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

• If the printer is being used from another computer, a screen is displayed informing you of this
condition.
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Note
• This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

Configuration Screen

Note
• You cannot configure a printer that has the status Not Found.

• This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication
status.

In the access point mode, this item is grayed out and you cannot confirm the printer connection
status.

Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the
latest information.

Important
• To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
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• If No Driver is displayed for the name, associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

• If Not Found is displayed for the status, check the followings:

• The access point is turned on.

• When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

• If the printer is being used from another computer, a screen is displayed informing you of this
condition.

Note
• This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are
unavailable for printing.

3. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

Configuration Screen

Note
• This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Enable switch printer function
When you cannot use your printer, you can use the same one on the network instead. When you
enable this function and you cannot use your printer, the screen to confirm if you start searching
the same printer as yours is displayed. Follow the message on the screen.

Note
• When this function is enabled, a check mark appears on the menu.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port
with the printer enables you to use it.

240



Maintenance...
Displays the Maintenance screen to revert the network settings of the printer to factory default
and to mount the card slot as the network drive.

Maintenance Screen

Set up printer's wireless LAN...
You can change the access point mode settings. Perform settings following the message on the
screen.

If you change the Encryption Method: setting and the Password: setting on the Set up printer's
wireless LAN screen, the changed settings are applied to the printer settings.

Note
• You can use this function only when you are using a computer compatible with the wireless LAN.

4. Help menu

Instructions
Displays this guide.

About
Displays the version of IJ Network Tool.
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Configuration Screen

You can change the configuration of the printer selected on the Canon IJ Network Tool screen.

Click the tab to select the sheet to change the settings.

The following screen is the example to change the setting on the Wireless LAN sheet.

Note
• This screen is not available depending on the printer you are using.

For details on each sheet, see the following.

Wireless LAN Sheet

Wired LAN Sheet

Admin Password Sheet
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Wireless LAN Sheet

Note
• This screen is not available depending on the printer you are using.

Allows you to set the printer with wireless LAN connection.

To display the Wireless LAN sheet, click the Wireless LAN tab on the Configuration screen.

1. Network Type:

Displays the wireless LAN mode currently selected.

Infrastructure
Connects the printer to the wireless LAN with an access point.

Access point mode
Connects external wireless communication devices (e.g. computers, smartphones, or tablets) to the
printer using it as an access point.

Note
• When Access point mode is displayed on Network Type:, you cannot change the settings on the

Wireless LAN sheet or the Admin Password sheet.

• You can perform setting from Set up printer's wireless LAN... on the Settings menu when you
use the printer with the access point mode.

Depending on the printer you are using, you can change the settings using the operation panel.

2. SSID:

The network name (SSID) of the wireless LAN currently used is displayed.

In the access point mode, the access point name (SSID) of the printer is displayed.

As the initial settings, the unique value is displayed.

Note
• Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.
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3. Search...

The Search screen is displayed to select an access point to connect to.

Search Screen

Note
• When IJ Network Tool runs over a LAN, the button is grayed out and cannot be selected. Connect

the printer and the computer with a USB cable temporarily to change the settings.

4. Encryption Method:

Select the encryption method used over the wireless LAN.

Do not use
Select to disable encryption.

Use WEP
Transmission is encrypted using a WEP key you specified.

If a WEP key has not been set, the WEP Details screen is displayed automatically. To change WEP
settings set before, click Configuration... to display the screen.

Changing the WEP Detailed Settings

Use WPA/WPA2
Transmission is encrypted using a WPA/WPA2 key you specified.

The security has been strengthened more than WEP.

If a WPA/WPA2 key has not been set, the Authentication Type Confirmation screen is displayed
automatically. To change WPA/WPA2 settings set before, click Configuration... to display the
WPA/WPA2 Details screen.

Changing the WPA/WPA2 Detailed Settings

5. Configuration...

The detailed settings screen is displayed. The WEP or the WPA/WPA2 key selected in Encryption
Method: can be confirmed and changed.

For details on WEP setting:
Changing the WEP Detailed Settings

For details on WPA/WPA2 setting:
Changing the WPA/WPA2 Detailed Settings

6. TCP/IP Setup:

Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your wireless LAN router or access point.

Use next IP address
Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a particular IP address or a fixed IP address.
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Search Screen

Note
• This screen is not available depending on the printer you are using.

The access points detected are listed.

1. Detected Access Points:

The signal strength from the access point, encryption type, name of access point, and the radio channel
can be confirmed.

Important
• If you connect to a network that is not protected with security measures, there is a risk of

disclosing data such as your personal information to a third party.

Note
• Signal strength is displayed as follows.

: Good

: Fair

: Poor

• Type of encryption is displayed as follows.

Blank: No encryption

WEP: WEP is set

WPA/WPA2: WPA/WPA2 is set

2. Update

Click to update the list of access points when your target access point is not detected.

If the target access point is set to the stealth mode, click Cancel to return to the previous screen and
enter the access point's SSID in SSID: on the Wireless LAN sheet.

Wireless LAN Sheet

Note
• When detecting your target access point, make sure that the access point is turned on.
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3. Set

Click to set the access point's SSID in SSID: on the Wireless LAN sheet.

Note
• The WEP Details screen or the WPA/WPA2 Details screen appears if the selected access point

is encrypted. In this case, configure the details to use the same encryption settings set to the
access point.

• Access points that cannot be used by this machine (including those configured to use different
encryption methods) are displayed grayed out and cannot be configured.
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WEP Details Screen

Note
• This screen is not available depending on the printer you are using.

Specify the printer WEP settings.

Note
• When changing the password (WEP key) of the printer, the same change must be made to the

password (WEP key) of the access point.

1. WEP Key:

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the combination of
the key length and key format.

 Key Length

64bit 128bit

Key Format ASCII 5 characters 13 characters

Hexadecimal (Hex) 10 digits 26 digits

2. Key Length:

Select either 64bit or 128bit.

3. Key Format:

Select either ASCII or Hex.

4. Key ID:

Select the Key ID (index) set to the access point.

5. Authentication:

Select the authentication method to authenticate the printer's access to the access point.

Select Auto or Open System or Shared Key.
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WPA/WPA2 Details Screen

Note
• This screen is not available depending on the printer you are using.

Specify the printer WPA/WPA2 settings.

The value displayed on the screen differs depending on the present settings.

1. Authentication Type:

Displays the type of authentication used for client authentication. This machine supports the PSK
authentication method.

2. Dynamic Encryption Type:

Displays the dynamic encryption method.

3. Change Settings...

Displays the Authentication Type Confirmation screen.

Authentication Type Confirmation Screen
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Authentication Type Confirmation Screen

Note
• This screen is not available depending on the printer you are using.

Type of authentication used for client authentication is displayed.

1. Authentication Type

Type of authentication used for client authentication is displayed.

PSK
This machine supports the PSK authentication method.

This authentication type PSK uses a passphrase.
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PSK:Passphrase and Dynamic Encryption Setup Screen

Note
• This screen is not available depending on the printer you are using.

Enter the passphrase and select the dynamic encryption method.

1. Passphrase:

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

2. Dynamic Encryption Type

The dynamic encryption method is selected from either TKIP (basic encryption) or AES (secure
encryption) automatically.
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Setup Information Confirmation Screen

Note
• This screen is not available depending on the printer you are using.

Displays the settings used for client authentication.

Confirm the settings and click Finish.
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Wired LAN Sheet

Note
• This screen is not available depending on the printer you are using.

Allows you to set the printer with wired LAN connection.

To display the Wired LAN sheet, click the Wired LAN tab on the Configuration screen.

1. TCP/IP Setup:

Sets the IP address of the printer to be used over the LAN. Specify a value appropriate for your network
environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your router.

Use next IP address
Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a particular IP address or a fixed IP address.
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Admin Password Sheet

Set a password for the printer to allow specific people to perform setup and configurations operation.

To display the Admin Password sheet, click the Admin Password tab on the Configuration screen.

1. Use admin password

Set an administrator password with privileges to set up and change detailed options. To use this feature,
select this check box and enter a password.

2. Password:

Enter the password to set.

3. Password Confirmation:

Enter the password again for confirmation.

Important
• If you forget the administrator password you specified, initialize the printer to revert the password to the

default setting.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copied to the clipboard.
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Access Control Sheet

Note
• This screen is not available depending on the printer you are using.

You can register the MAC addresses or the IP addresses of computers or network devices to allow access.

To display the Access Control sheet, click the Access Control tab on the Configuration screen.

1. Printer Access Control Type:

Select the type of access control with which to limit access of computers or network devices to the
printer over a network.

The setting items may differ depending on the choice of access control methods.

When Selecting MAC address

When Selecting IP address

When Selecting MAC address

The accessible computers or network devices are specified by their MAC addresses. Computers or
network devices whose MAC addresses appear on the list are allowed access.
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1. Enable printer access control(MAC address)

Select to enable access control to the printer by MAC address.

Note
• The two types of access control (i.e., by MAC address and by IP address) can be enabled at

the same time.

An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

• When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible MAC Addresses:

Shows the registered MAC addresses and any comments.

3. Edit...

The Edit Accessible MAC Address screen is displayed to edit the settings selected in Accessible
MAC Addresses:.

Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

4. Add...

The Add Accessible MAC Address screen is displayed to register the MAC address of a computer or
a network device from which to access the printer over the network.

Important
• Add the MAC address of all computers or network devices within the network from which to

access the printer. The printer cannot be accessed from a computer or a network device that is
not on the list.

5. Delete

Deletes the selected MAC address from the list.

When Selecting IP address

The accessible computers or network devices are specified by their IP addresses. Computers or network
devices whose IP addresses appear on the list are allowed access.
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1. Enable printer access control(IP address)

Select to enable access control to the printer by IP address.

Note
• The two types of access control (i.e., by MAC address and by IP address) can be enabled at

the same time.

An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

• When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible IP Addresses:

Shows the registered IP addresses and any comments.

3. Edit...

The Edit Accessible IP Address screen is displayed to edit the settings selected in Accessible IP
Addresses:.

Edit Accessible IP Address Screen/Add Accessible IP Address Screen

4. Add...

The Add Accessible IP Address screen is displayed to register the IP address of a computer or a
network device from which to access the printer over the network.

Important
• Add the IP address of all computers or network devices within the network from which to access

the printer. The printer cannot be accessed from a computer or a network device that is not on
the list.

• Up to 16 IP addresses can be registered. IP addresses specified by Range Specification are
counted as one address. Use Range Specification when you intend to register 17 or more IP
addresses.
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5. Delete

Deletes the selected IP address from the list.
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Edit Accessible MAC Address Screen/Add Accessible MAC
Address Screen

Note
• This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible MAC Address Screen.

1. MAC Address:

Enter the MAC address of a computer or a network device to allow access.

2. Comment:

Optionally enter any information to identify the device, such as the name of the computer.

Important
• Comments will be displayed only on the computer used to enter them.
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Edit Accessible IP Address Screen/Add Accessible IP Address
Screen

Note
• This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible IP Address Screen.

1. Specification Method:

Select either Single Address Specification or Range Specification to add the IP address(es).

Single Address Specification
Specify each IP address separately.

Range Specification
Specify a range of successive IP addresses.

2. IP Address:

Enter the IP address of a computer or a network device to allow access when you selected Single
Address Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

Start IP Address:
Enter the first IP address in the range of addresses of the computers or network devices to allow
access when you selected Range Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

End IP Address:
Enter the last IP address in the range of addresses of the computers or network devices to allow
access when you selected Range Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

Note
• The Start IP Address: must be a smaller value than the End IP Address:.

3. Comment:

Optionally enter any information to identify the device, such as the name of the computer.

Important
• Comments will be displayed only on the computer used to enter them.
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Other Screens of IJ Network Tool

Canon IJ Network Tool Screen

Status Screen

Connection Performance Measurement Screen

Maintenance Screen

Network Setup of the Card Slot Screen

Associate Port Screen

Network Information Screen
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

Items on the Canon IJ Network Tool Screen

Canon IJ Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

Important
• To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.

• If No Driver is displayed for the name, associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

• If Not Found is displayed for the status, check the followings:

• The access point is turned on.

• When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

• If the printer is being used from another computer, a screen is displayed informing you of this
condition.
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Note
• This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

Configuration Screen

Note
• You cannot configure a printer that has the status Not Found.

• This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication
status.

In the access point mode, this item is grayed out and you cannot confirm the printer connection
status.

Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the
latest information.

Important
• To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
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• If No Driver is displayed for the name, associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

• If Not Found is displayed for the status, check the followings:

• The access point is turned on.

• When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

• If the printer is being used from another computer, a screen is displayed informing you of this
condition.

Note
• This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are
unavailable for printing.

3. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

Configuration Screen

Note
• This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Enable switch printer function
When you cannot use your printer, you can use the same one on the network instead. When you
enable this function and you cannot use your printer, the screen to confirm if you start searching
the same printer as yours is displayed. Follow the message on the screen.

Note
• When this function is enabled, a check mark appears on the menu.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port
with the printer enables you to use it.
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Maintenance...
Displays the Maintenance screen to revert the network settings of the printer to factory default
and to mount the card slot as the network drive.

Maintenance Screen

Set up printer's wireless LAN...
You can change the access point mode settings. Perform settings following the message on the
screen.

If you change the Encryption Method: setting and the Password: setting on the Set up printer's
wireless LAN screen, the changed settings are applied to the printer settings.

Note
• You can use this function only when you are using a computer compatible with the wireless LAN.

4. Help menu

Instructions
Displays this guide.

About
Displays the version of IJ Network Tool.
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Status Screen

You can check the printer status and connection performance.

To display the Status screen, select Status from the View menu.

Note
• This screen is not available depending on the printer you are using.

• When using wired LAN, Signal Strength:, Link Quality: and Advanced Measurement... are not
available.

1. Device Status:

The device status is displayed as Available or Unavailable.

2. Signal Strength:

Indicates the strength of the signal received by the printer, ranging from 0% to 100%.

3. Link Quality:

Indicates the signal quality excluding the noise while communicating, ranging from 0% to 100%.

4. Advanced Measurement...

To examine the connection performance between the printer and the access point or between the printer
and the computer.

When you click, the Connection Performance Measurement is displayed.

Connection Performance Measurement Screen
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Connection Performance Measurement Screen

Note
• This screen is not available depending on the printer you are using.

Displays to execute the connection performance measurement.

Connection Performance Measurement Screen (Initial Screen)

Connection Performance Measurement Screen (Completion Screen)

Connection Performance Measurement Screen (Initial Screen)

Click Next> to start measurement.

Connection Performance Measurement Screen (Completion Screen)

Displays when the measurement is finished.
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1. Connection Performance between the Printer and the Access Point:

A mark indicates the result of the connection performance measurement between the printer and the
access point.

: Good connection performance

: Unstable connection performance

: Cannot connect

: Measurement is canceled, or cannot measure

2. Remeasurement

Measures the connection performance again.

Note
• If any messages appear on Overall Network Performance:, move the machine and access point as

instructed to improve the performance.
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Maintenance Screen

Displays to perform Setting Initialization and Network Setup of the Card Slot.

To display the Maintenance screen, select Maintenance... from the Settings menu.

1. Setting Initialization

Reverts all the network settings of the printer to factory default. Click Initialize to display the Initialize
Settings screen and click Yes to initialize the network settings of the printer. Do not turn off the printer
during initialization. Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup
with the Setup CD-ROM or perform setup according to the instructions on our website.

2. Network Setup of the Card Slot

Note
• This item is not available depending on the printer you are using.

Status displays whether the card slot is mapped as a network drive.

When you click, the Network Setup of the Card Slot is displayed.

Network Setup of the Card Slot Screen
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Network Setup of the Card Slot Screen

Note
• This screen is not available depending on the printer you are using.

Displays settings of the card slot and allows you to map a card slot on the network as a network drive on the
computer.

Displays when you click Setup on the Maintenance screen.

Network Setup of the Card Slot Screen (Setup Screen)

Network Setup of the Card Slot Screen (Setup Failed Screen)

Note
• You can change the network settings of the printer using IJ Network Tool with USB connection after

initializing the LAN settings. To change the network settings using IJ Network Tool, activate the LAN
settings in advance.

Network Setup of the Card Slot Screen (Setup Screen)

1. Drive:

Select the drive letter to assign to the network drive.

2. Update

Reloads the drive letters that are unassigned in Computer (My Computer in Windows XP) and
displays them in the Drive: list.

Network Setup of the Card Slot Screen (Setup Failed Screen)

Display when the network setup of the card slot is failed.
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1. Skip

Completes the setup without mapping a network drive to the card slot.

2. Retry

Returns to Network Setup of the Card Slot screen and re-executes the network drive mapping.

3. Cancel

Cancels the card slot setup. When IJ Network Tool is running over LAN, the Cancel button is
displayed grayed out and cannot be clicked.
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Associate Port Screen

Allows you to associate a created port with a printer driver.

Select the printer for which you want to change the association, then click OK.

Note
• You cannot print with the printer unless the printer driver is associated with the port.

1. Model:

Displays the name of device specified as a destination port.

It is blank if the name of device is not detected.

2. Printer:

Displays the printer driver installed in the computer.

Select the printer for which you want to change the association.

3. OK

Performs association.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copied to the clipboard.
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Appendix for Network Communication

Using the Card Slot over a Network

When the Printer Driver Is Not Associated with a Port

About Technical Terms

Restrictions

About Firewall
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Using the Card Slot over a Network

Note
• This screen is not available depending on the printer you are using.

Mounting the Card Slot as the Network Drive

Restrictions on Card Slot Use over a Network

Mounting the Card Slot as the Network Drive

The card slot must be mounted to use it over a network.

To mount the card slot as the network drive, follow the procedure below.

1. Insert a memory card into the card slot of the machine.

2. Start up IJ Network Tool.

3. Select the machine in Printers:.

4. Select Maintenance... on the Settings menu.

5. Click Setup.

6. Specify the drive letter, then click OK.
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7. Make sure that the card slot is mounted.

When the card slot is mounted, the following icon appears on Computer (or My Computer).

Restrictions on Card Slot Use over a Network

• The card slot can be shared by multiple computers, if the machine is connected to a network. Multiple
computers can read files from a memory card in the card slot at the same time. However, while one
computer is writing a file into a memory card, other computers cannot access the same file.

• If your computer joins a domain, the card slot may not be mounted as the network drive.

• If you use the memory card stored the large size files or many files, a large amount of card access
may be generated. In this case, the operation in the memory card may be impossible or slow. Operate
after the Access lamp of the machine is lit.

• When you access the network drive for the card slot over the network, file names consisting of eight
or less lowercase letters (not including its extension) may be shown in uppercase.

For example, a file name such as "abcdefg.doc" will be "ABCDEFG.DOC", while a name such as
"AbcdeFG.doc" will appear the same.

The file is not actually renamed, but merely appears to be changed.

• When you enable a memory card in the card slot of the machine to be writable only from a USB-
connected computer, you cannot access the network drive of the card slot. On the other hand, when
you enable it to be writable only from a LAN-connected computer, the card slot is not detected via
USB. Make sure that the card slot setting is selected properly according to your connection method.

To read files from a memory card via USB and over a network, disable the function to write files to a
memory card from a computer. You cannot write files to a memory card in either way with this setting.

• When you enable a memory card in the card slot of the machine to be writable only from a LAN-
connected computer, you can write files to a memory card from a computer connected to a network.
Note that it may increase the risk that the data on the memory card is infected by computer viruses or
accessed illegally.

It is recommended to use the access control function of the machine or connect to the Internet via a
router. For information on using a router, contact your Internet service provider or a network device
manufacturer.

• If you write files to a memory card over a network when IJ Network Scanner Selector EX is not
running, the Date Modified of the files may not be proper. Make sure to start up IJ Network Scanner
Selector EX before you write files to a memory card over the network. For details, refer to "IJ Network
Scanner Selector EX Menu and Setting Screen" from the HOME of your product's Online Manual.
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When the Printer Driver Is Not Associated with a Port

If No Driver is displayed for the printer's name on the Canon IJ Network Tool screen, the printer driver is
not associated with a created port.

To associate a port with a printer driver, follow the procedure below.

1. Start up IJ Network Tool.

2. Select the printer displayed as No Driver on Name.

3. Select Associate Port... on the Settings menu.

The Associate Port screen is displayed.

4. Select a printer to associate with a port.

The list of the printers that the printer driver is installed is displayed at Printer: on the Associate Port
screen. Select a printer to associate with a created port.

5. Click OK.
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About Technical Terms

In this section, technical terms used in the manual are explained.

A

B

C

D

F

I

K

L

M

O

P

R

S

T

U

W

A

• Access Point

A wireless transceiver or base station that receives information from wireless clients/the machine and
rebroadcasts it. Required in an infrastructure network.

• Access point mode

The machine is used as an access point to connect external wireless communication devices (e.g.
computers, smartphones, or tablets) in an environment where no access point or wireless LAN router
is available. You can connect up to 5 devices to the machine using the access point mode.

• Ad-hoc

Client computer and machine setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No access
point is required. This machine does not support ad-hoc communication.

• Admin Password

Administrator password in IJ Network Tool to restrict access to network users. It must be entered to
access the printer and change printer settings.

• AES

An encryption method. It is optional for WPA/WPA2. Strong cryptographic algorithm adopted within
U.S. government organizations for information processing.
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• Authentication Method

The method that an access point uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.

When using WEP as an encryption method, the authentication method is able to fix to Open System
or Shared Key.

For WPA/WPA2, authentication method is PSK.

◦ Auto

The printer automatically changes its authentication method to match the access point.

◦ Open System

In this authentication method, the communication partner is authenticated without using WEP key
even if Use WEP is selected.

◦ Shared Key

In this authentication method, the communication partner is authenticated using the WEP key that
was set for encryption.

B

• Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

C

• Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the access point. This machine supports channels 1 to 13.
(Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that
the number of channels that can be used for your wireless LAN varies depending on the region or
country.

D

• Default Gateway

A relay device to connect to another network such as a router or a computer.

• DHCP server functionality

The router or the access point assigns an IP address automatically whenever the printer or the
personal computer on a network starts up.

• DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.
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F

• Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.

I

• IEEE 802.11b

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

• IEEE 802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

• IEEE 802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

• Infrastructure

Client computer and machine setup where all wireless communications pass through an access point.

• IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by an access point or a DHCP server of the router automatically.

• IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.

K

• Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

◦ ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore "_"
characters. It is case-sensitive.
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◦ Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

• Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.

L

• Link Quality

The status of connection between the access point and the printer excluding noise (interference) is
indicated with a value from 0 to 100%.

• LPR

A platform-independent printing protocol used in TCP/IP networks. It is not supported bidirectional
communication.

M

• MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

O

• Operation Status

Indicates the status on whether the printer can be used.

P

• Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

• PSK

An encryption method employed by WPA/WPA2.

R

• Router

A relay device to connect to another network.
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S

• Signal Strength

The strength of the signal received by the printer from the access point is indicated with a value from
0 to 100%.

• SSID

Unique label for wireless LAN. It is often represented such as a network name or an access point
name.

SSID distinguishes one wireless LAN from another to prevent interference.

The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

• Stealth

In the stealth mode, an access point hides itself by not broadcasting its SSID. The client must specify
the SSID set to the access point to detect it.

• Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by an
access point or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

T

• TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

• TKIP

An encryption protocol employed by WPA/WPA2.

U

• USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.
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W

• WCN (Windows Connect Now)

Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

• WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

• Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.

This machine is a Wi-Fi authorized product.

• Wireless LAN

A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.

• WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

◦ Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This machine supports WPA-PSK.

◦ Passphrase

This encrypted key is used to perform WPA-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

• WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

◦ Authentication

WPA2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This machine supports WPA2-PSK.

◦ Passphrase

This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.
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• WPS (Wi-Fi Protected Setup)

WPS is a standard for easy and secure establishment of a wireless network.

There are 2 primary methods used in the Wi-Fi Protected Setup:

PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP or WPA/WPA2) to the access point to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
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About Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When a Firewall Function is Enabled

• A firewall function may limit communications between a printer and a computer. This may disable
printer setup and communications.

• During the printer setup, you may be prompted to enable or disable communications, depending on
the firewall function of the security software or operation system. If so, choose to enable
communications.

• When using IJ Network Tool, you may be prompted to enable or disable communications, depending
on the firewall function of the security software. If so, choose to enable communications.

• If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

Important
• If you disabled the firewall function, disconnect your network from the Internet.

• Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

• If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using IJ Network Tool.

Changing the Settings in the Wireless LAN Sheet

Changing the Settings in the Wired LAN Sheet

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

Note
• For the operation system firewall settings or the security software firewall settings, refer to the

instruction manual of the computer or software, or contact its manufacturer.
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Tips for Ensuring Optimal Printing Quality

Useful Information about Ink

Key Points to Successful Printing

Be Sure to Check Paper Settings before Printing

Be Sure to Set Cassette Paper Information after Loading Paper

Canceling a Print Job

Key to Enjoying Consistent Printing Quality

Precautions for Safe Transport of the Printer
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Useful Information about Ink

How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing.

When you use the Canon printer for the first time after you install the bundled ink tanks, the printer
consumes a small amount of ink in the amount to enable printing by filling the nozzles of the Print Head
with ink.

The printing costs described in the brochures or websites are based on the consumption data from not the
first ink tank /ink cartridge but the succeeding ink tank /ink cartridge.

Ink is sometimes used to maintain the optimal printing quality.

To keep printer's performance, Canon printer performs cleaning automatically according to its condition.
When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may
be consumed.

[Cleaning function]

The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents
print quality degradation or nozzle clogging.

Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

Note
• The printer uses pigment ink. Due to the nature of the pigment ink, the ink on the printed surface may

be removed when being rubbed or scratched.
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Key Points to Successful Printing

Check the printer status before printing!

• Is the print head OK?

If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the nozzle check
pattern to check the print head.

Maintenance Procedure

• Is the inside of the printer smeared with ink?

After printing large quantities of paper, the area where papers go through may get smeared with ink.
Clean the inside of your printer with Bottom Plate Cleaning.

Check how to load the paper correctly!

• Is the paper loaded in the correct orientation?

To load paper in a cassette, load paper WITH THE PRINTING SIDE FACING DOWN.

Loading Paper

A: cassette 1

B: cassette 2

• Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, then reload it.

"Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is Scratched
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Be Sure to Check Paper Settings before Printing

Before printing, make paper settings in the computer screen.

There are various types of paper, such as paper with a special surface coating for printing photos at optimal
quality and paper suitable for documents.

Each media type has specific preset settings (how ink is used and sprayed, distance from nozzles, etc.), that
allow you to print to that type with optimal image quality. The wrong paper settings may cause poor printout
color quality or scratches on the printed surface.

If you notice blurring or uneven colors, increase the print quality setting and try printing again.
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Be Sure to Set Cassette Paper Information after Loading Paper

When you insert a cassette into the printer after loading paper, the screen for setting the type and size of
paper is displayed. Set the cassette paper information according to the type and size of loaded paper.

To prevent incorrect printing, this printer has a function that detects whether the information set for the paper
loaded in the cassette matches the paper settings. Before printing, make paper settings in accordance with
the cassette paper information. When this function is enabled, an error message is displayed if these
settings do not match to prevent incorrect printing. When this error message is displayed, check and correct
the paper settings.

To check cassette paper information, display the paper information screen on the operation panel.
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Canceling a Print Job

Never press the ON button!

If you press the ON button while printing is in progress, the print data sent from the computer queues in
the printer and you may not be able to continue to print.

Press the Stop button to cancel printing.
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Key to Enjoying Consistent Printing Quality

The key to printing with the optimal printing quality is to prevent the print head from drying or clogging.
Always observe the following rules for optimal printing quality.

Never unplug the power cord until the power is turned off!

If you press the ON button to turn off the power, the printer caps the print head (nozzles) automatically to
prevent from drying. If you unplug the power cord from the wall outlet while the POWER lamp is lit or
flashing, the print head will not be capped properly and this will cause drying or clogging.

When unplugging the power cord, make sure that the POWER lamp is not lit.

Print periodically!

Just as the tip of a felt pen becomes dry and unusable if it has not been used for a long time, even if it is
capped, the print head too, may become dried or clogged if the printer has not been used for a long time.
We recommend you to use the printer at least once a month.

Ink is mixed at fixed intervals.

The printer is set to automatically mix the ink to maintain optimal printing quality. Therefore, printing on a
regular basis helps keep the ink in good condition.

If the printer is not used for an extended period of time, the printer will automatically mix the ink before
printing.

Note
• Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or

paint-stick, or bleed if water or sweat comes in contact with the printed area.
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Precautions for Safe Transport of the Printer

When relocating the printer, make sure of the following.

Important
• Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient

protective material to ensure safe transport.
• Always transport the printer with ink tanks installed. If you transport the printer without ink tanks, ink in

the print head may leak.
• With the print head and ink tank left installed in the printer, press the ON button to turn off the power.

This allows the printer to automatically cap the print head, thus preventing it from drying.
• After packing, do not tilt the box containing the printer or turn it on its side or upside down. Doing so

may cause the ink to leak during transport and cause damage to the printer.
• When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE UP" to

keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

1. Turn the printer off.

2. Confirm that the POWER lamp is off and unplug the power cord.

Important
• Do not unplug the printer while the POWER lamp is lit or flashing, as it may cause malfunction or

damage to the printer, making the printer unable to print.

3. Remove the cassettes from the printer, then shorten it until the retraction position after
removing paper.

Paper Sources to Load Paper

4. Close the paper output support, then retract the output tray extension and the paper output
tray.

5. Reinsert the cassettes.

6. Unplug the printer cable from the computer and from the printer, then unplug the power
cord from the printer.
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7. Use adhesive tape to secure all the covers on the printer to keep them from opening and to
prevent the cassettes from falling out during transportation. Then pack the printer in the
plastic bag.

8. Attach the protective material to the printer when packing the printer in the box.
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Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to print the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

• Paper money
• Money orders
• Certificates of deposit
• Postage stamps (canceled or uncanceled)
• Identifying badges or insignias
• Selective service or draft papers
• Checks or drafts issued by governmental agencies
• Motor vehicle licenses and certificates of title
• Traveler's checks
• Food stamps
• Passports
• Immigration papers
• Internal revenue stamps (canceled or uncanceled)
• Bonds or other certificates of indebtedness
• Stock certificates
• Copyrighted works/works of art without permission of copyright owner
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Specifications

General Specifications

Printing resolution (dpi) 600 (horizontal) x 1200 (vertical)

Interface USB Port:

Hi-Speed USB *1

LAN Port:

Wired LAN: 100BASE-TX / 10BASE-T

Wireless LAN: IEEE802.11n / IEEE802.11g / IEEE802.11b *2

*1 A computer that complies with Hi-Speed USB standard is required. Since
the Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can
be used at USB 1.1.

*2 Setup possible through WPS (Wi-Fi Protected Setup), WCN (Windows
Connect Now) or Cableless setup.

USB and LAN can be used at the same time.

Wireless LAN and wired LAN cannot be used at the same time.

Print width 8 inches/203.2 mm

Operating environment Temperature: 41 to 95 °F (5 to 35 °C)

Humidity: 10 to 90 % RH (no condensation)

* The performance of the printer may be reduced under certain temperature
and humidity conditions.

Recommended conditions:

Temperature: 59 to 86 °F (15 to 30 °C)

Humidity: 10 to 80 % RH (no condensation)

* For the temperature and humidity conditions of papers such as photo paper,
refer to the paper's packaging or the supplied instructions.

Storage environment Temperature: 32 to 104 °F (0 to 40 °C)

Humidity: 5 to 95 % RH (no condensation)

Power supply AC 100-240 V, 50/60 Hz

Power consumption Printing: Approx. 24 W

Standby (minimum): Approx. 1.0 W *1*2

OFF: Approx. 0.3 W *1

*1 USB connection to PC

*2 The wait time for standby cannot be changed.

External dimensions Approx. 18.3 (W) x 15.5 (D) x 11.5 (H) inches

Approx. 463 (W) x 394 (D) x 290 (H) mm

* With the Paper Output Tray and Cassettes retracted.

Weight Approx. 21.5 lb (Approx. 9.8 kg)

* With the Print Head and ink tanks installed.

Print Head/Ink Total 4352 nozzles (BK 1280 nozzles, C/M/Y 512 x 6 nozzles)
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Network Specifications

Communication protocol TCP/IP

Wired LAN Supported Standards: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)

Transfer speed: 10 M/100 Mbps (auto switching)

Wireless LAN Supported Standards: IEEE802.11n / IEEE802.11g / IEEE802.11b

Frequency bandwidth: 2.4 GHz

Channel: 1-11 or 1-13

* Frequency bandwidth and available channels differ depending on country or
region.

Communication distance: Indoors 164 feet/50 m

* Effective range varies depending on the installation environment and location.

Security:

WEP (64/128 bits)

WPA-PSK (TKIP/AES)

WPA2-PSK (TKIP/AES)

Setup:

WPS (Push button configuration/PIN code method)

WCN (WCN-NET)

Cableless setup

Other Features: Administration password

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.

Windows

Operating System Windows 8, Windows 8.1

Windows 7, Windows 7 SP1

Windows Vista SP1, Windows Vista SP2

Windows XP SP3 32-bit only

Printer driver only:

Windows Server 2003*, Windows Server 2003 R2*, Windows Server 2008,
Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012
R2

* XPS driver is not supported.

Browser Internet Explorer 8 or later

Hard Disk Space 2.5 GB

Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display XGA 1024 x 768
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Mac OS

Operating System Mac OS X v10.6.8 or later

Browser Safari 5 or later

Hard Disk Space 0.5 GB

Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display XGA 1024 x 768

Other Supported OS

Some functions may not be available with each OS. Refer to the manual or the Canon web site for details on
operation with iOS, Android, and Windows RT.

Mobile Printing Capability

Apple AirPrint

Google Cloud Print

Print from E-mail

MAXIFY Cloud Link

• An internet connection is required to view the Online Manual.
• Windows: Operation can only be guaranteed on a computer with Windows 8.1, Windows 8,

Windows 7, Windows Vista or Windows XP pre-installed.
• Windows: A CD-ROM Drive or internet connection is required during software installation.
• Windows: Internet Explorer 8, 9, 10 or 11 is required to install Easy-WebPrint EX.
• Windows: Some functions may not be available with Windows Media Center.
• Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.
• Windows: XPS Essentials Pack is required to print on Windows XP.
• Mac OS: Hard Disk must be formatted as Mac OS Extended (Journaled) or Mac OS Extended.
• Mac OS: For Mac OS, an internet connection is required during software installation.
• In an in-house network environment, the 5222 port must be open. Contact the network

administrator for details.

Information in this guide is subject to change without notice.
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Administrator Settings

Sharing the Printer on a Network
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Sharing the Printer on a Network

When computers are used in a network environment, documents can be printed from multiple computers
that share a single printer.

• Setting Up a Shared Printer

This section describes how to set up the print server and the client.

Note
• The Windows versions of the computers connected to the network do not necessarily have to be the

same.
• To set up the fax driver, use the same procedure.

Related Topic

Restrictions on Printer Sharing
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Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Select as described below:

• If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012,
from the Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware)
-> Devices and Printers
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control Panel -
> Hardware and Sound (Hardware) -> Devices and Printers
The Devices and Printers window is displayed.

• If you are using Windows Vista or Windows Server 2008, select the Start menu -> Control Panel -
> Hardware and Sound -> Printers
The Printers window is displayed.

• If you are using Windows XP, select the start menu -> Control Panel -> Printers and Other
Hardware -> Printers and Faxes
The Printers and Faxes window is displayed.

• If you are using Windows Server 2003 R2 or Windows Server 2003, select the start menu ->
Printers and Faxes
The Printers and Faxes window is displayed.

3. Click the icon for the model name of printer to be shared

• If you are using Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2, Windows Server
2012, or Windows Server 2008 R2, press the Alt key, and from the displayed File menu, select
Printer properties -> Sharing tab.

• If you are using Windows Vista, press the Alt key, and from the displayed File menu, select Run
as administrator -> Sharing....

• If you are using Windows XP, Windows Server 2008, Windows Server 2003 R2, or Windows
Server 2003, select Sharing... from the File menu.

Important
• In Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box may appear when

starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

Note
• Windows XP may display a message recommending the user to use the Network Setup Wizard

to set up sharing.
When this message appears, choose not to use the wizard and then set up sharing.

4. Set sharing
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On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

1. Display the Devices and Printers, Printers, or Printers and Faxes window.
2. Select as described below:

• If you are using Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2, Windows
Server 2012, or Windows Server 2008 R2, select the printer icon, click Print server
properties, and select the Drivers tab

• If you are using Windows Vista, press the Alt key, and from the displayed File menu, select
Run as administrator -> Server Properties..., and select the Drivers tab

• If you are using Windows XP, Windows Server 2008, Windows Server 2003 R2, or Windows
Server 2003, from the File menu, open Server Properties, and select the Drivers tab

3. Click Add....
4. When the Add Printer Driver Wizard window is displayed, click Next.
5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit architecture,

select x86. Then click Next.
6. Click Have Disk....
7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver, specify

the "inf" file, and click OK.
8. Select the printer to be used, and click Next.

Note
• If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.

6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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Restrictions on Printer Sharing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when
reading this information.

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

Restriction on setting up printer sharing

• If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:
1. Start Explorer on the print server and on the client with the different architecture, paste the

following path in the address bar, and press Enter on the keyboard:
%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.
3. On the Sharing tab, click Share.
4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder

that was shared in step 3, and click OK.
If there are multiples copies, select the file with the latest update date and time.

• If the print server is using the 32-bit version of Windows XP and the 64-bit driver is to be installed, the
installation may fail if the 32-bit "inf" file is not deleted from the driver package folder.

Restrictions on sharing and using a printer

• A print completion message may be displayed. To disable the message display, follow the procedure
below.

◦ If you are using Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows Server 2012:

In the Devices and Printers window of the client system, select the printer from Printers, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows 7 or Windows Server 2008 R2:

In the Devices and Printers window of the client system, select the printer from Printers and
Faxes, and click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows Vista:

In the Printers window of the client system, press the Alt key, and from the displayed File menu,
click Run as administrator -> Server Properties....
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows Server 2008:

In the Printers window of the client system, click Server Properties... from the File menu.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows XP, Windows Server 2003 R2, or Windows Server 2003:

In the Printers and Faxes window of the print server system, click Server Properties from the
File menu.
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Uncheck Notify when remote documents are printed on the Advanced tab, and then restart
the computer.

• The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

• When you print from a client system, you cannot use Canon IJ Preview.
• When the functions on the Maintenance tab cannot be set properly from a client system, they may be

grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.

• If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

• If an error occurs when you print a document on a shared printer from a client, the error message of
the Canon IJ status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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Administrator Password

Depending on the printer you are using, an administrator password is specified at the time of purchase.

The password is either "canon" or the printer serial number if it is specified.

Model whose administrator password is specified as "canon":

• The administrator password is specified as "canon" for the models below.

MG7500 series, MG6700 series, MG6600 series, MG5600 series

MG2900 series, MX490 series, MB5300 series, MB5000 series

MB2300 series, MB2000 series, E480 series, E460 series

iP110 series, iB4000 series, PRO-100S series, PRO-10S series

• At the time of purchase, the user name "ADMIN" is also specified for the models above.

• The following character restrictions apply to the password that you change:

◦ Set the password by using 0 to 32 characters.

◦ The allowed characters are single-byte alphanumeric characters.

◦ For security reasons, we recommend you use 6 and more alphanumeric characters.

Model whose serial number is used as the administrator password:

• For the models other than the above, the printer serial number is used as the administrator password.

Where Serial Number Is Located

• The following character restrictions apply to the password that you change:

◦ Set the password by using 4 to 32 characters.

◦ The allowed characters are single-byte alphanumeric characters.

◦ For security reasons, we recommend you use 6 and more alphanumeric characters.

Important
• You can change the password using one of the tools below. (Some tools may not be available

depending on the printer you are using.)

• operation panel of the printer

• IJ Network Tool

• printer information screen displayed on some Canon application software

• If the password has been changed while you are sharing the printer and you do not know the password,
ask the administrator of the printer you are using.

• Set the password back to the default setting by initializing the printer settings.

For more on initializing the printer, search for "UG067" or "UG505" on your printer's Online Manual and
see the instructions shown.
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Printing

Printing from a Computer

 

Paper setting for Printing
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Printing from a Computer

Printing with Application Software that You are Using (Printer Driver)
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Printing with Application Software that You are Using (Printer
Driver)

Printing with Easy Setup Basic

Various Printing Methods

Changing the Print Quality and Correcting Image Data

Overview of the Printer Driver

Printer Driver Description

Updating the Printer Driver
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Printing with Easy Setup

This section describes the simple procedure for setting the Quick Setup tab so that you can carry out
appropriate printing on this printer.

1. Check that the printer is turned on

2. Load paper on the printer

3. Open the printer driver setup window

4. Select a frequently used profile

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.
When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size
settings are automatically switched to the values that were preset.

5. Select the print quality

For Print Quality, select High or Standard according to your purpose.

310



Important
• The print quality settings that can be selected may differ depending on a printing profile.

6. Select the paper source

Select Cassette (Auto Select), Cassette 1, or Cassette 2 that matches your purpose for Paper
Source.

Important
• The paper source settings that can be selected may differ depending on the paper type and size.

7. Complete the setup
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Click OK.
When you execute print, the document is printed with settings that match your purpose.

Important
• When you select the Always Print with Current Settings check box, all settings specified on the

Quick Setup, Main, and Page Setup tabs are saved, and you can print with the same settings from the
next time as well.

• In the Commonly Used Settings window, click Save... to register the specified settings.

Note
• If the paper settings on the printer driver differ from the cassette paper information registered on the

printer, an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)
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Paper Settings on the Printer Driver and the Printer (Media Type)

When you use this printer, selecting a media type and paper size that matches the print purpose will help
you achieve the best print results.
You can use the following media types on this printer.

Commercially available papers

Media name Media Type in the printer driver
Cassette paper information registered on

the printer

Plain Paper (including recycled
paper)

Plain Paper Plain paper

Envelopes Envelope Envelope

Canon genuine papers (Photo Printing)

Media name <Model No.> Media Type in the printer driver
Cassette paper information registered

on the printer

Photo Paper Plus Glossy II <PP-201> Photo Paper Plus Glossy II PlusGlossyII

Photo Paper Pro Luster <LU-101> Photo Paper Pro Luster Pro Luster

Photo Paper Plus Semi-gloss <SG-201> Photo Paper Plus Semi-gloss Semi-gloss

Photo Paper Glossy <GP-501/GP-601> Glossy Photo Paper Glossy

Matte Photo Paper <MP-101> Matte Photo Paper Matte

Canon genuine papers (Business Letter Printing)

Media name <Model No.> Media Type in the printer driver
Cassette paper information registered on the

printer

High Resolution Paper <HR-101N> High Resolution Paper High Res
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Paper Settings on the Printer Driver and the Printer (Paper Size)

When you use this printer, selecting a paper size that matches the print purpose will help you achieve the
best print results.
You can use the following paper sizes on this printer.

Printer Paper Size in the printer driver Cassette paper information registered on the printer

Letter 8.5"x11" 22x28cm Letter

Legal 8.5"x14" 22x36cm Legal

A5 A5

A4 A4

B5 B5

4"x6" 10x15cm KG/4"x6"

5"x7" 13x18cm 2L/5"x7"

8"x10" 20x25cm 8"x10"

L 89x127mm L

2L 127x178mm 2L/5"x7"

Envelope Com 10 Env. Com 10

Envelope DL Envelope DL

Yougata 4 4.13"x9.25" Others

Yougata 6 3.86"x7.48" Others

Custom Size Others
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Various Printing Methods

Setting a Page Size and Orientation

Setting the Number of Copies and Printing Order

Setting the Stapling Margin

Fit-to-Page Printing

Scaled Printing

Page Layout Printing

Tiling/Poster Printing

Booklet Printing

Duplex Printing

Stamp/Background Printing

Registering a Stamp

Registering Image Data to be Used as a Background

Setting Up Envelope Printing

Printing on Postcards

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)

Editing the Print Document or Reprinting from the Print History
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:
You can also set page size and orientation on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.

3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.

Note
• If Normal-size is selected for Page Layout, then Automatically reduce large document that the

printer cannot output is displayed.
Normally, you can leave the check box checked. During printing, if you do not want to reduce large
documents that cannot be printed on the printer, uncheck the check box.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:
You can also set the number of copies on the Quick Setup tab.

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.

3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.
Check the Collate check box when you are printing multiple copies of a document and want to print out
all pages in each copy together. Uncheck this check box when you want to print all pages with the same
page number together.

• Print from Last Page:  /Collate: 

• Print from Last Page:  /Collate: 

• Print from Last Page:  /Collate: 
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• Print from Last Page:  /Collate: 

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

Important
• When the application software that you used to create the document has the same function, specify the

settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.

• Print from Last Page appears grayed out and is unavailable when Tiling/Poster is selected for Page
Layout.

• When Booklet is selected for Page Layout, Print from Last Page and Collate appear grayed out and
cannot be set.

• When Duplex Printing is selected, Print from Last Page appears grayed out and cannot be set.

Note
• By setting both Print from Last Page and Collate, you can perform printing so that papers are collated

one by one starting from the last page.
These settings can be used in combination with Normal-size, Fit-to-Page, Scaled, and Page Layout.
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Setting the Stapling Margin

The procedure for setting the staple side and the margin width is as follows:

1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Stapling Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
staple position. When you want to change the setting, select from the list.

3. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.
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Note
• The printer automatically reduces the print area depending on the staple position margin.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin width.

Important
• Stapling Side and Specify Margin... appear grayed out and are unavailable when:

• Tiling/Poster or Booklet is selected for Page Layout
• Scaled is selected for Page Layout (When Duplex Printing is also selected, only Stapling Side

can be specified.)
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Fit-to-Page Printing

The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be
used is as follows:

1. Open the printer driver setup window

2. Set fit-to-page printing

Select Fit-to-Page from the Page Layout list on the Page Setup tab.

3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When the
Printer Paper Size is larger than the Page Size, the page image will be enlarged.

The current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK.
When you execute print, the document will be enlarged or reduced to fit to the page size.
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Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Set scaled printing

Select Scaled from the Page Layout list on the Page Setup tab.

3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Set the scaling rate by using one of the following methods:

• Select a Printer Paper Size

When the printer paper size is smaller than the Page Size, the page image will be reduced. When
the printer paper size is larger than the Page Size, the page image will be enlarged.
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• Specify a scaling factor

Directly type in a value into the Scaling box.

The current settings are displayed in the settings preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

Important
• When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in
the printer driver.
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Note
• Selecting Scaled changes the printable area of the document.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for performing page layout printing is as follows:

1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.
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Pages
To change the number of pages to be printed on a single sheet of paper, select the number of
pages from the list.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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Tiling/Poster Printing

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for performing tiling/poster printing is as follows:

Setting Tiling/Poster Printing

1. Open the printer driver setup window

2. Set tiling/poster printing

Select Tiling/Poster from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of image divisions and the pages to be printed
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If necessary, click Specify..., specify the following settings in the Tiling/Poster Printing dialog box,
and then click OK.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create
a larger poster.

Print "Cut/Paste" in margins
To leave out words "Cut" and "Paste", uncheck this check box.

Note
• This feature may be unavailable when certain printer drivers or operating environments are

used.

Print "Cut/Paste" lines in margins
To leave out cut lines, uncheck this check box.

Print page range
Specifies the printing range. Select All under normal circumstances.
To reprint only a specific page, select Pages and enter the page number you want to print. To
specify multiple pages, enter the page numbers by separating them with commas or by entering a
hyphen between the page numbers.

Note
• You can also specify the print range by clicking the pages in the settings preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.

Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Set the print range

In the settings preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.
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Note
• Click the deleted pages to display them again.
• Right-click the settings preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

Important
• Since tiling/poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the
paper. This type of printing ensures that pages can be collated properly, in page number order, when the
printed sheets are folded and stapled at the center.

The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the window.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click OK.
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Margin for stapling
Select which side should the stapling margin be on when the booklet is completed.

Insert blank page
To leave one side of a sheet blank, check the check box, and select the page to be left blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin width
for one page.

Page Border
To print a page border around each document page, check the check box.

5. Complete the setup

Click OK on the Page Setup tab.

When you execute print, the document is automatically printed first on one side of a sheet of paper and
then on the opposite side.
When the printing is complete, fold the paper at the center of the margin and make a booklet.

Important
• Booklet cannot be selected when a media type other than Plain Paper is selected for Media Type on

the Main tab.

Note
• The stamp and background are not printed on the inserted blank sheets with the Insert blank page

function of booklet printing.
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Duplex Printing

The procedure for printing data on both sides of a sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab.

Performing Automatic Duplex Printing

You can perform the duplex printing without having to turn over the paper.

1. Open the printer driver setup window

2. Set automatic duplex printing

Check the Duplex Printing check box on the Page Setup tab and confirm that Automatic is checked.

3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Set the print area

When you perform duplex printing, the print area of the document becomes slightly narrower than
usual and the document may not fit on one page.
Click Print Area Setup..., select one of the following process methods, and then click OK.
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Use normal-size printing
Print without reducing the page.

Use reduced printing
Reduce the page slightly during printing.

5. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

6. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

7. Complete the setup

Click OK on the Page Setup tab.
When you execute print, duplex printing will be started.

Performing Duplex Printing Manually

You can perform the duplex printing manually.

1. Open the printer driver setup window

2. Set duplex printing

Check the Duplex Printing check box and uncheck the Automatic check box on the Page Setup tab.
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3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

5. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

6. Complete the setup

Click OK on the Page Setup tab.

When you execute print, the document is first printed on one side of a sheet of paper. After one side is
printed, reload the paper correctly according to the message.
Then click Start Printing to print the opposite side.

Important
• When a media type other than Plain Paper is selected from the Media Type list on the Main tab,

Duplex Printing appears grayed out and is unavailable.
• When Borderless, Tiling/Poster, or Booklet is selected from the Page Layout list, Duplex Printing

and Stapling Side appear grayed out and are unavailable.
• Duplex Printing can be performed only when one of the following paper sizes is selected from Page

Size on the Page Setup tab.
• Letter 8.5"x11" 22x28cm, A4

• After printing the front page, there is an ink drying wait time before starting to print the back page
(Operation stops temporarily). Do not touch the paper during this time. You can change the ink drying
wait time at Custom Settings on the Maintenance tab.
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Related Topic

Changing the Printer Operation Mode
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Stamp/Background Printing

Stamp or Background may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light illustration
behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a Stamp

"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab

The Stamp/Background (Stamp) dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and only the stamp function can be used.
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3. Select a stamp

Check the Stamp check box, and select the stamp to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the stamp details

If necessary, specify the following settings, and then click OK.

Define Stamp... button
To change the stamp text, bitmap, or position, click this.

Place stamp over text
To print the stamp on the front of the document, check this check box.

Note
• The stamp is given priority because the stamp is printed over the document data in the

sections where the stamp and the document data overlap. When this check box is
unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application software used.

• Place stamp over text cannot be used when the XPS printer driver is used.
When the XPS printer driver is used, the stamp is normally printed in the foreground of the
document.

Print semitransparent stamp
Check this check box to print a semi-transparent stamp on the document.
This function is available only when the XPS printer driver is used.

Stamp first page only
To print the stamp only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a Background

Two bitmap files are pre-registered as samples.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

3. Select the background

Check the Background check box, and select the background to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the background details

If necessary, complete the following settings, and then click OK.
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Select Background... button
To use another background or change the layout or density of a background, click this.

Background first page only
To print the background only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

Note
• The stamp and background are not printed on blank sheets inserted with the Insert blank page

function of booklet printing.

Related Topics

Registering a Stamp
Registering Image Data to be Used as a Background
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab

The Stamp/Background (Stamp) dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and only the stamp function can be used.

3. Click Define Stamp...

The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window

• Stamp tab

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type.
◦ For Text registration, the characters must already be entered in Stamp Text. If necessary,

change the TrueType Font, Style, Size, and Outline settings. You can select the color of
the stamp by clicking Select Color....

◦ For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,
change the settings of the Size and Transparent white area.

◦ For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size,
and Outline. You can select the color of the stamp by clicking Select Color....

Important
• Stamp Text appears grayed out and is unavailable when Date/Time/User Name is

selected.

• Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.
You can also change the stamp position by dragging the stamp in the preview window.
To change the stamp position angle, type a value in the Orientation box directly.

Important
• Orientation cannot be changed when Bitmap is selected for Stamp Type on the Stamp tab.

5. Save the stamp

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.
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6. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select the stamp for which the settings are to be changed

Select the Stamp check box in the Stamp/Background (Stamp) dialog box. Then from the list, select
the title of the stamp to be changed.

2. Click Define Stamp...

The Stamp Settings dialog box opens.

3. Configure the stamp while viewing the preview window

4. Overwrite save the stamp

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Deleting an Unnecessary Stamp

1. Click Define Stamp... in the Stamp/Background (Stamp) dialog box

The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
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Registering Image Data to be Used as a Background

This feature may be unavailable when certain printer drivers or operating environments are used.

You can select a bitmap file (.bmp) and register it as a new background. You can also change and register
some of the settings of an existing background. An unnecessary background can be deleted.

The procedure for registering image data to be used as a background is as follows:

Registering New Background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and Background cannot be used.

3. Click Select Background...

The Background Settings dialog box opens.
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4. Select the image data to be registered to the background

Click Select File.... Select the target bitmap file (.bmp), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method
Select how the background image data is to be placed.
When Custom is selected, you can set coordinates for X-Position and Y-Position.
You can also change the background position by dragging the image in the preview window.

Intensity
Set the intensity of the background image data with the Intensity slider. Moving the slider to the
right darkens the background, and moving the slider to the left lightens the background. To print
the background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

7. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Changing and Registering Some Background Settings

1. Select the background for which the settings are to be changed

Select the Background check box in the Stamp/Background dialog box. Then from the list, select
the title of the background you want to change.

2. Click Select Background...
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The Background Settings dialog box opens.

3. Specify each item on the Background tab while viewing the preview window

4. Save the background

Click Save overwrite on the Save settings tab. When you want to save the background with a
different title, enter a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Deleting an Unnecessary Background

1. Click Select Background... in the Stamp/Background dialog box

The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
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Setting Up Envelope Printing

The procedure for performing envelope printing is as follows:

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Commonly Used Settings on the Quick Setup tab.

4. Select the paper size

When the Envelope Size Setting dialog box is displayed, select Envelope Com 10, Envelope DL,
Yougata 4 4.13"x9.25", or Yougata 6 3.86"x7.48", and then click OK.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

6. Select the print quality

Select High or Standard that matches your purpose for Print Quality.

7. Complete the setup

Click OK.
When you execute print, the information is printed on the envelope.
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Important
• When you execute envelope printing, guide messages are displayed.

To hide the guide messages, check the Do not show this message again check box.
To show the guide again, click the View Printer Status button on the Maintenance tab, and start the
Canon IJ Status Monitor.
Then click Envelope Printing from Display Guide Message of the Option menu to enable the setting.

Note
• If the paper settings on the printer driver differ from the cassette paper information registered on the

printer, an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)

347



Printing on Postcards

This section describes the procedure for postcard printing.

1. Load postcard on the printer

2. Open the printer driver setup window

3. Select commonly used settings

Display the Quick Setup tab, and for Commonly Used Settings, select Standard.

4. Select the media type

For Media Type, select Hagaki A, Ink Jet Hagaki, Hagaki K, or Hagaki.

Important
• This printer cannot print on postcards that have photos or stickers attached.
• When printing on each side of a postcard separately, you will get cleaner printing if you print the

message side first and then print the address side.
• The paper settings on the printer driver and the cassette paper information to register on the

printer are different, depending on whether you are printing on the address side or the message
side. For details about the cassette paper information to be registered on the printer, see the
following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)

5. Select the paper size

For Printer Paper Size, select Hagaki 100x148mm or Hagaki 2 200x148mm.

Important
• Return postcards can be used only when you print them from the computer.
• When printing a return postcard, always set the paper size to Hagaki 2 200x148mm from your

application software or the printer driver.
• Do not fold the return postcard. If a crease is formed, the printer will not be able to feed the

postcard properly, and this condition will cause line shifts or a paper jam.

6. Set the print orientation

To print the address horizontally, set Orientation to Landscape.

7. Select the print quality

For Print Quality, select High or Standard, whichever best suits the purpose.

8. Complete the setup

Click OK.
When you execute printing, the data will be printed onto the postcard.
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Important
• When you execute postcard printing, a guide message is displayed.

When the guide message is displayed, select Do not show this message again if you do not want any
guide messages to be displayed.
To display guide messages again, open the Maintenance tab and click View Printer Status to start the
Canon IJ Status Monitor.
On the Option menu, choose Display Guide Message and click Hagaki Printing to enable the setting.

• When printing on media other than postcards, load the media according to usage method of that media,
and click Start Printing.
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Switching the Paper Source to Match the Purpose

In this printer, there are two paper sources, a cassette 1 and a cassette 2.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

You can also set the paper source on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

3. Select the paper source

From the Paper Source list, select the paper source that matches your purpose.

Cassette (Auto Select)
Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.

Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

Important
• When a media type other than Plain Paper is selected for Media Type on the Main tab, paper

cannot be supplied from the cassette 2.
• When a paper size other than Letter 8.5"x11" 22x28cm, Legal 8.5"x14" 22x36cm, or A4 is

selected for Page Size on the Page Setup tab, paper cannot be supplied from the cassette 2.
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4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.

Note
• If the paper settings on the printer driver differ from the cassette paper information registered on

the printer, an error may occur. For instructions on what to do if an error occurs, see "Paper
setting for Printing."
For details about the cassette paper information to be registered on the printer, see the following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)
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Displaying the Print Results before Printing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when
reading this information.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

You can also set the print results display on the Quick Setup tab.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
When you execute print, the Canon IJ Preview opens and displays the print results.

Important
• In the Manual Color Adjustment dialog box, the Color Adjustment tab contains the Print a pattern

for color adjustment check box. When this check box is selected, the Preview before printing
appears grayed out and is unavailable.

Related Topic

Canon IJ Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

The procedure for specifying a custom size is as follows:

You can also set a custom size in Printer Paper Size on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select Custom... for Page Size on the Page Setup tab.

The Custom Paper Size dialog box opens.

3. Set the custom paper size

Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.
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Important
• If the application software that created the document has a function for specifying height and width

values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

• Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Media Types You Can Use."

Note
• If the paper settings on the printer driver differ from the cassette paper information registered on the

printer, an error may occur. For instructions on what to do if an error occurs, see "Paper setting for
Printing."
For details about the cassette paper information to be registered on the printer, see the following:

• Paper Settings on the Printer Driver and the Printer (Media Type)
• Paper Settings on the Printer Driver and the Printer (Paper Size)
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Editing the Print Document or Reprinting from the Print History

This function is unavailable when the standard IJ printer driver is used.

In the Canon IJ XPS preview window, you can edit the print document or retrieve the document print history
to print the document.

The procedure for using the Canon IJ XPS Preview is as follows:

Print

Combine Documents

Delete Document

Reset Documents

View Thumbnails

Move Document

Undo

Move Page

Delete Page

Note

• By clicking  View Thumbnails, you can display or hide thumbnails of the print documents selected
in the Document Name list.

• Clicking  Undo reverses the change that just performed.
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Editing and Printing a Print Document

When printing multiple documents or pages, you can combine documents, change the print sequence of
the documents or pages, or delete documents or pages.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
The Canon IJ XPS Preview will start and the print result will be displayed before printing.

4. Editing print documents and print pages

• Combining print documents

You can combine multiple print documents to form a single document. By combining print
documents, you can prevent blank pages from being inserted when you execute duplex printing
or page layout printing.
From the Document Name list, select the documents to be combined. On the Edit menu, select
Combine Documents from Documents to combine the documents in the listed sequence.
To select multiple print documents, hold down the Ctrl key and click the documents to be
merged, or hold down the Shift key and press the upper arrow or lower arrow key. You can also
click a blank area in the document list and drag the mouse to select multiple documents.
When you combine documents, the documents selected before the combining are deleted from
the list and the combined document is added to the list.

• Changing the sequence of print documents or print pages

◦ To change the sequence of the print documents, go to the Document Name list, and select
the print document to be moved. Next, on the Edit menu, select Move Document from
Documents, and select the appropriate item. You can also click and drag a print document
to change the print sequence.

◦ To change the sequence of the print pages, click View Thumbnails from the Option menu,
and select the print page to be moved. Next, on the Edit menu, select Move Page from
Pages, and select the appropriate item. You can also click and drag a print page to change
the print sequence.

• Deleting print documents and print pages

◦ To delete a print document, select the target document from the Document Name list, and
on the Edit menu, choose Documents and then Delete Document.

◦ To delete a print page, click View Thumbnails from the Option menu, and select the print
page to be deleted. Next, on the Edit menu, select Delete Page from Pages.

• Print page recovery

You can recover pages that were deleted with Delete Page.
To recover pages, select the View Deleted Pages check box from the Option menu, and select
the pages to be recovered from among the displayed thumbnail pages. Then from the Edit menu
chose Pages and then Restore Page.

356



After editing the print documents or print pages, you can change the print settings on the Page
Information, Layout and Manual Color Adjustment tabs as necessary.

Important
• To display the multiple documents in the list, open the preview and execute print again.
• To return the print documents to their original condition before they were edited in the preview,

on the Edit menu, select Reset Documents from Documents.
• If the documents to be combined have different print settings, a message may be displayed.

Check the contents of the displayed message before combining the documents.
• If the documents to be combined have different output paper sizes and duplex printing or page

layout printing is to be performed, the printer may not produce the expected print results for
certain print pages.
Check the preview before printing.

• Depending on the print settings of the print document, some functions may not be available in
the Canon IJ XPS preview.

Note
• You can rename Document Name to any name.

5. Executing print

Click Print.
When you execute print, the printer uses the specified settings to print the data.

Reprinting from the Print History

When you click Save Print History on the File menu to enable the setting, the document printed from the
preview is saved, and you can reprint the document with the same settings.

1. Displaying the print history

Open the printer driver setup window. Then on the Maintenance tab, select View Print History.
The saved print document is displayed in the preview.

Important
• To limit the number of print history registrations, click History Entry Limit on the File menu.
• If the limit on the number of registration is exceeded, the print history registrations are deleted

starting from the oldest one.

2. Selecting a print document

From the Document Name list, select the document to be printed.

3. Executing print

Click Print.

Related Topic

Displaying the Print Results before Printing
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Changing the Print Quality and Correcting Image Data

Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

You can also set a grayscale printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.

3. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

Important
• When the Grayscale Printing check box is checked, the printer driver processes image data as sRGB

data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data
using an application software.
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Note
• During Grayscale Printing, inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed with
color tints that most people prefer. This method is suitable for printing sRGB data.

When you want to print by using the color space (Adobe RGB or sRGB) of the image data effectively, select
ICM (ICC Profile Matching). When you want to use an application software to specify a printing ICC profile,
select None.

The procedure for specifying color correction is as follows:

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
With Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

None
The printer driver does not perform color correction. Select this value when you are specifying an
individually created printing ICC profile in an application software to print data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

Important
• When ICM is disabled in the application software, ICM is unavailable for Color Correction and the

printer may not be able to print the image data properly.
• When the Grayscale Printing check box on the Main tab is checked, Color Correction appears

grayed out and is unavailable.

Related Topics

Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.
To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
Adobe RGB and sRGB are popularly used as common color spaces. Adobe RGB has a wider color space
than sRGB.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space (Adobe RGB or sRGB) of the image data
or the application software to be used.

There are two typical printing methods.
Check the color space (Adobe RGB or sRGB) of the image data and the application software to be used,
and then select the printing method suited to your purpose.

Adjusting Colors with the Printer Driver
Describes the procedure for printing sRGB data by using the color correction function of the printer
driver.

• To print using Canon Digital Photo Color

The printer prints data with color tints that most people prefer, reproducing colors of the original
image data and producing three-dimensional effects and high, sharp contrasts.

• To print by directly applying editing and touch-up results of an application software

When printing the data, the printer brings out subtle color difference between dark and light
areas, while leaving the darkest and lightest areas intact.
When printing the data, the printer applies fine adjustment results, such as brightness
adjustments made with an application software.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of Adobe RGB or sRGB effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print sRGB data with color tints that most
people prefer through the use of Canon Digital Photo Color.
When printing from an application software that can identify ICC profiles and allows you to specify them, use
a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.

4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
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Adjusting Intensity
Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space (Adobe RGB
or sRGB) of the data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.
Even if you print using a printing ICC profile that you created yourself from your application software, be
sure to select color management items from your application software.
For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select None for Color Correction.

4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

Print from an application software that cannot identify input ICC profiles or does allow you to specify one
by using the color space of the input ICC profile (sRGB) found in the data. When printing Adobe RGB
data, you can print the data with the Adobe RGB color space even if the application software does not
support Adobe RGB.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select ICM (ICC Profile Matching) for Color Correction.

4. Select the input profile

Select an Input Profile that matches the color space of the image data.

• For sRGB data or data without an input ICC profile:

Select Standard.
• For Adobe RGB data:

Select Adobe RGB (1998).
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Important
• When the application software specifies an input profile, the input profile setting of the printer

driver becomes invalid.
• When no input ICC profiles are installed on your computer, Adobe RGB (1998) will not be

displayed.

5. Set the other items

If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, Intensity,
and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints when printing.
Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.
The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment Adjust color balance

The procedure for adjusting color balance is as follows:

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust color balance
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There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved
to the left. For example, when cyan becomes weaker, the color red becomes stronger.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

Important
• When the Grayscale Printing check box on the Main tab is checked, the color balance (Cyan,

Magenta, Yellow) appear grayed out and are unavailable.

Related Topics

Specifying Color Correction
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Color Balance Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the color balance.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the color balance while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.

Parameters to Adjust
Select Cyan/Magenta/Yellow.

Important
• When the Grayscale Printing check box on the Main tab is checked, Cyan/Magenta/Yellow

appear grayed out and are unavailable.

Printer Paper Size
Select the paper size to be used for pattern printing.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.
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Note
• Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
color balance that you set is the center value.

6. Adjusting the color balance

Look at the print results and select the image that you like best. Then enter the color balance numbers
indicated at the bottom of that image into the Cyan, Magenta, and Yellow fields on the Color
Adjustment tab.
Clear the Print a pattern for color adjustment check box, and click OK.
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Note
• You can also set color balance on the Quick Setup tab by choosing Photo Printing under

Commonly Used Settings, and then choosing Color/Intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the color balance that was adjusted by the
pattern print function.

Important
• When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following

items are grayed out and cannot be set:
• Preview before printing on the Main tab
• Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing is set, only

Stapling Side can be set.)

• You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
• When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow

appear grayed out and are unavailable.
• Depending on your application software, this function may not be available.

Related Topics

Adjusting Color Balance
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Brightness

You can change the brightness of the overall image data during printing.
This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.
The following sample shows the print result when the brightness setting is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Specify the brightness

Select Light, Normal, or Dark for Brightness, and click OK. The current settings are displayed in the
settings preview on the left side of the printer driver.

375



4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Intensity
Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.
The following sample shows the case when the intensity is increased so that all colors become more intense
when the image data is printed.

No adjustment Higher intensity

The procedure for adjusting intensity is as follows:

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors, and moving the slider to the left
dilutes (brightens) the colors.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust the contrast

Moving the Contrast slider to the right increases the contrast, and moving the slider to the left decreases
the contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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After adjusting each color, click OK.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the intensity/contrast.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the intensity/contrast while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.

Parameters to Adjust
Select Intensity/Contrast.

Printer Paper Size
Select the paper size to be used for pattern printing.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.

Note
• Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print
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On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
intensity/contrast that you set is the center value.

6. Adjusting the intensity/contrast

Look at the print results and select the image that you like best. Then enter the intensity/contrast
numbers indicated at the bottom of that image into the Intensity and Contrast fields on the Color
Adjustment tab.
Clear the Print a pattern for color adjustment check box, and click OK.
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Note
• You can also set intensity/contrast on the Quick Setup tab by choosing Photo Printing under

Commonly Used Settings, and then choosing Color/Intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the intensity/contrast that was adjusted by
the pattern print function.

Important
• When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following

items are grayed out and cannot be set:
• Preview before printing on the Main tab
• Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing is set, only

Stapling Side can be set.)

• You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
• Depending on your application software, this function may not be available.

Related Topics

Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity
Adjusting Contrast
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Overview of the Printer Driver

Canon IJ Printer Driver

How to Open the Printer Driver Setup Window

Canon IJ Status Monitor

Checking the Ink Status from Your Computer

Canon IJ Preview

Deleting the Undesired Print Job

Instructions for Use (Printer Driver)
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Canon IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

Printer Driver Types

On Windows Vista SP1 or later, you can install the XPS printer driver in addition to the regular printer
driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

Important
• To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

• To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

• To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name) to specify the regular printer driver or select "XXX XPS"
(where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

Note
• Depending on application software you use, command names or menu names may vary and

there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

• If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings ->
Control Panel -> Hardware and Sound -> Devices and Printers.

• If you are using Windows 7, select the Start menu -> Devices and Printers.
• If you are using Windows Vista, select the Start menu -> Control Panel -> Hardware and

Sound -> Printers.
• If you are using Windows XP, select the start menu -> Control Panel -> Printers and Other

Hardware -> Printers and Faxes.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

Important
• Opening the printer driver setup window through Printer properties (Windows 8.1, Windows 8,

Windows 7) or Properties (Windows Vista, Windows XP) displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening
through Printing preferences or application software. For tabs regarding Windows functions,
refer to the user's manual for the Windows.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.

Note
• To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup

window and click View Printer Status on the Maintenance tab.
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of
paper or if the ink is low).

In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Maintenance tab, click View Printer Status.
The Canon IJ Status Monitor opens and displays an image of the ink status.

Note
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.
• When you receive a notice about the remaining ink level, a mark appears above the ink icon.

For example: 
Ink tank is running low. Prepare a new ink tank.

3. If necessary, click Ink Details

You can check the ink-related information.

If a warning or error related to the remaining ink amount occurs, a notification icon is displayed at the top
of the image in the Ink Details dialog box.
In such cases, take the appropriate action as described on the screen.

Note
• You can also display the Ink Details dialog box by selecting the ink icon on the Canon IJ Status

Monitor.
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Canon IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

Important
• If you are using the XPS printer driver, see "Editing the Print Document or Reprinting from the Print

History."

Related Topic

Displaying the Print Results before Printing
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon IJ Status Monitor" with "Canon IJ XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the icon of the Canon IJ Status Monitor displayed on the task bar.
The Canon IJ Status Monitor appears.

2. Display the print jobs

Click Display Print Queue.
The print queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

Important
• Users who have not been granted access permission for printer management cannot delete the print

job of another user.

Note
• When you perform this operation, all print jobs are deleted. If the print queue list contained a necessary

print job, start the printing process over from the beginning.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

• Depending on the document type to be printed, the paper feed method specified in the printer driver
may not operate correctly.
If this happens, open the printer driver setup window from the Print dialog box of the application
software, and check the setting in the Paper Source field on the Main tab.

• With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.

• If the selected Language in the About dialog box of the Maintenance tab does not match the
operating system interface language, the printer driver setup window may not be displayed properly.

• Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.

◦ Preview before printing on the Main tab
◦ Prevention of Print Data Loss in the Print Options dialog box on the Page Setup tab
◦ Page Layout, Tiling/Poster, Booklet, Duplex Printing, Specify Margin..., Print from Last

Page, Collate, and Stamp/Background... (Stamp...) on the Page Setup tab
◦ Print a pattern for color adjustment on the Color Adjustment tab in the Manual Color

Adjustment dialog box

• Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

• With some applications, the printing is divided into multiple print jobs.
To cancel printing, delete all divided print jobs.

• If image data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

Note
• Disable ICM required from the application software cannot be used when the XPS printer

driver is used.

• Do not start up the Canon IJ Network Tool while printing.
• Do not print when the Canon IJ Network Tool is running.

Points to Note About Applications with Restrictions

• There are following restrictions in Microsoft Word (Microsoft Corporation).
◦ When Microsoft Word has the same printing functions as the printer driver, use Word to specify

them.
◦ When Fit-to-Page, Scaled, or Page Layout is used for Page Layout on the Page Setup tab of

the printer driver, the document may not print normally in certain versions of Word.
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◦ When Page Size in Word is set to "XXX Enlarge/Reduce", the document may not print normally in
certain versions of Word.
If this happens, follow the procedure below.

1. Open Word's Print dialog box.
2. Open the printer driver setup window, and on the Page Setup tab, set Page Size to the same

paper size that you specified in Word.
3. Set the Page Layout that you want, and then click OK to close the window.
4. Without starting printing, close the Print dialog box.
5. Open Word's Print dialog box again.
6. Open the printer driver setup window and click OK.
7. Start printing.

• If bitmap printing is enabled in Adobe Illustrator (Adobe Systems Incorporated), printing may take time
or some data may not be printed. Print after unchecking the Bitmap Printing check box in the Print
dialog box.
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Printer Driver Description

Quick Setup tab Description

Main tab Description

Page Setup tab Description

Maintenance tab Description

Canon IJ Preview Description

Canon IJ XPS Preview Description

Canon IJ Status Monitor Description

394



Quick Setup tab Description

The Quick Setup tab is for registering commonly used print settings. When you select a registered setting,
the printer automatically switches to the preset items.

Commonly Used Settings
The names and icons of frequently used printing profiles are registered. When you select a printing
profile according to the purpose of the document, settings that match the purpose are applied.
In addition, functions that are thought to be useful for the selected printing profile are displayed in
Additional Features.
You can also change a printing profile and register it under a new name. You can delete the registered
printing profile.
You can rearrange the profiles either by dragging the individual profiles or by holding down the Ctrl key
and pressing the up or down arrow keys.
Standard

These are the factory settings.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Business Document
Select this setting when printing a general document.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Paper Saving
Select this setting to save paper when printing a general document. The 2-on-1 Printing and
Duplex Printing check boxes are checked automatically.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Photo Printing
If you select this setting when printing a photo, the photo paper and photo size generally used are
set.
If Orientation and Copies were set from the application software, those settings have priority.
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Envelope
If you select this setting for printing an envelope, Media Type is set automatically to Envelope. In
the Envelope Size Setting dialog box, select the size of the envelope to be used.

Note
• The combination of the Additional Features that was displayed for the printing profile that had

been selected when the added printing profile was saved is also displayed when that added
printing profile is selected.

Save...
Displays the Save Commonly Used Settings dialog box.
Click this button when you want to save the information that you set on the Quick Setup, Main, and
Page Setup tabs to Commonly Used Settings.

Delete
Deletes a registered printing profile.
Select the name of the setting to be deleted from Commonly Used Settings, and click Delete. When a
confirmation message is displayed, click OK to delete the specified printing profile.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.
Uncheck this check box if you do not want to display a preview.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile

installed on your computer.

Additional Features
Displays the frequently used, convenient functions for the printing profile that you selected for
Commonly Used Settings on the Quick Setup tab.
When you move the mouse pointer near a function that can be changed, a description of that function is
displayed.
To enable a function, check the corresponding check box.
For some functions, you can set detailed settings from the Main and Page Setup tabs.

Important
• Depending on the printing profiles, certain function may be grayed out and you will not be able to

change them.

2-on-1 Printing
Prints two pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

396



4-on-1 Printing
Prints four pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

Duplex Printing
Selects whether to print the document on both sides or one side of a sheet of paper.
To change the staple side or the margins, set the new values from the Page Setup tab.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application
software will be reversed vertically and horizontally.

Color/Intensity Manual Adjustment
Select when you set the Color Correction method and individual settings such as Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast, etc.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
Normally, the paper size is set automatically according to the output paper size setting, and the
document is printed with no scaling.
When you set 2-on-1 Printing or 4-on-1 Printing in Additional Features, you can manually set the
paper size with Page Size on the Page Setup tab.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.
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Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
High

Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.

Paper Source
Select the source from which paper is supplied.
Cassette (Auto Select)

Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.

Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

Important
• Depending on the media type and size, the Paper Source settings that can be selected may differ.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• When the application software that you used to create the document has the same function,

specify the settings on the printer driver. However, if the print results are not acceptable, specify
the function settings on the application software.

Always Print with Current Settings
Prints documents with the current settings starting from the next print execution.
When you select this function and then close the printer driver setup window, the information that you
set on the Quick Setup, Main, and Page Setup tabs are saved and printing with the same settings is
possible starting from the next print execution.

Important
• If you log on with a different user name, the settings that were set when this function was enabled

are not reflected in the print settings.
• If a setting was specified on the application software, it has priority.

Defaults
Restores all the settings you have changed to their default values.
Click this button to return all settings on the Quick Setup, Main, and Page Setup tabs to their default
values (factory settings).

Save Commonly Used Settings dialog box

This dialog box allows you to save the information that you set on the Quick Setup, Main, and Page
Setup tabs and add the information to the Commonly Used Settings list on the Quick Setup tab.
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Name
Enter the name for the printing profile you wish to save.
Up to 255 characters can be entered.
The name appears, with its associated icon, in the Commonly Used Settings list on the Quick
Setup tab.

Options...
Opens the Save Commonly Used Settings dialog box.
Changes the details of printing profile to be saved.

Save Commonly Used Settings dialog box

Select the icons of the printing profiles to be registered to Commonly Used Settings, and change the
items to be saved in the printing profiles.

Icon
Select the icon for the printing profile you wish to save.
The selected icon appears, with its name, in the Commonly Used Settings list on the Quick
Setup tab.

Save the paper size setting
Saves the paper size to the printing profile in Commonly Used Settings.
To apply the saved paper size when the printing profile is selected, check this check box.
If this check box is unchecked, the paper size is not saved, and consequently the paper size setting
is not applied when the printing profile is selected. Instead the printer prints with the paper size
specified with the application software.

Save the orientation setting
Saves the Orientation to the printing profile in Commonly Used Settings.
To apply the saved print orientation when the printing profile is selected, check this check box.
If this check box is unchecked, the print orientation is not saved, and consequently the Orientation
setting is not applied when the printing profile is selected. Instead the printer prints with the print
orientation specified with the application software.

Save the copies setting
Saves the Copies setting to the printing profile in Commonly Used Settings.
To apply the saved copies setting when the printing profile is selected, check this check box.
If this check box is unchecked, the copies setting is not saved, and consequently the Copies
setting is not applied when the printing profile is selected. Instead the printer prints with the copies
setting specified with the application software.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.
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Related Topics

Printing with Easy Setup
Setting a Page Size and Orientation
Setting the Number of Copies and Printing Order
Duplex Printing
Setting Up Envelope Printing
Printing on Postcards
Switching the Paper Source to Match the Purpose
Displaying the Print Results before Printing
Setting Paper Dimensions (Custom Size)
Printing a Color Document in Monochrome
Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Registering a Frequently Used Printing Profile
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Main tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Cassette (Auto Select)

Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.

Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

Important
• Depending on the media type and size, the Paper Source settings that can be selected may differ.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
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Important
• Depending on the Media Type settings, the same print results may be produced even if the Print

Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.

Color/Intensity
Selects color adjustment method.
Auto

Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast, and so on are adjusted
automatically.

Manual
Select when you set the individual settings such as Cyan, Magenta, Yellow, Brightness,
Intensity, and Contrast, etc. and Color Correction method.

Set...
Select Manual for Color/Intensity to enable this button.
In the Manual Color Adjustment dialog box, you can adjust individual color settings such as
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast on the Color Adjustment tab, and
select the Color Correction method on the Matching tab.

Note
• If you want to use an ICC profile to adjust colors, use the Manual Color Adjustment dialog

box to set the profile.

Grayscale Printing
This function converts the data to monochrome data when printing your document.
Check this check box to print a color document in monochrome.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile

installed on your computer.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, Intensity, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted. You can check the color adjustment
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status easily by changing the preview image to one similar to the results to be printed with Sample
Type.

Note
• The graphic is in monochrome when the Grayscale Printing check box is checked.

Sample Type
Selects a preview image displayed on the Color Adjustment tab.
If necessary, select a preview image from Standard, Portrait, Landscape, or Graphics, whichever
is most similar to the print results.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

Important
• When Grayscale Printing is checked on the Main tab, Cyan, Magenta, and Yellow appear

grayed out and are unavailable.

Brightness
Selects the brightness of your print.
You cannot change the levels of pure white and black. However, the brightness of the colors between
white and black can be changed.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Print a pattern for color adjustment
When the color balance or intensity/contrast is changed, the pattern printing function prints a list of
the adjustment results along with the adjustment values.
Select this function when printing a pattern for color adjustment.

Pattern Print preferences...
Check Print a pattern for color adjustment to enable this button.
The Pattern Print dialog box opens and allows you to set pattern printing settings.
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Pattern Print dialog box

Performs the setup for printing of patterns that allow you to check the color balance and intensity/
contrast of documents.

Parameters to Adjust
Select the item to be checked by pattern printing.
Cyan/Magenta/Yellow

Prints a pattern that allows you to check the cyan/magenta/yellow balance.

Important
• When Grayscale Printing is checked on the Main tab, Cyan/Magenta/Yellow appear

grayed out and are unavailable.

Intensity/Contrast
Prints a pattern that allows you to check the intensity/contrast balance.

Printer Paper Size
Selects the paper size to be used for pattern printing.
This setting is linked to Printer Paper Size on the Page Setup tab.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Sets the number of patterns to be printed.
You can select from Largest, Large, and Small. When you select a pattern size, the number of
patterns that can be printed is as follows:

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.
• The setting preview on the Main tab displays an image that allows you to check the overall

layout.

Largest
Cyan/Magenta/Yellow 37
Intensity/Contrast 49

Large
Cyan/Magenta/Yellow 19
Intensity/Contrast 25

Small
Cyan/Magenta/Yellow 7
Intensity/Contrast 9

Color Variation Between Instances
Sets the amount of color change between neighboring patterns.
Select from Large, Medium, and Small. Large produces a large amount of change, and Small
produces a small amount of change.

Note
• Large is about double the size of Medium, and Small is about half the size of Medium.
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Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM (ICC Profile Matching), or None to match the purpose of
the print operation.

Important
• When Grayscale Printing is checked on the Main tab, Color Correction appears grayed out

and is unavailable.

Driver Matching
With Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

Important
• If the application software is set so that ICM is disabled, ICM (ICC Profile Matching) is

unavailable for Color Correction and the printer may not be able to print the image data
properly.

None
Disables color adjustment with the printer driver.

Input Profile
Specifies the input profile to be used when you select ICM (ICC Profile Matching) for Color
Correction.
Standard

The standard printer profile (sRGB), which supports the color space of ICM, is used. This is the
default setting.

Adobe RGB (1998)
The Adobe RGB profile, which supports a wider color space than sRGB, is used.

Important
• Adobe RGB (1998) is not displayed when input profiles of Adobe RGB are not installed.

Note
• In the XPS printer driver, ICM has become ICC Profile Matching.

Related Topics

Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Specifying Color Correction
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
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Printing a Color Document in Monochrome
Displaying the Print Results before Printing
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Page Setup tab Description

The Page Setup tab allows you to determine how a document is to be arranged on the paper. Also, this tab
allows you to set the number of copies and the order of printing. If the application which created the
document has a similar function, set them with the application.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
If you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.
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Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application software will
be reversed vertically and horizontally.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
The default setting is Same as Page Size to perform normal-sized printing.
You can select a printer paper size when you select Fit-to-Page, Scaled, Page Layout, Tiling/Poster,
or Booklet for Page Layout.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Page Layout
Selects the size of the document you want to print and the type of printing.
Normal-size

This is the normal printing method. Select this when you do not specify any page layout.
Automatically reduce large document that the printer cannot output

If the printer cannot print the paper size of a document, the printer can automatically reduce
the size when it prints the document.
Check this check box to reduce the size when printing the document.

Fit-to-Page
This function enables you to automatically enlarge or reduce documents to fit to the paper size
loaded in the printer without changing the paper size you specified in your application software.

Scaled
Documents can be enlarged or reduced to be printed.
Specify the size in Printer Paper Size, or enter the scaling ratio in the Scaling box.
Scaling

Specifies an enlargement or reduction ratio for the document you want to print.

Page Layout
Multiple pages of document can be printed on one sheet of paper.
Specify...

Opens the Page Layout Printing dialog box.
Click this button to set details on page layout printing.

Tiling/Poster
This function enables you to enlarge the image data and divide the enlarged data into several
pages to be printed. You can also glue together these sheets of paper to create large printed
matter, such as a poster.
Specify...

Opens the Tiling/Poster Printing dialog box.
Click this button to set details on tiling/poster printing.

Booklet
The booklet printing function allows you to print data for a booklet. Data is printed on both sides of
the paper. This type of printing ensures that pages can be collated properly, in page number order,
when the printed sheets are folded and stapled at the center.
Specify...

Opens the Booklet Printing dialog box.
Click this button to set details on booklet printing.
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Duplex Printing
Selects whether to print the document automatically on both sides or one side of a sheet of paper.
Check this check box to print the document on both sides.
This function can be used only when Plain Paper is selected for Media Type and one of Normal-size,
Fit-to-Page, Scaled, or Page Layout is selected.
Automatic

Selects whether duplex printing is to be performed automatically or manually.
This check box will be enabled if Booklet is selected from the Page Layout list or the Duplex
Printing check box is checked.
To perform duplex printing automatically, check this check box.
To perform duplex printing manually, uncheck this check box.

Print Area Setup...
Opens the Print Area Setup dialog box in which you can configure the print area for automatic
duplex printing.

Stapling Side
Selects the stapling margin position.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
stapling margin position. Check Stapling Side, and select from the list to change it.

Specify Margin...
Opens the Specify Margin dialog box.
You can specify the width of the margin.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• If the application used to create your document has a similar function, specify the number of copies

with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not need
to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check this check box to group together the pages of each copy when you want to print multiple copies.
Uncheck this check box when you want to print with all pages of the same page number grouped
together.

Important
• When the application software that you used to create the document has the same function, give

priority to the printer driver settings. However, if the print results are not acceptable, specify the
function settings on the application software. When you specify the number of copies and the
printing order with both the application and this printer driver, the number of copies may be
multiplied numbers of the two settings or the specified printing order may not be enabled.

Print Options...
Opens the Print Options dialog box.
Changes detailed printer driver settings for print data that is sent from applications.
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Stamp/Background... (Stamp...)
Opens the Stamp/Background (Stamp) dialog box.
The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light
illustration behind the document data.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and

only the stamp function can be used.

Depending on the type of printer driver you are using and the environment, Stamp and Background
may not be available.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Pages
Specifies the number of document pages to fit on one sheet.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Tiling/Poster Printing dialog box

This dialog box allows you to select the size of the image to be printed. You can also make settings for cut
lines and paste markers which are convenient for pasting together the pages into a poster.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings of the Tiling/Poster Printing dialog box.
You can check what the print result will look like.
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Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create a
larger poster.

Print "Cut/Paste" in margins
Specifies whether to print the words "Cut" and "Paste" in the margins. These words serve as
guidelines for pasting together the pages into a poster.
Check this check box to print the words.

Note
• Depending on the type of printer driver you are using and the environment, this function may not

be available.

Print "Cut/Paste" lines in margins
Specifies whether to print cut lines that serve as guidelines for pasting together the pages into a
poster.
Check this check box to print the cut lines.

Print page range
Specifies the printing range. Select All under normal circumstances.
Select Pages to specify a specific page or range.

Note
• If some of the pages have not been printed well, specify the pages that do not need to be printed

by clicking them in the settings preview of the Page Setup tab. Only the pages shown on the
screen will be printed this time.

Booklet Printing dialog box

This dialog box allows you to set how to bind the document as a booklet. Printing only on one side and
printing a page border, can also be set in this dialog box.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Booklet Printing dialog box.
You can check what the document will look like when printed as a booklet.

Margin for stapling
Specifies which side of the booklet is to be stapled.

Insert blank page
Selects whether to print the document on one side or both sides of the booklet.
Check this check box to print the document on one side of the booklet and select the side to be left
blank from the list.

Margin
Specifies the width of the stapling margin.
The specified width becomes the stapling margin from the center of the sheet.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.
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Print Area Setup dialog box

When you perform duplex printing, the print area of the document becomes slightly narrower than usual.
Therefore when a document that has small margins is printed, the document may not fit on one page.
This dialog box allows you to set whether the page is to be reduced when printed so that the document
fits in one page.

Use normal-size printing
Prints the document pages without reducing them. This is the default setting.

Use reduced printing
Slightly reduces each document page so that it fits on one sheet of paper during printing.
Select this setting when using automatic duplex printing to print a document with small margins.

Specify Margin dialog box

This dialog box allows you to specify the margin width for the side to be stapled. If a document does not fit
on one page, the document is reduced when printed.

Margin
Specifies the width of the stapling margin.
The width of the side specified by Stapling Side becomes the stapling margin.

Print Options dialog box

Makes changes to print data that is sent to the printer.

Depending on the type of printer driver you are using and the environment, this function may not be
available.

Disable ICM required from the application software
Disables the ICM function required from the application software.
When an application software uses Windows ICM to print data, unexpected colors may be produced
or the printing speed may decrease. If these problems occur, checking this check box may resolve
the problems.

Important
• Uncheck this check box under normal circumstances.
• This function does not work when ICM is selected for Color Correction on the Matching tab of

the Manual Color Adjustment dialog box.

Note
• Disable ICM required from the application software tab cannot be used with the XPS printer

driver.

Disable the color profile setting of the application software
Checking this check box disables information in the color profile that was set on the application
software.
When the information in the color profile set on the application software is output to the printer driver,
the print result may contain unexpected colors. If this happens, checking this check box may resolve
the problem.
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Important
• Even when this check box is checked, only some of the information in the color profile is

disabled, and the color profile can still be used for printing.
• Uncheck this check box under normal circumstances.

Disable the paper source setting of the application software
Disables the paper feeding method that is set by the application.
With some applications such as Microsoft Word, the data may be printed with a feeding method that
differs from the printer driver setting. In this case, check this function.

Important
• When this function is enabled, normally the paper feeding method cannot be changed from the

Canon IJ Preview.
However, if you are using the XPS printer driver, you will be able to change the paper feeding
method from the Canon IJ XPS Preview.

Ungroup Papers
Sets the display method of Media Type, Page Size, and Printer Paper Size.
To display the items separately, select the check box.
To display the items as a group, clear the check box.

Do not allow application software to compress print data
Compression of the application software print data is prohibited.
If the print result has missing image data or unintended colors, selecting this check box may improve
the condition.

Important
• Uncheck this check box under normal circumstances.

Note
• Do not allow application software to compress print data tab cannot be used with the XPS

printer driver.

Print after creating print data by page
The print data is created in page units, and printing starts after the processing of one page of print
data is complete.
If a printed document contains unintended results such as streaks, selecting this check box may
improve the results.

Important
• Uncheck this check box under normal circumstances.

Scale images using nearest-neighbor interpolation
When an image is to be enlarged or reduced when printed, the printer uses a simple interpolation
process to enlarge or reduce the image.
If the image data in a printed document is not printed clearly, selecting this check box may improve
the results.

Important
• Uncheck this check box under normal circumstances.
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Note
• Scale images using nearest-neighbor interpolation can be used only with the XPS printer

driver.

Prevention of Print Data Loss
You can reduce the size of the print data that was created with the application software and then print
the data.
Depending on the application software being used, the image data may be cut off or may not be
printed properly. In such cases, select On. If you will not be using this function, select Off.

Important
• When using this function, the print quality may drop depending on the print data.

Unit of Print Data Processing
Selects the processing unit of the print data to be sent to the printer.
Select Recommended under normal circumstances.

Important
• A large amount of memory may be used for certain settings.

Do not change the setting if your computer has a small amount of memory.

Note
• Unit of Print Data Processing tab cannot be used with the XPS printer driver.

Stamp/Background (Stamp...) dialog box

The Stamp/Background (Stamp...) dialog box allows you to print a stamp and/or background over or
behind the document pages. In addition to the pre-registered ones, you can register and use your original
stamp or background.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and

only the stamp function can be used.

Stamp
Stamp printing is a function that prints a stamp over a document.
Check this check box and select a title from the list to print a stamp.

Define Stamp...
Opens the Stamp Settings dialog box.
You can check the details of a selected stamp or save a new stamp.

Place stamp over text
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a stamp over the printed document page. The printed data may be
hidden behind the stamp.
Uncheck this check box to print the document data over the stamp. The printed data will not be
hidden behind the stamp. However, the sections of the stamp that are overlapped by the document
may be hidden.
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Print semitransparent stamp
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a semi-transparent stamp over the printed document page.
Uncheck this check box to print the stamp over the document data. The printed data may be hidden
behind the stamp.

Note
• You can use Print semitransparent stamp only with the XPS printer driver.

Stamp first page only
Selects whether the stamp is to be printed on the first page only or on all pages when the document
has two or more pages.
Check the Stamp check box to enable this.
Check this check box to print a stamp on the first page only.

Background
Background printing is a function that allows you to print an illustration or a similar object (bitmap)
behind the document.
Check this check box to print a background and select a title from the list.

Select Background...
Opens the Background Settings dialog box.
You can register a bitmap as a background, and change layout method and intensity of the selected
background.

Background first page only
Selects whether to print the background on the first page only or print on all pages when the
document has two or more pages.
Check the Background check box to enable this.
Check this check box to print a background on the first page only.

Stamp Tab

The Stamp tab allows you to set the text and bitmap file (.bmp) to be used for a stamp.

Preview Window
Shows the status of the stamp configured in each tab.

Stamp Type
Specifies the stamp type.
Select Text to create a stamp with characters. Select Bitmap to create with a bitmap file. Select
Date/Time/User Name to display the creation date/time and user name of the printed document.
The setting items in the Stamp tab change depending on the selected type.

When Stamp Type is Text or Date/Time/User Name

Stamp Text
Specifies the stamp text string.
Up to 64 characters can be entered.
For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text.

Important
• Stamp Text appears grayed out and is unavailable if Date/Time/User Name is selected.
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TrueType Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Outline
Selects a frame that encloses the stamp text string.
If a large font size is selected for Size, characters may extend outside of the stamp border.

Color/Select Color...
Shows the current color for the stamp.
To select a different color, click Select Color... to open the Color dialog box, and select or create a
color you wish to use as a stamp.

When Stamp Type is Bitmap

File
Specifies the name of the bitmap file to be used as the stamp.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file to be used as a stamp.

Size
Adjusts the size of the bitmap file to be used as a stamp.
Moving the slider to the right increases the size, moving the slider to the left decreases the size.

Transparent white area
Specifies whether to make white-filled areas of the bitmap transparent.
Check this check box to make white-filled areas of the bitmap transparent.

Note
• Click Defaults to set Stamp Type to text, Stamp Text to blank, TrueType Font to Arial, Style to

Regular, Size to 36 points, Outline unchecked, and Color to gray with the RGB values (192, 192,
192).

Placement Tab

The Placement tab allows you to set the position where the stamp is to be printed.

Preview Window
Shows the status of the stamp configured in each tab.

Position
Specifies the stamp position on the page.
Selecting Custom from the list allows you to enter values for the X-Position and Y-Position
coordinates directly.

Orientation
Specifies the angle of rotation for the stamp. The angle can be set by entering the number of
degrees.
Negative values rotate the stamp clockwise.
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Note
• Orientation is enabled only when Text or Date/Time/User Name is selected for Stamp Type

on the Stamp tab.

Note
• Click Defaults to set the stamp position to Center and the orientation to 0.

Save settings Tab

The Save settings tab allows you to register a new stamp or delete an unnecessary stamp.

Title
Enter the title to save the stamp you created.
Up to 64 characters can be entered.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Stamps
Shows a list of saved stamp titles.
Specify a title to display the corresponding stamp in Title.

Save/Save overwrite
Saves the stamp.
Enter a title in Title, and then click this button.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps list, and click this button.

Background Tab

The Background tab allows you to select a bitmap file (.bmp) to be used as a background or determine
how to print the selected background.

Preview Window
Shows the status of the bitmap set on the Background tab.

File
Specifies the name of the bitmap file to be used as the background.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file (.bmp) to be used as the background.

Layout Method
Specifies how the background image is to be placed on the paper.
When Custom is selected, you can set coordinates for X-Position and Y-Position.

Intensity
Adjusts the intensity of the bitmap to be used as a background.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity. To print the background at the original bitmap intensity, move the slider to the rightmost
position.
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Note
• Depending on the type of printer driver you are using and the environment, this function may not be

available.
• Click Defaults to set File to blank, Layout Method to Fill page, and the Intensity slider to the

middle.

Save settings Tab

The Save settings tab allows you to register a new background or delete an unnecessary background.

Title
Enter the title to save the background image you specified.
Up to 64 characters can be entered.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Backgrounds
Shows a list of registered background titles.
Specify a title to display the corresponding background in Title.

Save/Save overwrite
Saves the image data as a background.
After inserting the Title, click this button.

Delete
Deletes an unnecessary background.
Specify the title of an unnecessary background from the Backgrounds list, and then click this
button.
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Maintenance tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.

 Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

 Deep Cleaning
Performs deep cleaning.
Perform deep cleaning when two cleaning attempts do not resolve the print head problem.

Note
• Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Therefore, perform
cleaning only when necessary.

Ink Group
When you click Cleaning or Deep Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.
Click Initial Check Items to display the items that you need to check before you execute cleaning
or deep cleaning.

 Print Head Alignment
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
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Align the print head immediately after installing the print head.
When you click Print Head Alignment, the Start Print Head Alignment dialog box is displayed.

 Nozzle Check
Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, click Cleaning to
clean the print head.
To display a list of items that you should check before printing the nozzle check pattern, click Initial
Check Items.
Print Check Pattern

This function prints a pattern that allows you to check whether the any of the ink nozzles are
clogged.
Click Print Check Pattern. When the confirmation message is displayed, click OK. The Pattern
Check dialog box is then displayed.
Left-side bitmap (good)

The print head nozzles are not clogged.

Right-side bitmap (bad)
The print head nozzles may be clogged.

Exit
Closes the Pattern Check dialog box, and returns to the Maintenance tab.

Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or if a specific color fails to print, even though
all ink levels are sufficiently high.

 Power Off
Turns off the printer from the printer driver.
Perform this function to turn off the printer when you cannot press the ON button (POWER button) on
the printer because the printer is out of your reach.
You must press the ON button (POWER button) on the printer to turn the printer on again after clicking
this button. When you use this function, you will not be able to turn the printer on from the printer driver.

 Auto Power
Opens the Auto Power Settings dialog box.
Specify settings for operating the printer power automatically. Perform this function if you want to
change the auto power settings.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an error

message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.
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 Quiet Settings
Opens the Quiet Settings dialog box.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
This mode comes in handy when the operating noise of the printer becomes a concern, such when
printing at night. Perform this operation when you want to change the quiet mode setting.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an error

message may appear because the computer cannot collect the printer status.

 Custom Settings
Opens the Custom Settings dialog box.
Perform this function to change the settings of this printer.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an error

message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

View Print History
This function starts the Canon IJ XPS preview, and displays the print history.

Note
• You can use this function only with the XPS printer driver.

View Printer Status
Starts the Canon IJ Status Monitor.
Perform this function when you want to check the printer status and how a print job is proceeding.

Note
• If you are using the XPS printer driver, the "Canon IJ Status Monitor" becomes the "Canon IJ XPS

Status Monitor".

About
Opens the About dialog box.
The version of the printer driver, plus a copyright notice, can be checked.
In addition, the language to be used can be switched.

Initial Check Items

Before running Cleaning or Deep Cleaning, check that the printer power is on, and open the cover of the
printer.
Check the following items for each ink.

• Check the amount of ink remaining in the tank.
• Make sure that you push in the ink tank completely until you hear a clicking sound.
• If an orange tape is adhered to the ink tank, peel it off completely.

Any remaining tape will hinder ink output.
• Check that the ink tanks are installed in their correct positions.
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Start Print Head Alignment dialog box

This dialog box allows you to adjust the attachment position for the print head, or to print the current
setting value for the print head position.

Align Print Head
Aligns the print head.
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.

Print Alignment Value
Click this button to check the current setting value of the print head position.
Prints the current setting value for the print head position.

Print Head Alignment dialog box

To adjust the print head position manually, click Align Print Head in the Start Print Head Alignment
dialog box, and perform the operations instructed in the messages. The Print Head Alignment dialog
box is then displayed.
This dialog box allows you to check the printed pattern and adjust the print head position.

Preview Window
Displays the pattern of Print Head Alignment, and checks the position of the selected pattern.
You can also change the setting by clicking the pattern on the screen directly.

Select the Pattern Number
Compare the printed adjustment patterns, and enter the pattern number of the pattern with the
least visible streaks or horizontal stripes into the corresponding box.

Note
• If you do not know how to analyze the printed pattern, see Aligning the Print Head Position from

Your Computer.

Initial Check Items

Before running Nozzle Check, check that the printer power is on, and open the cover of the printer.
Check the following items for each ink.

• Check the amount of ink remaining in the tank.
• Make sure that you push in the ink tank completely until you hear a clicking sound.
• If an orange tape is adhered to the ink tank, peel it off completely.

Any remaining tape will hinder ink output.
• Check that the ink tanks are installed in their correct positions.

Auto Power Settings dialog box

When you click Auto Power, the Auto Power Settings dialog box is displayed.
This dialog box allows you to manage the printer power from the printer driver.

Auto Power On
Selects the auto power-on setting.
Specify Disable to prevent the printer from turning on automatically when print data is sent to it.
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Make sure the printer is on and then click OK to change the printer settings.
Specify Enable to turn the printer on automatically when print data is sent to it.

Auto Power Off
Selects the auto power-off setting.
If a printer driver operation or a printer operation is not performed within the specified time, the printer
turns off.

Quiet Settings dialog box

When you click Quiet Settings, the Quiet Settings dialog box is displayed.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
Select when you wish to reduce the operating noise of the printer at night, etc.
Using this function may lower the print speed.

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified period
of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to the
same time, the quiet mode will not function.

Important
• You can set the quiet mode from the printer or the printer driver.

No matter how you use to set the quiet mode, the mode is applied when you perform operations
from the printer or printing from the computer.

Custom Settings dialog box

When you click Custom Settings, the Custom Settings dialog box is displayed.
If necessary, switch between various modes of printer operation.

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density printing to
prevent paper abrasion.
Check this check box to enable this function.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head
alignment.
Check this check box to perform the manual head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the document 90 degrees to the left when printing, select the check box.
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Don't detect mismatch of paper settings when printing from computer
When you print documents from your computer and the paper settings on the printer driver and the
cassette paper information registered on the printer do not match, this setting disables the message
display and allows you to continue printing.
To disable detection of paper setting mismatches, select this check box.

Ink Drying Wait Time
The printer can pause before printing a subsequent page. Moving the slider to the right increases the
pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries,
increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

About dialog box

When you click About, the About dialog box is displayed.
This dialog box displays the version, copyright, and module list of the printer driver. You can select the
language to be used and switch the language displayed in the setup window.

Modules
Lists the printer driver modules.

Language
Specifies the language you wish to use in the printer driver setup window.

Important
• If the font for displaying the language of your choice is not installed in your system, the

characters will be garbled.

Related Topics

Cleaning the Print Heads from Your Computer
Aligning the Print Head Position from Your Computer
Use Your Computer to Print a Nozzle Check Pattern
Managing the Printer Power
Reducing the Printer Noise
Changing the Printer Operation Mode
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Canon IJ Preview Description

Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.
The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.
When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

File Menu
Selects the print operation.
Start Printing

Ends the Canon IJ Preview and then starts printing the document that is displayed on the preview
screen.
This command has the same function as the Start Printing on the toolbar.

Cancel Printing
Ends the Canon IJ Preview and cancels the printing of the document that is displayed on the
preview screen.
This command has the same function as the Cancel Printing on the toolbar.

Exit
Ends the Canon IJ Preview.

Page Menu
This menu includes the following commands to select page to be displayed.
All of these commands except Page Selection... can also be selected from the toolbar.

Note
• If the pages are being spooled, the last spooled page becomes the last page.
• If the Page Layout setting on the Page Setup tab is specified to Page Layout, Tiling/Poster, or

Booklet, the number of pages is the number of sheets to be used for printing, and not the number
of pages in the original document created with the application software.
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• If duplex printing manually has been set, the front pages which will be printed first are all displayed
together, and then the back pages are displayed.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole

Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
This menu includes the following command:
Displays Print Page Information

Displays print setup information (including printer paper size, media type, and page layout) for each
page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

Help Menu
When you select this menu item, the Help window for Canon IJ Preview is displayed, and you can
check the version and copyright information.
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Start Printing button
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

Cancel Printing button
Ends the Canon IJ Preview, and cancels the printing of the document that is displayed on the preview
screen.
You can click this button while spooling.

Print Page Information Screen
Displays print setup information for each page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

Important
• If the media type and paper source are set from the application software, those settings have

priority and the changed settings may become ineffective.

Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
You can select the media type of the document to be printed.

Paper Source
You can select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Canon IJ XPS Preview Description

Canon IJ XPS Preview is an application software that displays what the print result will look like before a
document is actually printed.
The preview reflects the information which is set within the printer driver and allows you to check the
document layout, print order, and number of pages. The preview also allows you to edit the print document,
edit the print pages, change the print settings, and perform other functions.
When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile installed

on your computer.

File Menu
Selects print operation and print history settings:
Print

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

This command has the same function as  (Print) on the toolbar and the Print in the print
settings area.

Print All Documents
Prints all documents in the document list and closes the Canon IJ XPS Preview.

Save Print History
Switches whether the documents printed from the Canon IJ XPS Preview are to be saved as print
history entries.

History Entry Limit
Switches the maximum number of print history registrations.
Select 10 Entries, 30 Entries, or 100 Entries.
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Important
• If the limit on the number of registration is exceeded, the print history registrations are deleted

starting from the oldest one.

Add documents from history to the list
Adds the document saved in the print history to the document list.

Exit
Ends the Canon IJ XPS Preview. The documents remaining in the document list will be deleted
from the list.
This command has the same function as the Exit in the print settings area.

Edit Menu
Selects the method for editing multiple documents or pages.
Undo

Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.
This command has the same function as the (Undo) on the toolbar.

Documents
Selects the method for editing print documents.
Combine Documents

Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

This command has the same function as the (Combine Documents) on the toolbar.

Reset Documents
Returns the document selected in the document list to their status before they were added to
the Canon IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

This command has the same function as the (Reset Documents) on the toolbar.

Move Document
Use the following command to change the order of the documents selected in the document
list.

Move to First
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Up One
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Down One
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Move to Last
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.
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Delete Document
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be
selected.

This command has the same function as the (Delete Document) on the toolbar.

Grayscale Printing
Allows you to change the monochrome print settings.
This command has the same functionality as the Grayscale Printing check box in the print
settings area.

Page Layout Printing...
Opens the Page Layout Printing dialog box.
This dialog box allows you to set Page Layout Printing, Pages, Page Order, and Page
Border.

Duplex Printing...
Opens the Duplex Printing dialog box.
This dialog box allows you to set Duplex Printing, Automatic, Stapling Side, and Margin.

Copies...
Opens the Copies dialog box.
This dialog box allows you to set Copies, Collate, and Print from Last Page.

Pages
Selects the method for editing print pages.
Delete Page

Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

This command has the same function as the (Delete Page) on the toolbar.

Restore Page
Restores pages that were deleted with the Delete Page function.
To restore pages, you must select the View Deleted Pages check box on the Option menu
and display the deleted pages as thumbnails.

Move Page
Use the following command to change the order of the currently selected pages.

Move to First
Moves the currently selected page to the beginning of the document.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Forward One
Moves the currently selected page one position in front of its current position.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Backward One
Moves the currently selected page one position after its current position.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.
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Move to Last
Moves the currently selected page to the end of the document.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

View Menu
Selects the documents and pages to be displayed.
Documents

Use the following command to select the document to display.
First Document

Displays the first document in the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Previous Document
Displays the document located before the currently displayed document.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Next Document
Displays the document located after the currently displayed document.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Last Document
Displays the last document in the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Pages
Use the following command to select the page to be displayed.

Note
• If the Page Layout setting in the printer driver is specified to Tiling/Poster, or Booklet, the

number of pages is the number of sheets to be used for printing, and not the number of pages
in the original document created with the application software.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

431



Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole

Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
Toggles the show / hide status of the following information.
View Thumbnails

Reduces all pages in the document selected in the document list and displays them at the bottom
of the preview window.

This command has the same function as the (View Thumbnails) on the toolbar.

View Document List
Displays the print document list at the top of the preview window.

View Print Settings Area
Displays the print settings area at the right side of the preview window.

View Deleted Pages
When the thumbnails are displayed, this function displays pages that were deleted with the Delete
Page function.
To check deleted pages, you must first select the View Thumbnails check box.

Keep printed documents on the list
Leaves the printed document in the document list.

Print Settings Displayed at Startup
Switches the tab of the print settings area to be displayed when the Canon IJ XPS Preview is
started.
Select Page Information, Layout, or Manual Color Adjustment.

Help Menu
When you select this menu item, the Help window for Canon IJ XPS Preview is displayed, and you can
check the version and copyright information.

(Print)
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.
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(Combine Documents)
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

(Delete Document)
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be selected.

(Reset Documents)
Returns the document selected in the document list to their status before they were added to the Canon
IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

(View Thumbnails)
Reduces all pages in the document selected in the document list and displays them at the bottom of the
preview window.
To hide the print pages, click View Thumbnails again.

(Move to First)
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

(Move Up One)
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

(Move Down One)
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

(Move to Last)
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

(Undo)
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.

(Delete Page)
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

Document list
Displays the list of the print documents.
The document selected in the document list becomes the target for preview display and editing.
Document Name

Displays the name of the print document.
If you click the name of the selected print document, a text box is displayed, and you can rename
the document to any name.
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Pages
Displays the number of pages in the print document.

Important
• The number displayed in Pages and the output page count are different.
• To check the output page count, check the status bar at the bottom of the preview window.

Status
Displays the status of the print documents.
Documents that are undergoing data processing are displayed as Processing data.

Important
• Documents showing Processing data cannot be printed or edited.

Wait until the data processing ends.

Print Settings Area Screen
Allows you to check and change the print settings of the documents selected in the document list.
Print Settings Area is displayed on the right side of the preview window.
Page Information tab

The print settings are displayed for each page.
You can change the media type and paper source settings.
Printer Paper Size

Displays the paper size of the document to be printed.

Media Type
Allows you to select the media type of the document to be printed.

Paper Source
Allows you to select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.

Layout tab
You can specify settings for page layout printing.
To apply the specified settings, click Apply.
If the page layout print settings cannot be changed for the print document, the individual items are
grayed out and cannot be selected.

Manual Color Adjustment tab
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast options.
Cyan/Magenta/Yellow

Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a
color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document.
Use your application software if you want to change the total color balance significantly. Use
the printer driver only if you want to adjust the color balance slightly.
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Important
• When Grayscale Printing is checked, Cyan, Magenta, and Yellow appear grayed out

and are unavailable.

Brightness
Selects the brightness of your print.
Pure white and black will not change, but colors between white and black will change.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left
decreases the intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on this tab to their default values (factory settings).

Grayscale Printing
Allows you to change the monochrome print settings.

Duplex Printing
Selects whether to print the document on both sides or one side of a sheet of paper.
If the duplex print settings cannot be changed for the print document, this item is grayed out and is
unavailable.

Important
• When you select Booklet for Page Layout, Duplex Printing of the print settings area will be

set automatically. In this case, Duplex Printing is grayed out and is unavailable.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
If the numbers of copies cannot be changed for the print document, this item is grayed out and is
unavailable.

Exit
Ends the Canon IJ XPS Preview.
The documents remaining in the document list will be deleted from the list.

Print
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.
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Canon IJ Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.

Canon IJ Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.

 : Indicates that a warning (operator call error) has occurred or the printer is working.
 : There has been an error which requires a service.

Ink Tank
Canon IJ Status Monitor shows an icon when a low ink warning or a no ink error occurs.
In addition, this function displays graphics showing the estimated ink levels of the ink tank.
In this case, click the graphics to open the Ink Details dialog box. You can check the detail
information such as the remaining ink level and the ink tank types for your printer.

Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.
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Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.

Cancel Printing
Cancels the current print job.

Important
• The Cancel Printing button is enabled only while print data is being sent to the printer.

Once the print data has been sent, the button is grayed out and becomes unavailable.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon IJ
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job

Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Guide Message
Displays the guide for operations in which how to set paper is complicated.
Envelope Printing

Displays the guide message when envelope printing starts.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Envelope Printing on the Display Guide
Message in the Option menu and enable this setting.

Hagaki Printing
Displays the guide message before the printer begins hagaki printing.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Hagaki Printing on the Display Guide
Message in the Option menu and enable this setting.

Display Warning Automatically
When a Low Ink Warning Occurs

Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Ink Details Menu
Select this menu to display the Ink Details dialog box. Check the detail information such as the
remaining ink level and the ink tank types for your printer.
Ink Details dialog box

This function displays graphics and messages showing the ink tank type and the estimated
ink levels.
Ink Information (displayed at left)

Shows the ink tank types with graphics.
If a warning or error related to the remaining ink level occurs, the printer driver displays
an icon to let you know.
If the icon is displayed, operate the printer according to the instructions displayed on the
screen.
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Message (displayed at right)
Shows information such as the ink status and ink colors with sentences.

Ink Model Number
Shows the ink tank types for your printer.

Close
Closes the Ink Details dialog box to return to Canon IJ Status Monitor.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and
you can check the version and copyright information.
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Updating the Printer Driver

Obtaining the Latest Printer Driver

Deleting the Unnecessary Printer Driver

Before Installing the Printer Driver

Installing the Printer Driver
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Maintenance tab.

You can access our website and download the latest printer driver for your model.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Before Installing the Printer Driver
Installing the Printer Driver
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Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

• If you are using Windows 8.1 or Windows 8, from the Desktop charms, select Settings -> Control
Panel -> Programs -> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows 7 or Windows Vista, select Start menu -> Control Panel -> Programs -
> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows XP, select Start menu -> Control Panel -> Add or Remove Programs.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Remove.

The confirmation window for uninstalling the model appears.

Important
• In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box

may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.

Important
• Printer driver and XPS printer driver will be deleted when you uninstall the Printer Driver.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

Checking the Printer Status

• Turn off the printer.

Checking the Personal Computer Settings

• Terminate all running applications.
• Log on as a user who has the administrator account.

Important
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Obtaining the Latest Printer Driver
Installing the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver and XPS printer
driver for your model.

The procedure for installing the downloaded printer driver is as follows:

1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

Important
• In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box

may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation

Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

Important
• You can install the XPS printer driver with the same procedure for installing the printer driver. However,

when installing the XPS printer driver, first complete installation of the printer driver.
• You can download the printer driver and XPS printer driver for free, but any Internet access charges

incurred are your responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Obtaining the Latest Printer Driver
Deleting the Unnecessary Printer Driver
Before Installing the Printer Driver
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Paper setting for Printing

By registering the paper size and the media type loaded in the cassette, you can prevent the printer from
misprinting by displaying the message before printing starts when the paper size or the media type of the
loaded paper differs from the print settings.

• When you load paper in the cassette:

The screen to register the cassette paper information is displayed.

Press the OK button, then register the paper size and the media type according to the loaded paper.

Important
• For details on the proper combination of paper settings you can specify by the printer driver or on

the LCD:

Setting the Media Type with the Printer Driver and on the Printer

Setting the Paper Size with the Printer Driver and on the Printer

• When the paper settings for printing are different from the cassette paper information registered
to the printer:

Ex:

◦ Paper setting for printing: B5

◦ Cassette paper information registered to the printer: A4
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When you start printing, a message is displayed.

Confirm the message, then press the OK button. When the screen to select the operation is displayed,
select one of the operations below.

Note
• Depending on the setting, the choices below may not be displayed.

Use cass. settings
Select if you want to print on the paper loaded in the cassette without changing the paper settings.

For example, when the paper setting for printing is B5 and the cassette paper information registered
to the printer is A4, the printer starts printing with B5 on the paper loaded in the cassette.

Replace the paper
Select if you want to print after replacing the paper of the cassette.

For example, when the paper setting for printing is B5 and the cassette paper information registered
to the printer is A4, you load B5 sized paper in the cassette before you start printing.

The cassette paper information registration screen is displayed after replacing the paper and
inserting the cassette. Register the cassette paper information according to the paper you loaded in
the cassette.

Note
• If you do not know what paper information to register to the printer, press the Back button

when the screen to select the operation is displayed. When the previous screen is displayed,
confirm the paper size and the media type, then register them to the printer.

• For details on the proper combination of paper settings you can specify by the printer driver or
on the LCD:

Setting the Media Type with the Printer Driver and on the Printer

Setting the Paper Size with the Printer Driver and on the Printer

Cancel printing
Cancels printing.

Select when you change the paper settings specified for printing. Change the paper settings, then
try printing again.

Note
• You can disable the message which prevents misprinting. When you disable the message, the

printer starts printing even though the paper settings for printing and the cassette paper information
registered to the printer are different.

• To change the setting using the operation panel:

Cassette settings

• To change the setting using the printer driver:

Changing the Printer Operation Mode
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Troubleshooting

The Printer Cannot Be Powered On

Printing Does Not Start

Paper Does Not Feed Properly/"No Paper" Error Occurs

Print Results Not Satisfactory

Ink Is Not Ejected

Paper Jams

If an Error Occurs

Search Each Function

Problems with Network Communication

Problems with Printing

Problems with Printing Quality

Problems with the Printer

Problems with Installation/Downloading

About Errors/Messages Displayed

If You Cannot Resolve the Problem
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Problems with Network Communication

Problems with the Printer While Using with Network

Cannot Detect a Printer on a Network

Other Problems with Network
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Problems with the Printer While Using with Network

The Printer Stopped Working Suddenly

Ink Remaining Level Is Not Displayed on Printer Status Monitor of the Printer

Printing Speed Is Slow

Cannot Use the Printer on Replacing an Access Point or Changing Its settings
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The Printer Stopped Working Suddenly

Cannot Communicate with the Printer After the Network Settings Are Changed

Cannot Communicate with the Printer over the Wireless LAN

Cannot Communicate with the Printer Using the Access Point Mode

Cannot Communicate with the Printer over the Wired LAN

Cannot Print from a Computer Connected to the Network

Cannot Communicate with the Printer After the Network Settings Are
Changed

It may take a while for the computer to obtain the IP address, or you may need to restart your computer.

Search for the printer again after confirming a valid IP address is assigned to the computer.

Cannot Communicate with the Printer over the Wireless LAN

Check1  Make sure that the printer is turned on.

Check2  Make sure that the network settings in the printer are identical with those of
the access point.

Refer to the instruction manual provided with the access point or contact its manufacturer to check the access
point settings, and then modify the printer settings.

How to Set an Encryption Key

Check3  Make sure that the printer is not placed far away from the access point.

The access point is located indoors within the effective range for wireless communication. Locate the printer
within 164 ft. / 50 m from the access point.

Check4  Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

Check5  Make sure that there is no source of radio wave interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed
nearby, the device may cause interference. Place the wireless station as far away from the interference source
as possible.

Check6  Make sure that the network settings of the computer are correct.
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For the procedures to connect a network device to the computer and set them up, refer to the instruction
manual of your network device or contact its manufacturer.

Check7  Make sure that the radio status is good and adjust the installation positions
while monitoring the radio status with IJ Network Tool.

Monitoring Wireless Network Status

Check8  Make sure that a valid wireless channel is used.

The wireless channel to be used may be limited depending on wireless network devices installed in the
computer. Refer to the instruction manual provided with your computer or your wireless network device to
specify the valid wireless channel.

Check9  Make sure that the channel confirmed in Check 8 can communicate with the
computer.

If not, change the channel set to the access point.

Check10  Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning that Canon
software is attempting to access the network. If the warning message appears, set the security software to
always allow access.

If using any programs that switch the network environment, check their settings. Some programs will enable a
firewall by default.

Check11  When using a router, connect the printer and computer to the LAN side
(same network segment).

If the problem is not resolved, perform setup again with the Setup CD-ROM or perform it according to the
instructions on our website.

• For placement:

Make sure that there is no barrier or obstacle between the access point and the printer.

Note
• When you connect the printer to a Windows XP computer by cableless setup:

Follow the procedure below to perform settings of the printer and the computer.

1. Enable the access point mode of the printer.

2. Right-click the Wireless Network Connections icon on the notification area on the desktop,
then click View Available Wireless Networks.

3. Select the network name on the screen displayed, then click Connect.

Select "XXXXXX-iBXXXXseries" ("XX" represents alphanumeric characters.) as the network
name.

4. Enter the network key on the screen displayed, then click Connect.

As a default, the serial number of the printer is used as a network key. Confirm the serial number
on the rear of the printer.

5. Perform setup with the Setup CD-ROM or perform it according to the instructions on our website.
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Cannot Communicate with the Printer Using the Access Point Mode

Check1  Make sure that the printer is turned on.

Check2  Is Change LAN in LAN settings under Device settings set to LAN inactive,
Wireless LAN active, or Wired LAN active?

Select AP mode active.

Check3  Is the printer selected to connect external communication devices (e.g.
computers, smartphones, or tablets)?

Select an access point name (SSID) specified for the printer as a destination for external communication
devices.

Check4  Enter a password if you specify it for the printer.

Check5  Make sure that external communication devices are not placed far away from
the printer.

Do not locate external communication devices too far away from the printer.

Check6  Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

Check7  Make sure that there is no source of radio wave interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed
nearby, the device may cause interference. Place the wireless station as far away from the interference source
as possible.

Check8  Are you trying to connect 6 devices or more?

You can connect up to 5 devices using the access point mode.

Cannot Communicate with the Printer over the Wired LAN

Check1  Make sure that the printer is turned on.

Check2  Make sure that the LAN cable is connected properly.

Make sure that the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.
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If the problem is not resolved, perform setup again with the Setup CD-ROM or perform it according to the
instructions on our website.

Cannot Print from a Computer Connected to the Network

Check1  Make sure that the network settings of the computer are correct.

For the procedures to set up the computer, refer to the instruction manual of your computer or contact its
manufacturer.

Check2  If the printer driver is not installed, install it.

Install the printer driver with the Setup CD-ROM or install it from our website.

Check3  When using wireless LAN, make sure that access control is not set to the
access point.

For the procedures to connect an access point and set it up, refer to the instruction manual of your access
point or contact its manufacturer.

Note
• To check the MAC address or the IP address of the computer, see Checking the IP Address or the MAC

Address of the Computer.
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Ink Remaining Level Is Not Displayed on Printer Status Monitor of
the Printer

Use the printer driver with bidirectional communication.

Select Enable bidirectional support in the Ports sheet of the properties dialog box of the printer driver.

How to Open the Printer Driver Setup Window
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Printing Speed Is Slow

Check1  The printer may be printing out a large job issued from another computer.

Check2  When using wireless LAN, make sure that the radio status is good and adjust
the installation positions while monitoring the radio status with IJ Network Tool.

Monitoring Wireless Network Status

Make sure that there is no barrier or obstacle between the access point and the printer. Wireless communication
between different rooms or floors is generally poor. The metal, concrete, or timber including the metallic material,
mud wall, or insulator may interrupt a wireless communication. If the printer cannot communicate with the
computer over a wireless LAN for the wall material, place the printer and the computer in the same room or floor.

Check3  Make sure that there is no source of interference in your vicinity.

If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed nearby,
the device may cause interference. Place the wireless station as far away from the interference source as
possible.
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Cannot Use the Printer on Replacing an Access Point or Changing
Its settings

When you replace an access point, perform network setup of the printer again.

Perform network setup again with the Setup CD-ROM or perform it again according to the instructions on
our website.

If the problem is not resolved, see below.

Cannot Communicate with the Printer After Applying MAC/IP Address Filtering or Entering an Encryption
Key to the Access Point

When Encryption Is Enabled, Cannot Communicate With the Printer After the Encryption Type Was
Switched on the Access Point

Cannot Communicate with the Printer After Applying MAC/IP Address
Filtering or Entering an Encryption Key to the Access Point

Check1  Confirm the access point setting.

Refer to the instruction manual provided with the access point or contact its manufacturer to confirm the
access point setting. Make sure that the computer and the access point can communicate with each other
under this setting.

Check2  If you are performing MAC address filtering or IP address filtering at the
access point, confirm that the MAC address or IP address for both the computer or the
network device and the printer are registered.

Check3  If you are using a WEP or WPA/WPA2 key, make sure that the encryption
key for the computer or the network device and the printer matches that set to the
access point.

Besides the WEP key itself, the key length, key format, the key ID to use, and the authentication method must
match among the printer, the access point, and the computer.

Normally, select Auto for the authentication method. If you want to specify the method manually, select Open
System or Shared Key according to the setting of the access point.

How to Set an Encryption Key
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When Encryption Is Enabled, Cannot Communicate With the Printer
After the Encryption Type Was Switched on the Access Point

If the printer cannot communicate with the computer after the encryption type of the printer was switched,
make sure that encryption types for the computer and the access point matches that set to the printer.

Cannot Communicate with the Printer After Applying MAC/IP Address Filtering or Entering an
Encryption Key to the Access Point
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Cannot Detect a Printer on a Network

Cannot Detect the Printer When Setting up Network Communication

The Printer Cannot Be Detected in the Wireless LAN

The Printer Cannot Be Detected in the Wired LAN

Note
• You cannot use the wireless LAN and the wired LAN at the same time.
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Cannot Detect the Printer When Setting up Network
Communication

If the printer could not be detected on the network when setting up the network communication, confirm the
network settings before redetecting the printer.

Cannot Detect the Printer during Wireless LAN Setup: Check 1

Cannot Detect the Printer during Wired LAN Setup: Check 1

Important
• If the printer cannot be detected while you are setting up the network communication using a USB

cable, the printer may be in the access point mode. In this case, finish the access point mode and
enable the wireless LAN, then try to redetect the printer.

Using the Printer with the Access Point Mode
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Cannot Detect the Printer during Wireless LAN Setup: Check 1

Are the printer and network device (router, access point, etc.) turned on?

Make sure that the printer is turned on.

Confirming that the Power Is On

Make sure that the network device (router, access point, etc.) is turned on.

If the printer or the network device is turned off:

Turn on the printer or the network device.

After turning on the printer or the network device, it may take some time until ready for use. After a while
just turning on the printer or the network device, click Redetect on the Check Printer Settings screen.

When the printer is detected, follow the instructions on the screen to continue to set up the network
communication.

If the printer and the network device are turned on:

If the printer could not be detected after clicking Redetect even when the printer and the network device
are turned on, or when you have turned them on, go to check 2.

Cannot Detect the Printer during Wireless LAN Setup: Check 2
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Cannot Detect the Printer during Wireless LAN Setup: Check 2

Is the wireless LAN setting of the printer enabled?

Make sure that the  or  icon is displayed on the LCD.

If the icon is not displayed:

The wireless LAN setting of the printer is disabled. Enable the wireless LAN setting of the printer.

After enabling the wireless LAN setting, click Back to Top on the Check Printer Settings screen to try to
set up the network communication from the beginning.

If the icon is displayed:

Go to check 3.

Cannot Detect the Printer during Wireless LAN Setup: Check 3
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Cannot Detect the Printer during Wireless LAN Setup: Check 3

Is the printer connected to the access point?

By using the icon on the LCD, make sure that the printer is connected to the access point.

If the  icon is displayed:

The printer may be placed far away from the access point. Place the printer near the access point
temporarily, then click Redetect on the Check Printer Settings screen.

When the printer is detected, follow the instructions on the screen to continue to set up the network
communication.

If the printer cannot be detected, the printer is not connected to the access point. Connect the printer to
the access point.

Click Back to Top on the Check Printer Settings screen to try to set up the network communication from
the beginning.

If the  icon is displayed:

Go to check 4.

Cannot Detect the Printer during Wireless LAN Setup: Check 4
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Cannot Detect the Printer during Wireless LAN Setup: Check 4

Does the firewall function of your security software or operation system for
computer interfere with setting up the network communication?

The firewall function of your security software or operation system for computer may limit communications
between the printer and your computer. Confirm the setting of firewall function of your security software or
operation system or the message appearing on your computer.

If the firewall function interferes with setting up:

• When the message appears on your computer:

If the message warning that Canon software is attempting to access the network appears on the
computer, set the security software to allow access.

• When the message does not appear on your computer:

Cancel to set up, then set the security software to allow Canon software* to access the network.

* On the Setup CD-ROM, select win > Driver > DrvSetup, then set the security software to allow the
file Setup.exe or Setup64.exe to access the network.

After setting the security software, try to set up the network communication from the beginning.

Note
• For the operation system firewall settings or the security software firewall settings, refer to the

instruction manual of the computer or software, or contact its manufacturer.

If there is no problem with the firewall settings:

Go to check 5.

Cannot Detect the Printer during Wireless LAN Setup: Check 5
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Cannot Detect the Printer during Wireless LAN Setup: Check 5

Check the settings of the access point.

Check the settings of the access point for the network connection such as IP address filtering, MAC
address filtering, or DHCP function.

Make sure that the radio channel of the access point and that assigned to the printer are the same.

For details on how to check the settings of the access point, refer to the instruction manual supplied with
the access point or contact its manufacturer.
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Cannot Detect the Printer during Wired LAN Setup: Check 1

Is the LAN cable connected, and are the printer and the router turned on?

Make sure that the LAN cable is connected.

Make sure that the printer is turned on.

Confirming that the Power Is On

Make sure that the router is turned on.

If the LAN cable is connected and the printer or the network device is
turned off:

Turn on the printer or the network device.

After turning on the printer or the network device, it may take some time until ready for use. After a while
just turning on the printer or the network device, click Redetect on the Check Printer Settings screen.

When the printer is detected, follow the instructions on the screen to continue to set up the network
communication.

If the LAN cable is connected and the printer and the network device are
turned on:

If the printer could not be detected after clicking Redetect even when the printer and the network device
are turned on, or when you have turned them on, go to check 2.

Cannot Detect the Printer during Wired LAN Setup: Check 2
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Cannot Detect the Printer during Wired LAN Setup: Check 2

Are the computer and the router configured and can the computer connect
to the network?

Make sure that you can view web pages on your computer.

If you cannot view any web pages:

Click Cancel on the Check Printer Settings screen to cancel to set up the network communication. After
that, configure the computer and network device.

For the procedures, refer to the instruction manuals supplied with the computer and network device, or
contact their manufacturers.

If you can view web pages after configuring the computer and network device, try to set up the network
communication from the beginning.

If you can view web pages:

Go to check 3.

Cannot Detect the Printer during Wired LAN Setup: Check 3
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Cannot Detect the Printer during Wired LAN Setup: Check 3

Enable the wired LAN setting of the printer.

Press the Setup button, then select Device settings and LAN settings in this order, then select Wired
LAN active for Change LAN.

The  icon is displayed on the LCD.
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The Printer Cannot Be Detected in the Wireless LAN

Check1  Make sure that the printer is turned on.

Check2  Is Change LAN in LAN settings under Device settings set to LAN inactive?

Check3  When the printer is connected to the computer temporarily using a USB cable,
make sure that the USB cable is connected properly.

When you set up the wireless LAN connection or change the wireless LAN settings using IJ Network Tool
through USB connection, make sure that the printer is connected to the computer with a USB cable securely.

Connecting the Printer to the Computer Using a USB Cable

Check4  Make sure that the printer setup is completed.

If not, perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

Check5  When using IJ Network Tool, click Update to search for the printer again.

Canon IJ Network Tool Screen

Check6  When searching for a printer over a network, make sure that the printer is
associated with the port.

When No Driver is displayed under Name in IJ Network Tool, there is no association. Select Associate Port on
the Settings menu, then associate the port with the printer.

When the Printer Driver Is Not Associated with a Port

Check7  Make sure that the network settings in the printer are identical with those of the
access point.

Refer to the instruction manual provided with the access point or contact its manufacturer to check the access
point settings, and then modify the printer settings.

How to Set an Encryption Key

Check8  Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the location of the devices.

Check9  Make sure that the printer is not placed far away from the access point.

The access point is located indoors within the effective range for wireless communication. Locate the printer
within 164 ft. / 50 m from the access point.

Check10  Make sure that there is no source of radio wave interference in your vicinity.
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If a device (e.g. microwave oven) using the same frequency bandwidth as the wireless station is placed nearby,
the device may cause interference. Place the wireless station as far away from the interference source as
possible.

Check11  Make sure that the network settings of the computer are correct.

Make sure that the computer can communicate with the access point over the wireless LAN.

Check12  Make sure that Enable bidirectional support is selected in the Ports sheet of
the properties dialog box of the printer driver.

Check13  Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning that Canon
software is attempting to access the network. If the warning message appears, set the security software to
always allow access.

If using any programs that switch the network environment, check their settings. Some programs will enable a
firewall by default.

Check14  When using a router, connect the printer and computer to the LAN side (same
network segment).

If the problem is not resolved, perform setup again with the Setup CD-ROM or perform it according to the
instructions on our website.
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The Printer Cannot Be Detected in the Wired LAN

Check1  Make sure that the printer is turned on.

Check2  Is Change LAN in LAN settings under Device settings set to LAN inactive?

LAN settings

Check3  Make sure that the LAN cable is connected properly.

Make sure that the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.
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Other Problems with Network

Forgot an Access Point Name, SSID, or a Network Key

The Message Is Displayed on the Computer Screen During Setup

The Administrator Password Set to the Printer Was Forgotten

Checking Information about the Network

How to Restore the Printer's Network Settings to Factory Default
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Forgot an Access Point Name, SSID, or a Network Key

Cannot Connect with an Access Point to Which a WEP or WPA/WPA2 Key Is Set (You Forgot the WEP or
WPA/WPA2 Key)

How to Set an Encryption Key

Cannot Connect with an Access Point to Which a WEP or WPA/WPA2
Key Is Set (You Forgot the WEP or WPA/WPA2 Key)

For information on how to set up the access point, refer to the instruction manual provided with the access
point or contact its manufacturer. Make sure that the computer and the access point can communicate
with each other.

After that, set up the printer to match the settings of the access point using IJ Network Tool.

How to Set an Encryption Key

For information on how to set up the access point, refer to the instruction manual provided with the access
point or contact its manufacturer. Make sure that the computer and the access point can communicate
with each other.

After that, set up the printer to match the settings of the access point using IJ Network Tool.

• When using WEP

The key length, key format, the key to use (one of 1 to 4), and the authentication method must match
among the access point, the printer, and the computer.

In order to communicate with an access point that uses automatically generated WEP keys, you must
configure the printer to use the key generated by the access point by entering it in hexadecimal
format.

Normally, select Auto for the authentication method. Otherwise, select Open System or Shared Key
according to the setting of the access point.

When the WEP Details screen appears after clicking Set on the Search screen, follow the on-screen
instructions and set the key length, the key format, the key number, and the authentication to enter a
WEP key.

For details, see Changing the WEP Detailed Settings.

• When using WPA/WPA2

The authentication method, passphrase, and dynamic encryption type must match on the access
point, the printer, and the computer.

Enter the passphrase configured on the access point (a sequence of between 8 and 63 alphanumeric
characters, or a 64-character hexadecimal number).
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Either TKIP (basic encryption) or AES (secure encryption) is selected automatically for the dynamic
encryption method.

For details, see Changing the WPA/WPA2 Detailed Settings.

Note
• This printer supports WPA/WPA2-PSK (WPA/WPA2-Personal) and WPA2-PSK (WPA2-

Personal).
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The Message Is Displayed on the Computer Screen During Setup

The Enter Password Screen Is Displayed During Setup

The Screen for Setting the Encryption Is Displayed After Selecting the Access Point in the Search Screen

"You are connecting the printer to the non encrypted wireless network" Is Displayed

The Enter Password Screen Is Displayed During Setup

The following screen is displayed if an administrator password is set to the printer which has already been
set up to use via a network.

Enter the administrator password you have set.

Note
• An administrator password is already specified for the printer at the time of purchase.

For details:

About the Administrator Password

For improving security, it is recommended to change the administrator password.

Changing the Settings in the Admin Password Sheet

The Screen for Setting the Encryption Is Displayed After Selecting the
Access Point in the Search Screen

This screen is displayed automatically if the selected access point is encrypted. In this case, configure the
details to use the same encryption settings set to the access point.

For information on the encryption settings, see Changing the Settings in the Wireless LAN Sheet.

"You are connecting the printer to the non encrypted wireless
network" Is Displayed
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Security is not configured on the access point. The printer can still be used, so continue the setup
procedure to complete it.

Important
• If you connect to a network that is not protected with security measures, there is a risk of disclosing

data such as your personal information to a third party.
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The Administrator Password Set to the Printer Was Forgotten

Initialize the printer settings.

Select All data, then the administrator password reverts to the default.

Reset setting

After initializing the printer settings, perform setup with the Setup CD-ROM or perform it according to the
instructions on our website.
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Checking Information about the Network

Checking the IP Address or the MAC Address of the Printer

Checking the IP Address or the MAC Address of the Computer

Checking If the Computer and the Printer, or Computer and the Access Point Can Communicate

Checking the Network Setting Information

Checking the IP Address or the MAC Address of the Printer

To check the IP address or the MAC address of the printer, print out the network setting information using
the operation panel of the printer.

Printing Out Network Setting Information

To display the network setting information using IJ Network Tool, select Network Information on the
View menu.

Canon IJ Network Tool Screen

Checking the IP Address or the MAC Address of the Computer

To check the IP address or MAC address assigned to the computer, follow the procedure below.

1. Select Command Prompt as shown below.

• In Windows 8.1 or Windows 8, select Command Prompt from the Start screen. If Command
Prompt is not displayed on the Start screen, select the Search charm, then search for
"Command Prompt".

• In Windows 7, Windows Vista, or Windows XP, click Start > All Programs > Accessories >
Command Prompt.

2. Enter "ipconfig/all" and press the Enter key.

The IP addresses and the MAC addresses of the network devices installed on your computer are
displayed. When the network device is not connected to the network, the IP address is not displayed.

Checking If the Computer and the Printer, or Computer and the
Access Point Can Communicate

To check that communication is available, perform the ping test.
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1. Select Command Prompt as shown below.

• In Windows 8.1 or Windows 8, select Command Prompt from the Start screen. If Command
Prompt is not displayed on the Start screen, select the Search charm, then search for
"Command Prompt".

• In Windows 7, Windows Vista, or Windows XP, click Start > All Programs > Accessories >
Command Prompt.

2. Type the ping command and the IP address of the target printer or the target access
point, and then press the Enter key.

ping XXX.XXX.XXX.XXX

"XXX.XXX.XXX.XXX" is the IP address of the target device.

If the communication is available, a message such as the following is displayed.

Reply from XXX.XXX.XXX.XXX: bytes=32 time=10ms TTL=255

When Request timed out is displayed, the communication is not available.

Checking the Network Setting Information

To check the network setting information of the printer, print out the network setting information using the
operation panel of the printer.

Printing Out Network Setting Information
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How to Restore the Printer's Network Settings to Factory Default

Important
• Note that initialization erases all network settings on the printer, and printing operation from a computer

over network may become impossible. To use the printer over network, perform setup with the Setup
CD-ROM or perform it according to the instructions on our website.

Select Reset LAN settings on the operation panel of the printer to initialize the network setting.

Reset setting
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Problems with Printing

Printing Does Not Start

Paper Jams

Paper Does Not Feed Properly/"No Paper" Error Occurs

Cannot Print Properly with Automatic Duplex Printing

Printing Stops Before It Is Completed
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Printing Does Not Start

Check1  Make sure that the power plug is securely plugged in, then press the ON button
to turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit.

Note
• When printing large data such as a photo or graphics, it may take longer to start printing. While the

POWER lamp is flashing, the computer is processing data and sending it to the printer. Wait until printing
starts.

Check2  Make sure that the printer is connected to your computer properly.

When the printer is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the printer and the computer, then check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device. Consult
the reseller of the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.

When you use the printer over LAN, make sure that the printer is connected to the network with a LAN cable or
is set up correctly.

Check3  Is the access point mode enabled?

When you print using a mode other than the access point mode, disable the access point mode in advance.

Check4  Are the paper settings identical with those registered to the cassette?

When the paper settings are not identical with those registered to the cassette, an error message is displayed.
Resolve the error according to the instructions on the LCD.

Paper Setting for Printing

Note
• You can disable the message which prevents misprinting.

• To change the setting using the operation panel:

Cassette settings

• To change the setting using the printer driver:

Changing the Printer Operation Mode

Check5  If there are any unnecessary print jobs, delete them.

Deleting the Undesired Print Job
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Check6  Make sure that your printer's name is selected in the Print dialog box.

The printer will not print properly if you are using a printer driver for a different printer.

Make sure that "Canon XXX series" (where "XXX" is your printer's name) is selected in the Print dialog box.

Note
• To make the printer the one selected by default, select Set as Default Printer.

Check7  Configure the printer port appropriately.

Make sure that the printer port is configured appropriately.

1. Log on as a user account with administrator privilege.

2. Select items as shown below.

• In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop > Hardware
and Sound > Devices and Printers.

• In Windows 7, select Devices and Printers from the Start menu.

• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open the properties of the printer driver for the printer.

• In Windows 8.1, Windows 8, or Windows 7, right-click the "Canon XXX series" icon (where "XXX" is
your printer's name), then select Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX series" icon (where "XXX" is your
printer's name), then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX series" appearing in the
Printer column is selected for Print to the following port(s).

Note
• When the printer is used over LAN, the port name of the printer is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a
character string specified by the user when setting up the printer.

• If the setting is incorrect:

Reinstall the printer driver with the Setup CD-ROM or install it from our website.

• Printing does not start even though the printer is connected to the computer using a USB cable and the
port named "USBnnn" is selected:

In Windows 8.1 or Windows 8, select My Printer on the Start screen to start My Printer. If My Printer
is not displayed on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to set
the correct printer port, then select your printer's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon Utilities,
Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow the on-
screen instructions to set the correct printer port, then select your printer's name.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.
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• Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the printer
is used over LAN:

Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then associate
the port with the printer using Associate Port in the Settings menu.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.

Check8  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Check9  Restart your computer.
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Paper Jams

When paper is jammed, a troubleshooting message is displayed automatically. Take the appropriate action
described in the message.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to remove the jammed paper, refer to Support Code List (When Paper Is Jammed).

Note
• You can confirm the actions against errors with Support Codes on your computer or on the LCD by

searching a Support Code.

Click Here to Search
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Paper Does Not Feed Properly/"No Paper" Error Occurs

Check1  Make sure that paper is loaded.

Loading Paper

Check2  Make sure of the following when you load paper.

• When loading two or more sheets of paper, flip through the paper before loading. In addition, when you load
paper with some paper remaining in the cassette, flip through the remaining paper and the newly loaded
paper before loading.

• When loading two or more sheets of paper, align the edges of the sheets before loading.

• When loading two or more sheets of paper, make sure that the paper stack does not exceed the paper load
limit.

However, proper feeding of paper may not be possible at this maximum capacity depending on the type of
paper or environmental conditions (either very high or low temperature and humidity). In such cases, reduce
the sheets of paper you load at a time to less than half of the paper load limit.

• Always load the paper in portrait orientation, regardless of the printing orientation.

Loading Paper

Important
• When loading paper in the cassette, slide the paper guide on the front side to align with the corresponding

mark of page size. Load the paper with the print side facing DOWN, load the paper stack in the center of
the cassette, then slide the paper guides to align with the both edges of the paper stack.

Loading Paper

Check3  Check to see if the paper you are printing on is not too thick or curled.

Media Types You Cannot Use

Check4  Make sure of the following when you load Hagakis or envelopes.

• If a Hagaki is curled, it may not feed properly even though the paper stack does not exceed the paper load
limit.

Load Hagakis with a zip code column toward the far end of the cassette 1.

• When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.
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Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

Check5  Confirm that the media type and the paper size settings correspond with the
loaded paper.

Check6  Clean the paper feed roller.

Cleaning the Paper Feed Roller

Note
• Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

Check7  If two or more sheets of paper feed from the cassette at once, clean the inside
of the cassette.

For information on cleaning the inside of the cassette, refer to Cleaning the Pad in the Cassette.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues after
removing the paper, contact the service center.
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Cannot Print Properly with Automatic Duplex Printing

Check1  Is the setting for automatic duplex printing selected?

Make sure that the Duplex Printing and Automatic check boxes are selected on the Page Setup sheet in the
printer driver setup window.

Duplex Printing

Check2  Make sure that the actual size of the paper is suitable for automatic duplex
printing.

The sizes of media suitable for automatic duplex printing are A4 and Letter.

Load paper of suitable size, then press the OK button on the printer.

Check3  Make sure that the paper size setting is correct.

Make sure that the paper size setting matches the actual size of the paper with a size suitable for automatic
duplex printing.

First, check the paper size setting in the application software you are printing from.

Then, check the Page Size setting on the Page Setup sheet in the printer driver setup window.

Note
• Duplex printing may not be available depending on the version of the application software.

Check4  Make sure that the media type setting is correct.

Make sure that the media type setting matches the actual size of the paper with a size suitable for automatic
duplex printing.

Make sure that the type of loaded paper is suitable for automatic duplex printing on the Main sheet in the printer
driver setup window.

Note
• To switch to manual duplex printing, follow the procedure below.

Open the printer driver setup window, clear the Automatic check box on the Page Setup sheet, and
reprint.

When performing manual duplex printing, note the following.

• If you are printing three or more pages of a document with manual duplex printing, one side of all
sheets of paper will be printed first. Turn over the paper and reload the paper in the printer, and
then the reverse side of all sheets of paper will be printed. Be careful not to change the order of
paper in the stack.

• The procedure for reversing the paper varies depending on the staple side and printing orientation.
Follow the on-screen instructions.
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Printing Stops Before It Is Completed

Check1  Is the paper loaded?

Make sure that paper is loaded.

If the printer has run out of paper, load paper.

Check2  Do the printing documents have lots of photographs or illustrations?

As printing large data such as photos or graphics takes time for the printer and the computer to process, the
printer may appear to have stopped operating.

In addition, when printing data that uses a large amount of ink continuously on plain paper, the printer may
pause temporarily. In either case, wait until the process is complete.

Note
• If you are printing a document with a large printing area or printing multiple copies of a document, printing

may pause to allow the ink to dry.

Check3  Has the printer been printing continuously for a long period?

If the printer has been printing continuously for a long time, the print head or other parts around it may overheat.
The printer may stop printing at a line break for a period of time and then resume printing.

In this case, wait for a while without operation. If the printing still does not resume, interrupt your print session at
a convenient time and turn the printer off for at least 15 minutes.

Caution
• The print head and the surrounding area can become extremely hot inside the printer. Never touch the

print head or nearby components.
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Problems with Printing Quality

Print Results Not Satisfactory

Ink Is Not Ejected
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Print Results Not Satisfactory

If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the
paper and print quality settings first.

Check1  Do the page size and media type settings match the size and type of the loaded
paper?

When these settings are incorrect, you cannot obtain a proper print result.

If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality of the
printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

Confirm the page size and media type settings using the printer driver.

Printing with Easy Setup

Check2  Make sure that the appropriate print quality is selected using the printer driver.

Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven colors,
increase the print quality setting and try printing again.

You can confirm the print quality setting using the printer driver.

Changing the Print Quality and Correcting Image Data

Check3  If the problem is not resolved, there may be other causes.

See also the sections below:

Cannot Print to End of Job

Part of the Page Is Not Printed

No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

Lines Are Misaligned

Line Does Not Print or Prints Partially

Image Does Not Print or Prints Partially

Printed Paper Curls or Has Ink Blots

Paper Is Smudged/Printed Surface Is Scratched

Back of the Paper Is Smudged

Colors Are Uneven or Streaked
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Cannot Print to End of Job

Check1  Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Check3  Is the space of your computer's hard disk sufficient?

Delete unnecessary files to free disk space.
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Part of the Page Is Not Printed

Check  When performing automatic duplex printing, the reason below is possible.

When performing automatic duplex printing, the printable area at the top of the page will be 0.08 inches / 2 mm
narrower than the usual.

For this reason, the bottom of the page may not be printed. To prevent this, select the setting to reduce printing
from the printer driver.

Important
• Reduced printing may affect the layout depending on your document.

Apply the print setting specified with the application software if the software has a enlarge/reduce printing
function.

1. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

2. Check the Duplex Printing check box in the Page Setup sheet.

3. Click Print Area Setup, then select Use reduced printing.
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White
Streaks

 No Printing Results

 Printing Is Blurred

 Colors Are Wrong
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 White Streaks

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Check the status of ink tanks. Replace the ink tank if the ink has run out.

Replacing an Ink Tank

Check3  Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning
and try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the
service center.

Check4  When using paper with one printable surface, make sure that the paper is
loaded with the printable side facing down.

Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

Load paper with the printable side facing down.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.
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Lines Are Misaligned

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Perform Print Head Alignment.

If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

Aligning the Print Head

Note
• If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment

manually referring to Aligning the Print Head Position Manually from Your Computer.

Check3  Increase the print quality and try printing again.

Increasing the print quality in the printer driver may improve the print result.

Check4  If lines are misaligned with manual duplex printing, perform automatic duplex
printing.
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Line Does Not Print or Prints Partially

Check1  Is the Page Layout Printing performed or the Binding margin function used?

When the Page Layout Printing or Binding margin function is being used, thin lines may not be printed. Try
thickening the lines in the document.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Image Does Not Print or Prints Partially

Check1  Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Printed Paper Curls or Has Ink Blots

 Printed Paper Has Ink Blots

 Printed Paper Curls

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  If the intensity is set high, reduce the intensity setting and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

You can confirm the intensity using the printer driver.

Adjusting Intensity

Check3  Is Photo Paper used for printing photographs?

When printing data with high color saturation such as photographs or images in deep color, we recommend
using Photo Paper Plus Glossy II or other Canon speciality paper.

Media Types You Can Use
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Paper Is Smudged/Printed Surface Is Scratched

 Paper Is Smudged

The Edges of Paper Are Smudged Printed Surface Is Smudged

 Printed Surface Is Scratched

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Is the appropriate type of paper used?

Check to see if the paper you are printing on is suitable for your printing purpose.

Media Types You Can Use

Check3  Load the paper after correcting its curl.

When using Photo Paper Plus Semi-gloss, even if the sheet is curled, load one sheet at a time as it is. If you roll
up this paper to flatten, this may cause cracks on the surface of the paper and reduce the print quality.

We recommend putting unused paper back into the package and keeping it on a level surface.

• For Plain Paper

Turn the paper over and reload it to print on the other side.

• For Other Paper

If the curl on the four corners of the paper is more than 0.1 inch / 3 mm (A) in height, the paper may be
smudged or may not be fed properly. In such cases, follow the procedure described below to correct the
paper curl.
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1. Roll up the paper in the opposite direction to the paper curl as shown below.

2. Check that the paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

Note
• Depending on the media type, the paper may be smudged or may not be fed properly even if it is not

curled inward. In such cases, follow the procedure described below to curl the paper outward within 0.1
inch / 3 mm (B) in height before printing. This may improve the print result.

(C) Printing side

We recommend printing paper that has been curled outward one sheet at a time.

Check4  Adjust the setting to prevent paper abrasion.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the loaded
paper. If you notice abrasion even with the media type set correctly to match the loaded paper, set the printer to
prevent paper abrasion by using the operation panel or the computer.

Print speed may be reduced if you apply the setting to prevent paper abrasion setting.

* Readjust the setting not to prevent paper abrasion once printing is complete. If not, this setting remains
enabled for all subsequent print jobs.

• To set by using the operation panel

Press the Setup button, then select Device settings and Output settings in this order, then set Prevent
abrasion to ON.

Changing the Printer Settings on the LCD

• To set by using your computer

Open the printer driver setup window, and in Custom Settings in the Maintenance sheet, select the
Prevent paper abrasion check box, and then click OK.

To open the printer driver setup window, see How to Open the Printer Driver Setup Window.

Check5  If the intensity is set high, reduce the intensity setting and try printing again.
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If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

Reduce the intensity setting in the printer driver and try printing again.

1. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

2. On the Main sheet, select Manual for Color/Intensity, and then click Set....

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.

Check6  Is printing performed beyond the recommended printing area?

If you are printing beyond the recommended printing area of your printing paper, the lower edge of the paper
may become stained with ink.

Resize your original document in your application software.

Printing Area

Check7  Is the paper feed roller dirty?

Clean the paper feed roller.

Cleaning the Paper Feed Roller

Note
• Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

Check8  Is the inside of the printer dirty?

When performing duplex printing, the inside of the printer may become stained with ink, causing the printout to
become smudged.

Perform the Bottom Plate Cleaning to clean the inside of the printer.

Cleaning the Inside of the Printer (Bottom Plate Cleaning)

Note
• To prevent the inside of the printer from stains, set the paper size correctly.

Check9  Set the time to dry the printed surface longer.

Doing so gives the printed surface enough time to dry so that paper smudged and scratched are prevented.

1. Make sure that the printer is turned on.

2. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

3. Click the Maintenance tab and then Custom Settings.

4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click OK.

5. Confirm the message and click OK.
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Back of the Paper Is Smudged

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Perform the Bottom Plate Cleaning to clean the inside of the printer.

Cleaning the Inside of the Printer (Bottom Plate Cleaning)

Note
• When performing duplex printing or too much printing, the inside may become stained with ink.

501



Colors Are Uneven or Streaked

 Colors Are Uneven

 Colors Are Streaked

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning
and try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:
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Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the
service center.

Check3  Perform Print Head Alignment.

Aligning the Print Head

Note
• If the problem is not resolved after performing the Print Head Alignment, perform Print Head Alignment

manually referring to Aligning the Print Head Position Manually from Your Computer.
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Ink Is Not Ejected

Check1  Has the ink run out?

Check the Support Code on the LCD and take the appropriate action to resolve the error.

Support Code List

Check2  Are the print head nozzles clogged?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head Cleaning
and try printing the Nozzle Check Pattern again.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the print head may be damaged. Contact the
service center.
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Problems with the Printer

The Printer Cannot Be Powered On

The Printer Turns Off Unintentionally

Cannot Connect to Computer with a USB Cable Properly

Cannot Communicate with the Printer with USB Connection

LCD Cannot Be Seen At All

An Unintended Language Is Displayed on the LCD

Print Head Holder Does Not Move to the Position for Replacing

Printer Status Monitor Is Not Displayed
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The Printer Cannot Be Powered On

Check1  Press the ON button.

Check2  Make sure that the power plug is securely plugged into the power cord
connector of the printer, then turn it back on.

Check3  Unplug the printer from the power supply, then plug the printer back in and turn
the printer back on after leaving it for at least 2 minutes.

If the problem is not resolved, contact the service center.
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The Printer Turns Off Unintentionally

Check  Deactivate the setting to turn the unit off automatically.

The printer turns off automatically according to the elapsed time you specified if you activate the setting to turn
the unit off automatically.

If you do not want the printer to turn off automatically, open the printer driver setup window and in Auto Power
under the Maintenance sheet, select Disable for Auto Power Off.
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Cannot Connect to Computer with a USB Cable Properly

Printing Speed Is Slow/Hi-Speed USB Connection Does Not
Work/"This device can perform faster" Message Is Displayed

If your system environment is not fully compatible with Hi-Speed USB, the printer will operate at a lower
speed provided under USB 1.1. In this case, the printer operates properly but printing speed may slow
down due to communication speed.

Check  Check the following to make sure that your system environment supports Hi-
Speed USB connection.

• Does the USB port on your computer support Hi-Speed USB connection?

• Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is no longer than around
10 feet / 3 meters.

• Does the operating system of your computer support Hi-Speed USB connection?

Obtain and install the latest update for your computer.

• Does the Hi-Speed USB driver operate properly?

Obtain the latest version of the Hi-Speed USB driver compatible with your hardware and reinstall it on
your computer.

Important
• For details on Hi-Speed USB of your system environment, contact the manufacturer of your computer,

USB cable, or USB hub.
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Cannot Communicate with the Printer with USB Connection

Check1  Make sure that the printer is turned on.

Check2  Make sure that the USB cable is connected properly.

See Connecting the Printer to the Computer Using a USB Cable to connect the USB cable properly.

Check3  Do not start up IJ Network Tool while printing.

Check4  Do not print while IJ Network Tool is running.

Check5  Make sure that Enable bidirectional support is selected in the Ports sheet of
the properties dialog box of the printer driver.

How to Open the Printer Driver Setup Window
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LCD Cannot Be Seen At All

• If the POWER lamp is off:

The printer is not powered on. Connect the power cord and press the ON button.

• If the POWER lamp is lit:

The LCD may be in the screen-saver mode. Press one of the buttons on the operation panel.
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An Unintended Language Is Displayed on the LCD

Select the language you want to be displayed according to the following procedure.

1. Press the Setup button, then wait for about 5 seconds.

2. Press the  button once, then press the OK button.

3. Press the  button twice, then press the OK button.

4. Press the OK button again.

5. Use the  button to select the language for the LCD, then press the OK button.

The desired language is displayed on the LCD.
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Print Head Holder Does Not Move to the Position for Replacing

Important
• The print head holder moves to the position for replacing only when an ink tank runs out of ink. If no ink

tanks run out of ink, the print head holder does not move even though you open the front cover.

Check1  Is the POWER lamp off?

Check if the POWER lamp is lit.

The print head holder will not move unless the power is on. If the POWER lamp is off, close the front cover and
turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit, and then open the front cover again.

Check2  Is an error message displayed on the LCD?

Close the front cover, follow the Support Code (error number) displayed in the error message to resolve the
error, and then reopen it. For details on how to resolve the error, refer to Support Code List.

Check3  Has the front cover been left open for 60 minutes or longer?

If the front cover is left open for more than 60 minutes, the print head holder moves to the position to protect it to
prevent the print head from drying out. Close and reopen the front cover to return the print head holder to the
position for replacing.

512



Printer Status Monitor Is Not Displayed

Check  Is the printer status monitor enabled?

Make sure that Enable Status Monitor is selected on the Option menu of the printer status monitor.

1. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

2. On the Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on the Option menu if it is not selected.
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Problems with Installation/Downloading

Cannot Install the Printer Driver

Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu Does Not
Appear

How to Update Printer Driver in Network Environment

Uninstalling IJ Network Tool
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Cannot Install the Printer Driver

• If the installation does not start even after the Setup CD-ROM is inserted into your computer's
disc drive:

Start the installation following the procedure below.

1. Select items as shown below.

◦ In Windows 8.1 or Windows 8, select the Explorer icon in Taskbar on Desktop, then select
Computer from the list on the left.

◦ In Windows 7 or Windows Vista, click Start then Computer.

◦ In Windows Vista, click Start then Computer.

◦ In Windows XP, click Start then My Computer.

2. Double-click the  CD-ROM icon on the displayed window.

If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

If you cannot install the printer driver with the Setup CD-ROM, install it from our website.

Note
• If the CD-ROM icon is not displayed, try the following:

• Remove the CD-ROM from your computer, then insert it again.

• Restart your computer.

If the icon is not yet displayed, try different discs and see if they are displayed. If other discs are
displayed, there is a problem with the Setup CD-ROM. In this case, contact the service center.
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• If you are unable to proceed beyond the Printer Connection screen:

Note
• The printer is not detected. Check the connection. may be displayed depending on the

computer you use.

Check1  Make sure that the USB cable is securely plugged in to the printer and the
computer.

Check2  Follow the procedure below to connect the printer and the computer again.

1. Turn the printer off.

2. Unplug the USB cable from the printer and the computer, then connect it again.

3. Turn the printer on.

Check3  If you cannot resolve the problem, follow the procedure below to reinstall the
printer driver.

1. Click Cancel.

2. Click Start Over on the Installation Failure screen.

3. Click Exit on the "MAXIFY XXX" screen (where "XXX" is your printer's name), then remove the CD-
ROM.

4. Turn the printer off.

5. Restart the computer.

6. Make sure that you have no application software running.

7. Insert the CD-ROM again, then install the printer driver.
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• In other cases:

Reinstall the printer driver.

If the driver was not installed correctly, uninstall the printer driver, restart your computer, then reinstall
the driver.

Deleting the Unnecessary Printer Driver

If you reinstall the printer driver, install the printer driver with the Setup CD-ROM or install it from our
website.

Note
• If the installer was forced to be terminated due to a Windows error, the system may be in an

unstable condition and you may not be able to install the driver. Restart your computer before
reinstalling.
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Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu
Does Not Appear

If Easy-WebPrint EX does not start up or its menu does not appear on Internet Explorer, confirm the
following.

Check1  Is Canon Easy-WebPrint EX displayed on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not displayed, Easy-WebPrint EX is not installed on your computer. Install the
latest Easy-WebPrint EX onto your computer from our website.

Note
• If Easy-WebPrint EX is not installed on your computer, a message asking you to install it may be displayed

on the notification area on the desktop. Click the message, then follow the instructions on the computer
screen to install Easy-WebPrint EX.

• While the installation or download Easy-WebPrint EX is in progress, it is necessary to access the Internet.

Check2  Is Canon Easy-WebPrint EX selected on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not selected, Easy-WebPrint EX is disabled. Select Canon Easy-WebPrint EX
to enable it.
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How to Update Printer Driver in Network Environment

Download the latest printer driver in advance.

To obtain the latest printer driver, access our web site through the Internet and download the latest printer
driver for your model.

After uninstalling the printer driver, install the latest printer driver according to the regular procedure. When
the connection method selection screen is displayed, select Use the printer with wireless LAN
connection or Use the printer with wired LAN connection according to the connection method you use.
The printer will be detected automatically in the network.

After making sure that the printer is detected, install the printer driver following the on-screen instructions.

Note
• You can use the printer over a LAN without performing setup again.
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Uninstalling IJ Network Tool

Follow the procedure below to uninstall IJ Network Tool from your computer.

Important
• Even if IJ Network Tool is uninstalled, you can print over network. However, you cannot change the

network settings over network.

• Log into a user account with administrator privilege.

1. Perform the procedure to uninstall IJ Network Tool.

• In Windows 8.1 or Windows 8:

1. Select Control Panel from the Settings charm on Desktop > Programs > Programs and
Features.

2. Select Canon IJ Network Tool from the program list, then click Uninstall.

If the User Account Control screen appears, click Continue.

• In Windows 7 or Windows Vista:

1. Click Start > Control Panel > Programs > Programs and Features.

2. Select Canon IJ Network Tool from the program list, then click Uninstall.

If the User Account Control screen appears, click Continue.

• In Windows XP:

1. Click Start > Control Panel > Add or Remove Programs.

2. Select Canon IJ Network Tool from the program list, then click Remove.

2. Click Yes when the confirmation message appears.

When the message prompting you to restart your computer is displayed, click OK to restart your
computer.
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About Errors/Messages Displayed

If an Error Occurs

A Message Is Displayed
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If an Error Occurs

When an error occurs in printing such as the printer is out of paper or paper is jammed, a troubleshooting
message is displayed automatically. Take the appropriate action described in the message.

When an error occurs, a Support Code (error number) is displayed on the computer screen or the LCD.

• When a Support Code and a message are displayed on the computer screen:

• When a Support Code and a message are displayed on the LCD:

For details on how to resolve errors with Support Codes, refer to Support Code List.

Note
• You can confirm the actions against errors with Support Codes on your computer or on the LCD by

searching a Support Code.

Click Here to Search

For details on how to resolve errors without Support Codes, see A Message Is Displayed.
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A Message Is Displayed

This section describes some of the errors or messages.

Note
• A Support Code (error number) is displayed on the computer or on the LCD for some error or message.

For details on errors with Support Codes, refer to Support Code List.

If a message is displayed on the LCD, see below.

• A Message Is Displayed on the LCD

If a message is displayed on the computer, see below.

• Error Regarding Automatic Duplex Printing Is Displayed

• Error Regarding the Power Cord Being Unplugged Is Displayed

• Writing Error/Output Error/Communication Error

• Other Error Messages

• The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

A Message Is Displayed on the LCD

Confirm the message and take an appropriate action.

• Cannot connect to the server; try again

You cannot connect to the server due to some communication error. When you have tried to access a
photo sharing site, it is possible that your photos have been deleted.

Press the OK button to dismiss the error, then try again after a while.

Error Regarding Automatic Duplex Printing Is Displayed

Check  See Cannot Print Properly with Automatic Duplex Printing and take the
appropriate action.

Error Regarding the Power Cord Being Unplugged Is Displayed

The power cord may have been unplugged while the printer was still on.

Check the error message that appears on the computer, then click OK.

The printer starts printing.

523



See Notice for Unplugging the Power Cord for unplugging the power cord.

Writing Error/Output Error/Communication Error

Check1  If the POWER lamp is off, make sure that the power plug is plugged in, then
turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit.

Check2  Make sure that the printer port is configured appropriately in the printer driver.

* In the following instructions, "XXX" signifies your printer's name.

1. Log on as a user account with administrator privilege.

2. Select items as shown below.

• In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Hardware and Sound > Devices and Printers.

• In Windows 7, select Devices and Printers from the Start menu.

• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open the properties of printer driver for the printer.

• In Windows 8.1, Windows 8, or Windows 7, right-click the "Canon XXX series" icon (where "XXX" is
your printer's name), then select Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX series" icon (where "XXX" is your
printer's name), then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX series" appearing in
the Printer column is selected for Print to the following port(s).

Note
• When the printer is used over LAN, the port name of the printer is displayed as

"CNBJNP_xxxxxxxxxx". "xxxxxxxxxx" is the character string generated from the MAC address or a
character string specified by the user when setting up the printer.

• If the setting is incorrect:

Reinstall the printer driver with the Setup CD-ROM or install it from our website.

• Printing does not start even though the printer is connected to the computer using a USB cable and
the port named "USBnnn" is selected:

In Windows 8.1 or Windows 8, select My Printer on the Start screen to start My Printer. If My
Printer is not displayed on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to
set the correct printer port, then select your printer's name.
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In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow
the on-screen instructions to set the correct printer port, then select your printer's name.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.

• Printing does not start even though the port named "CNBJNP_xxxxxxxxxx" is selected when the
printer is used over LAN:

Launch IJ Network Tool, and select "CNBJNP_xxxxxxxxxx" as you confirmed in step 4, then
associate the port with the printer using Associate Port in the Settings menu.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.

Check3  Make sure that the printer is connected to your computer properly.

When the printer is connected to your computer with a USB cable, make sure that the USB cable is securely
plugged in to the printer and the computer, then check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device.
Consult the reseller of the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.

When you use the printer over LAN, make sure that the printer is connected to the network with a LAN cable
or is set up correctly.

Check4  Make sure that the printer driver is installed correctly.

Uninstall the printer driver following the procedure described in Deleting the Unnecessary Printer Driver, then
reinstall the printer driver with the Setup CD-ROM or reinstall it from our website.

Check5  When the printer is connected to your computer with a USB cable, check the
status of the device on your computer.

Follow the procedure below to check the status of the device.

1. Open the Device Manager on your computer as shown below.

If the User Account Control screen is displayed, follow the on-screen instructions.

• In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Hardware and Sound > Device Manager.

• In Windows 7 or Windows Vista, click Control Panel, Hardware and Sound, then Device Manager.

• In Windows XP, click Control Panel, Performance and Maintenance, System, then click Device
Manager on the Hardware sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.

If the USB Printing Support Properties screen is not displayed, make sure that the printer is correctly
connected to the computer.

Check3  Make sure that the printer is connected to your computer properly.

3. Click the General tab and make sure that there is no indication of a problem with the device.

If a device error is displayed, refer to Windows help to resolve the error.
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Other Error Messages

Check  If an error message is displayed outside the printer status monitor, check the
following:

• "Could not spool successfully due to insufficient disk space"

Delete any unnecessary files to increase the amount of free space on the disk.

• "Could not spool successfully due to insufficient memory"

Quit other running application softwares to increase available memory.

If you cannot print yet, restart your computer and retry printing.

• "Printer driver could not be found"

Uninstall the printer driver following the procedure described in Deleting the Unnecessary Printer Driver,
then reinstall the printer driver with the Setup CD-ROM or reinstall it from our website.

• "Could not print Application name - File name"

Try printing again once the current job is complete.

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is
Displayed

If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a confirmation screen asking for
permission to send the printer and application software usage information will be displayed every month
for about ten years.

Read the instructions on the screen and follow the procedure below.
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• If you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent via the
Internet. If you have followed the on-screen instructions, the information will be sent automatically
from the second time onward and the confirmation screen will not be displayed again.

Note
• When the information is being sent, a caution screen such as an Internet security screen may be

displayed. In this case, confirm that the program name is "IJPLMUI.exe", then allow it.

• If you deselect the Send automatically from the next time check box, the information will not
be sent automatically from the second time onward and a confirmation screen will be displayed at
the time of the next survey. To send the information automatically, see Changing the confirmation
screen setting:.

• If you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is skipped.
The confirmation screen will be displayed again one month later.

• To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall, then follow the
on-screen instructions.

• Changing the confirmation screen setting:

1. Select items as shown below.

◦ In Windows 8.1 or Windows 8, select Control Panel from the Settings charm on Desktop >
Programs > Programs and Features.

◦ In Windows 7, or Windows Vista, select the Start menu > Control Panel > Programs >
Programs and Features.

◦ In Windows XP, select the Start menu > Control Panel > Add or Remove Programs.
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Note
• In Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning

dialog box may appear when installing, uninstalling or starting up software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, follow the on-screen instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.

3. Select Change.

If you select Yes after you have followed the on-screen instructions, the confirmation screen will
be displayed at the time of the next survey.

If you select No, the information will be sent automatically.

Note
• If you select Uninstall (or Remove in Windows XP), the Inkjet Printer/Scanner/Fax

Extended Survey Program is uninstalled. Follow the on-screen instructions.
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If You Cannot Resolve the Problem

If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of
the printer or the service center.

Canon support staff are trained to be able to provide technical support to satisfy customers.

Caution
• If the printer emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power cord

from the outlet and contact the seller or the service center. Never attempt to repair or disassemble the
printer yourself.

• Attempts by customers to repair or take apart the printer will invalidate any warranty regardless of
whether the warranty has expired.

Before contacting the service center, confirm the following:

• Product name:

* Your printer's name is located on the front cover of the setup manual.

• Serial number: please refer to the setup manual

• Details of the problem

• What you tried to solve the problem, and what happened
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Support Code List

The support code appears on the LCD and the computer screen when an error occurs.

"Support Code" means the error number and appears with an error message.

When an error occurs, check the support code displayed on the LCD or the computer screen and take the
appropriate action.

Support Code Appears on the LCD and the Computer Screen

• 1000 to 1ZZZ

1007 1008 1200 1300 1303 1310

1313 1314 1575 1600 1660 1688

1700 1701 1754 1755 1872 1873

1874 1890     

• 2000 to 2ZZZ

2111 2112 2113 2121 2122 2500

• 4000 to 4ZZZ

4100 4103 4104    

• 5000 to 5ZZZ

5100 5102 5103 5104 5105 5200

5203 5204 5205 5206 5207 5208

5209 5400 5500 5501 5B00 5B01

5C01      

• 6000 to 6ZZZ

6000 6500 6502 6800 6801 6900

6901 6902 6910 6911 6920 6921

6930 6931 6932 6933 6940 6941

6942 6943 6944 6945 6946  

• 7000 to 7ZZZ

7100 7200 7201 7202 7203 7204
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7205 7300     

• A000 to ZZZZ

B202 B203 B204 B502 B503 B504

C000      

About the support code for paper jam, you can also refer to Support Code List (When Paper Is Jammed).
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Support Code List (When Paper Is Jammed)

If the paper is jammed, remove it following the procedure appropriate for each case.

• If the paper is jammed inside the front cover:

1300

• If the paper is jammed inside the rear cover:

1303

• If the paper is jammed inside the rear cover as the printer pulled in the printed paper:

1313

• If the paper is jammed inside the rear cover when automatic duplex printing:

1314

• Cases other than above:

In Other Cases
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1300

Cause

Paper is jammed inside the front cover.

Action

If the paper is jammed inside the front cover, remove the paper following the procedure below.

Note
• If you need to turn off the printer to remove jammed paper during printing, press the Stop button to

cancel print jobs before turning off the printer.

1. Open the front cover.

Important
• Do not touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be
damaged.

2. Make sure that the jammed paper is not under the print head holder.

If the jammed paper is under the print head holder, move the print head holder to the right edge or the
left edge whichever is easier to remove the paper.

When you move the print head holder, press either the right side or the left side of the print head
holder with your fingertips and slide the print head holder slowly to the right edge or the left edge.

3. Hold the jammed paper with your hands.
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If the paper is rolled up, pull it out.

4. Pull the paper slowly not to tear it, then pull the paper out.

5. Make sure that all the jammed paper is removed.

If the paper is torn, a piece of paper may remain inside the printer. Check the following and remove
the piece of paper if it remains.

• Does the piece of paper remain under the print head holder?

• Does the little piece of paper remain inside the printer?

• Does the piece of paper remain in the right side or the left side space (C) inside the printer?
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6. Close the front cover.

7. Press the printer's OK button.

If you turned off the printer, all print jobs in the queue are canceled. Reprint if necessary.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are

loading it correctly.

Align the paper guides with the both edges of the paper when you load paper.

• If the message about paper jam is displayed on the LCD of the printer or on the computer
screen when you resume printing after removing all the jammed paper, a piece of paper may
remain inside the printer. In this case, confirm that no piece of paper remains inside the printer.

• We recommend you use paper other than A5 sized one to print documents with photos or
graphics; otherwise, the printout may curl and cause paper exit jams.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues
after removing the paper, contact the service center.
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1303

Cause

Paper is jammed inside the rear cover.

Action

If the paper is jammed inside the rear cover, remove the paper following the procedure below.

Note
• If you need to turn off the printer to remove jammed paper during printing, press the Stop button to

cancel print jobs before turning off the printer.

1. Rotate the printer so that the rear side of the printer faces toward you.

2. If the protective material for the rear cover remains attached, remove it.

3. Open the rear cover.

Slide the rear cover to the left then open it.

4. Pull out the paper slowly.
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Note
• Do not touch the inner parts of the printer.

• If you cannot pull the paper out, try the following.

• Turn the printer off and turn it back on.

The paper may be ejected automatically.

• Pull out the paper output tray.

It becomes easy to pull out the paper.

5. Close the rear cover slowly.

Close the rear cover then slide it to the right.

Slide the rear cover so that the  mark on the rear cover aligns with the  mark on the printer.

6. Reload the paper, then press the printer's OK button.

If you turned off the printer, all print jobs in the queue are canceled. Reprint if necessary.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are

loading it correctly.

Align the paper guides with the both edges of the paper when you load paper.

• We recommend you use paper other than A5 sized one to print documents with photos or
graphics; otherwise, the printout may curl and cause paper exit jams.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues
after removing the paper, contact the service center.

537



1313

Cause

Paper is jammed inside the rear cover as the printer pulled in the printed paper.

Action

If the paper is jammed inside the rear cover as the printer pulled in the printed paper, remove the paper
following the procedure below.

Important
• If the printed paper piles up on the paper output slot, the printer may pull it in and the paper is

jammed inside the printer. Remove the printed paper from the paper output tray before it amounts to
75 sheets.

Note
• If you need to turn off the printer to remove jammed paper during printing, press the Stop button to

cancel print jobs before turning off the printer.

1. Rotate the printer so that the rear side of the printer faces toward you.

2. If the protective material for the rear cover remains attached, remove it.

3. Open the rear cover.

Slide the rear cover to the left then open it.
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4. Pull out the paper slowly.

Note
• Do not touch the inner parts of the printer.

• If you cannot pull the paper out, try the following.

• Turn the printer off and turn it back on.

The paper may be ejected automatically.

• Pull out the paper output tray.

It becomes easy to pull out the paper.

5. Close the rear cover slowly.

Close the rear cover then slide it to the right.

Slide the rear cover so that the  mark on the rear cover aligns with the  mark on the printer.

6. Reload the paper, then press the printer's OK button.

If you turned off the printer, all print jobs in the queue are canceled. Reprint if necessary.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are

loading it correctly.
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Align the paper guides with the both edges of the paper when you load paper.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues
after removing the paper, contact the service center.
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1314

Cause

Paper is jammed inside the rear cover when performing automatic duplex printing.

Action

If the paper is jammed inside the rear cover when performing automatic duplex printing, remove the paper
following the procedure below.

Note
• If you need to turn off the printer to remove jammed paper during printing, press the Stop button to

cancel print jobs before turning off the printer.

1. Rotate the printer so that the rear side of the printer faces toward you.

2. If the protective material for the rear cover remains attached, remove it.

3. Open the rear cover.

Slide the rear cover to the left then open it.

4. Pull out the paper slowly.
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Note
• Do not touch the inner parts of the printer.

• If you cannot pull the paper out, try the following.

• Turn the printer off and turn it back on.

The paper may be ejected automatically.

• Pull out the paper output tray.

It becomes easy to pull out the paper.

5. Close the rear cover slowly.

Close the rear cover then slide it to the right.

Slide the rear cover so that the  mark on the rear cover aligns with the  mark on the printer.

6. Reload the paper, then press the printer's OK button.

If you turned off the printer, all print jobs in the queue are canceled. Reprint if necessary.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are

loading it correctly.

Align the paper guides with the both edges of the paper when you load paper.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues
after removing the paper, contact the service center.
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In Other Cases

Make sure of the following:

Check1  Are there any foreign objects around the paper output slot?

Check2  Are the rear cover attached properly?

Check3  Is the paper curled?

Load the paper after correcting its curl.
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1007

Cause

Possible causes include the following.

• There is no paper in the cassette 1.

• Paper is not loaded in the cassette 1 properly.

Action

Take the corresponding actions below.

• Load paper in the cassette 1.

• Align the paper guides with the both edges of the paper when you load paper in the cassette 1.

After carrying out the above measures, press the OK button to dismiss the error.

Note
• The loadable paper differs depending on the paper source.

A4, Letter, or Legal-sized plain paper can be loaded in both the cassette 1 and the cassette 2.

• If you want to cancel printing, press the printer's Stop button.
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1008

Cause

Possible causes include the following.

• There is no paper in the cassette 2.

• Paper is not loaded in the cassette 2 properly.

Action

Take the corresponding actions below.

• Load paper in the cassette 2.

• Align the paper guides with the both edges of the paper when you load paper in the cassette 2.

After carrying out the above measures, press the OK button to dismiss the error.

Important
• The loadable paper differs depending on the paper source.

The loadable paper in the cassette 2 is A4, Letter, or Legal-sized plain paper.

Note
• If you want to cancel printing, press the printer's Stop button.
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1200

Cause

The front cover is open.

Action

Close the front cover and wait for a while.

Do not close it while you are replacing an ink tank.
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1310

Cause

The size of paper may not be compatible with automatic duplex printing.

Action

The sizes of media suitable for auto duplex printing are A4 and Letter. Make sure that the size of the
paper loaded in the printer is correct. Pressing the OK button will eject the paper and restart printing from
the front side of the next paper. The reverse side of the ejected sheet will not be printed.
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1575

Cause

Ink cannot be correctly detected.

Action

If an ink tank becomes empty, replace it.

An ink tank cannot be replaced until it becomes empty.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of
printing under the ink out condition.
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1600

Cause

Ink may have run out.

Action

Replacing the ink tank is recommended.

If printing is in progress and you want to continue printing, press the machine's OK button with the ink
tank installed. Then printing can continue. Replacing the ink tank is recommended after the printing. The
machine may be damaged if printing is continued under the ink out condition.

Important
• Do not remove an ink tank until a new one is prepared to be installed.

• Once you remove an ink tank, the machine will not operate until a new one is installed.

• Once you remove an ink tank, the machine will not operate even if the removed ink tank is just
reinstalled.
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1660

Cause

The ink tank is not installed.

Action

Install the ink tank.
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1688

Cause

The ink has run out.

Action

Replace the ink tank and close the front cover.

Printing under the current condition may damage the machine.

If you want to continue printing in this condition, you need to release the function for detecting the
remaining ink level. Press and hold the machine's Stop button for at least 5 seconds, and then release it.

With this operation, releasing the function for detecting the remaining ink level is memorized. Please be
advised that Canon shall not be liable for any malfunction or trouble caused by continuation of printing
under the ink out condition.

Important
• Do not remove an ink tank until a new one is prepared to be installed.

• Once you remove an ink tank, the machine will not operate until a new one is installed.

• Once you remove an ink tank, the machine will not operate even if the removed ink tank is just
reinstalled.
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1700

Cause

The ink absorber is almost full.

Action

Press the printer's OK button to continue printing. Contact the service center.
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1701

Cause

The ink absorber is almost full.

Action

Press the printer's OK button to continue printing. Contact the service center.
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1754

Cause

The ink tank is not installed properly.

Action

Open the front cover.

Then push the ink tank.

After installing the ink tank properly, close the front cover.

If the problem is not resolved, contact the service center.

Important
• The ink tank that was once installed cannot be removed until the ink runs out.
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1755

Cause

The ink has run out.

Action

To maintain both machine and print quality, the machine cannot continue printing under the ink out
condition.

Cancel printing and replace the ink tank before printing again.

Important
• Do not remove an ink tank until a new one is prepared to be installed.

• Once you remove an ink tank, the machine will not operate until a new one is installed.

• Once you remove an ink tank, the machine will not operate even if the removed ink tank is just
reinstalled.
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1872

Cause

The cassette 1 is not inserted.

Action

Insert the cassette 1.

Note
• The cassette paper information registration screen is displayed after inserting the cassette 1. Register

the cassette paper information according to the paper you loaded in the cassette 1.

• If you want to cancel printing, press the printer's Stop button.
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1873

Cause

The cassette 2 is not inserted.

Action

Insert the cassette 2.

Note
• The cassette paper information registration screen is displayed after inserting the cassette 2. Register

the cassette paper information according to the paper you loaded in the cassette 2.

• If you want to cancel printing, press the printer's Stop button.
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1874

Cause

The cassette 1 and the cassette 2 are not inserted.

Action

Insert the both cassettes.

Note
• The cassette paper information registration screen is displayed after inserting the cassettes. Register

the cassette paper information according to the paper you loaded in the cassette 1 and the cassette
2.

• If you want to cancel printing, press the printer's Stop button.
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1890

Cause

The protective material for the print head holder or the tape may remain attached to the holder.

Action

Open the front cover, then confirm that the protective material or the tape does not remain attached to the
print head holder.

If you find the protective material or the tape remains attached, remove it, then close the front cover.

If the problem is not resolved, contact the service center.
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2111

Cause

The paper settings for printing are different from the cassette paper information registered to the printer.

Note
• For details on the proper combination of paper settings you can specify by the printer driver or on the

LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

• For details on the cassette paper information registering to the printer:

Paper setting for Printing (Windows)

Paper setting for Printing (Mac)

Paper setting for Printing (Smartphone and so on)

If the paper settings for printing are different from the cassette paper information registered to the printer
as the following, a message is displayed on the LCD.

• Print settings specified on the printer driver:

Paper size: B5

Media type: Plain paper

• Cassette paper information registered to the printer:

Paper size: A4

Media type: Plain paper

Action

Pressing the printer's OK button, the following screen is displayed on the LCD.

Select what to do as necessary.

Note
• Depending on the setting, the choices below may not be displayed.

Use cass. settings
Select if you want to print on the paper loaded in the cassette 1 without changing the paper settings.

For example, when the paper setting for printing is B5 and the cassette paper information registered
to the printer is A4, the printer starts printing with B5 on the paper loaded in the cassette 1.
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Replace the paper
Select if you want to print after replacing the paper of the cassette 1.

For example, when the paper setting for printing is B5 and the cassette paper information registered
to the printer is A4, you load B5 sized paper in the cassette 1 before you start printing.

The cassette paper information registration screen is displayed after replacing the paper and inserting
the cassette 1. Register the cassette paper information according to the paper you loaded in the
cassette 1.

Note
• If you do not know what paper information to register to the printer, press the Back button when

the screen to select the operation is displayed. When the previous screen is displayed, confirm
the paper size and the media type, then register them to the printer.

• For details on the proper combination of paper settings you can specify by the printer driver or on
the LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

Cancel printing
Cancels printing.

Select when you change the paper settings specified for printing. Change the paper settings, then try
printing again.

Note
• You can disable the message which prevents misprinting. When you disable the message, the printer

starts printing even though the paper settings for printing and the cassette paper information
registered to the printer are different.

• To change the setting using the operation panel:

Cassette settings (Windows)

Cassette settings (Mac)

Cassette settings (Smartphone and so on)

• To change the setting using the printer driver:

Changing the Printer Operation Mode (Windows)

Changing the Printer Operation Mode (Mac)
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2112

Cause

The paper settings for printing are different from the cassette paper information registered to the printer.

Note
• For details on the proper combination of paper settings you can specify by the printer driver or on the

LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

• For details on the cassette paper information registering to the printer:

Paper setting for Printing (Windows)

Paper setting for Printing (Mac)

Paper setting for Printing (Smartphone and so on)

If the paper settings for printing are different from the cassette paper information registered to the printer
as the following, a message is displayed on the LCD.

• Print settings specified on the printer driver:

Paper size: A4

Media type: Plain paper

• Cassette paper information registered to the printer:

Paper size: Legal

Media type: Plain paper

Action

Pressing the printer's OK button, the following screen is displayed on the LCD.

Select what to do as necessary.

Note
• Depending on the setting, the choices below may not be displayed.

Use cass. settings
Select if you want to print on the paper loaded in the cassette 2 without changing the paper settings.

For example, when the paper setting for printing is A4 and the cassette paper information registered
to the printer is Legal, the printer starts printing with A4 on the paper loaded in the cassette 2.
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Replace the paper
Select if you want to print after replacing the paper of the cassette 2.

For example, when the paper setting for printing is A4 and the cassette paper information registered
to the printer is Legal, you load A4 sized paper in the cassette 2 before you start printing.

The cassette paper information registration screen is displayed after replacing the paper and inserting
the cassette 2. Register the cassette paper information according to the paper you loaded in the
cassette 2.

Note
• If you do not know what paper information to register to the printer, press the Back button when

the screen to select the operation is displayed. When the previous screen is displayed, confirm
the paper size and the media type, then register them to the printer.

• For details on the proper combination of paper settings you can specify by the printer driver or on
the LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

Cancel printing
Cancels printing.

Select when you change the paper settings specified for printing. Change the paper settings, then try
printing again.

Note
• You can disable the message which prevents misprinting. When you disable the message, the printer

starts printing even though the paper settings for printing and the cassette paper information
registered to the printer are different.

• To change the setting using the operation panel:

Cassette settings (Windows)

Cassette settings (Mac)

Cassette settings (Smartphone and so on)

• To change the setting using the printer driver:

Changing the Printer Operation Mode (Windows)

Changing the Printer Operation Mode (Mac)
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2113

Cause

The paper settings for printing are different from the cassette paper information registered to the printer.

Note
• For details on the proper combination of paper settings you can specify by the printer driver or on the

LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

• For details on the cassette paper information registering to the printer:

Paper setting for Printing (Windows)

Paper setting for Printing (Mac)

Paper setting for Printing (Smartphone and so on)

If the paper settings for printing are different from the cassette paper information registered to the printer
as the following, a message is displayed on the LCD.

• Print settings specified on the printer driver:

Paper size: A4

Media type: Plain paper

• Cassette paper information registered to the printer:

Paper size: Legal

Media type: Plain paper

Action

Pressing the printer's OK button, the following screen is displayed on the LCD.

Select what to do as necessary.

Note
• Depending on the setting, the choices below may not be displayed.

Use cass. settings
Select if you want to print on the paper loaded in the cassette 1 and the cassette 2 without changing
the paper settings.
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For example, when the paper setting for printing is A4 and the cassette paper information registered
to the printer is Legal, the printer starts printing with A4 on the paper loaded in the cassette 1 and the
cassette 2.

Replace the paper
Select if you want to print after replacing the paper of the cassette 1 and the cassette 2.

For example, when the paper setting for printing is A4 and the cassette paper information registered
to the printer is Legal, you load A4 sized paper in the cassette 1 and the cassette 2 before you start
printing.

The cassette paper information registration screen is displayed after replacing the paper and inserting
the cassettes. Register the cassette paper information according to the paper you loaded in the
cassette 1 and the cassette 2.

Note
• If you do not know what paper information to register to the printer, press the Back button when

the screen to select the operation is displayed. When the previous screen is displayed, confirm
the paper size and the media type, then register them to the printer.

• For details on the proper combination of paper settings you can specify by the printer driver or on
the LCD:

Setting the Media Type with the Printer Driver and on the Printer (Windows)

Setting the Media Type with the Printer Driver and on the Printer (Mac)

Setting the Paper Size with the Printer Driver and on the Printer (Windows)

Setting the Paper Size with the Printer Driver and on the Printer (Mac)

Cancel printing
Cancels printing.

Select when you change the paper settings specified for printing. Change the paper settings, then try
printing again.

Note
• You can disable the message which prevents misprinting. When you disable the message, the printer

starts printing even though the paper settings for printing and the cassette paper information
registered to the printer are different.

• To change the setting using the operation panel:

Cassette settings (Windows)

Cassette settings (Mac)

Cassette settings (Smartphone and so on)

• To change the setting using the printer driver:

Changing the Printer Operation Mode (Windows)

Changing the Printer Operation Mode (Mac)
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2121

Cause

The paper settings of the cassette 1 is not complete.

Action

If the following screen is displayed, the paper settings of the cassette 1 is not complete.

Press the printer's OK button to terminate the paper settings of thecassette.
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2122

Cause

The paper settings of the cassette 2 is not complete.

Action

If the following screen is displayed, the paper settings of the cassette 2 is not complete.

Press the printer's OK button to terminate the paper settings of thecassette.
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2500

Cause

The cause of following may have occurred the failure of Automatic Print Head Alignment.

• Print head nozzles are clogged.

• The paper of size other than A4 or Letter is loaded in the cassette 1.

• The paper output slot is exposed to strong light.

Action

Press the printer's OK button to dismiss the error, then take the actions described below.

• Print the nozzle check pattern to check the status of the print head.

• Load one sheet of A4/Letter-sized plain paper in the cassette 1 and perform Automatic Print Head
Alignment again.

For Automatic Print Head Alignment, always load paper in the cassette 1.

• Adjust your operating environment and/or the position of the printer so that the paper output slot is not
exposed directly to strong light.

After carrying out the above measures, if the problem continues after aligning the print head again, press
the printer's OK button to dismiss the error, and then perform Manual Print Head Alignment.

568



4100

Cause

The specified data cannot be printed.

Action

When you print the contents on CREATIVE PARK PREMIUM, confirm the message on the computer
screen, make sure that genuine Canon ink tanks are installed properly for all colors, then start printing
again.
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4103

Cause

Cannot perform printing with the current print settings.

Action

Press the printer's Stop button to cancel printing.

Then change the print settings and print again.
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4104

Cause

The paper size or the media type that cannot be fed from the cassette 2 is specified.

Action

Press the printer's Stop button to cancel printing.

Specify the paper size setting to A4, Letter, or Legal and specify the media type setting to Plain Paper.
Then print again.

Note
• If you will not change the paper size setting or the media type setting, select the cassette 1 as the

paper source. If this is the case, register the cassette 1 paper information properly.
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5100

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.
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5102

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.
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5103

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.
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5104

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.
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5105

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.

576



5200

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

577



5203

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

578



5204

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

579



5205

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

580



5206

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

581



5207

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

582



5208

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

583



5209

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

584



5400

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

585



5500

Cause

Ink tank has not been properly recognized.

Action

Contact the service center.

586



5501

Cause

Ink tank has not been properly recognized.

Action

Contact the service center.

587



5B00

Cause

Printer error has occurred.

Action

Contact the service center.

588



5B01

Cause

Printer error has occurred.

Action

Contact the service center.

589



5C01

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

590



6000

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

591



6500

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

592



6502

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

593



6800

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

594



6801

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

595



6900

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

596



6901

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

597



6902

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

598



6910

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

599



6911

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

600



6920

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

601



6921

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

602



6930

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

603



6931

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

604



6932

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

605



6933

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

606



6940

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

607



6941

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

608



6942

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

609



6943

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

610



6944

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

611



6945

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

612



6946

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

613



7100

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

614



7200

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

615



7201

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

616



7202

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

617



7203

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

618



7204

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

619



7205

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

620



7300

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

621



B202

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Contact the service center.

622



B203

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Contact the service center.

623



B204

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Contact the service center.

624



B502

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

625



B503

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

626



B504

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

627



C000

Cause

Printer error has occurred.

Action

Cancel printing and turn off the printer.

Then confirm the following.

• Confirm that there are no materials (e.g. the protective material or jammed paper) that is preventing
the print head holder from moving.

If any, remove the materials.

• Confirm that the ink tanks are installed properly.

Push an ink tank until it clicks into place.

After confirming the conditions above, turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the print head holder from

moving, be careful not to touch the clear film (A) or the white belt (B).

If the paper or your hands touch these parts and blot or scratch them, the printer can be damaged.

628


